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Documentation Updates

The title page of this document contains the following identifying information:

¢ Software Version number, which indicates the software version.

o Document Release Date, which changes each time the document is updated.

o Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, goto:

http://h20229.www2.hp.com/passport-registration.htmi
Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support Online web site at:
http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed to manage your business. As a
valued support customer, you can benefit by using the support web site to:

o Search for knowledge documents of interest

o Submit and track support cases and enhancement requests
o Download software patches

« Manage support contracts

e Look up HP support contacts

¢ Review information about available services

¢ Enterinto discussions with other software customers

o Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.htmi
To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Introduction to the HP NNM iSPI Performance Products and
the Network Performance Server

The Network Performance Server (NPS) extends NNMi's functionality by providing a platform for
performance data storage, analysis and reporting. The NPS platform is used by the NNM iSPI
Performance series of products, which includes NNM iSPI Performance for Metrics, Traffic, and
Quality Assurance.

Through NPS, the iSPI Performance products provide a comprehensive set of customizable reports
and graphs that support interactive/operational performance management and scheduled reporting.
The reports and graphs provide actionable insight into the performance of the network.

At the core of the foundation provided by NPS is the column-based database management system
(DBMS), which enables you to effectively store, access, and track network performance data.

Extension Packs provided by the NNM iSPI Performance products add rules and definitions to the
NPS deployment to generate reports. These rules and definitions enable the business intelligence
component—the Bl Server—to generate insightful and actionable reports.

NPS Administration

NPS uses NNMi for all user authentication and logon via Single Sign-On. NNMi users automatically
become NPS users the first time they access the NPS Report Menu.

NNMi user roles are applied in NPS. An NNMi administrator is automatically granted administrative
privileges on NPS. These privileges include the ability to administer and manipulate content and
settings on the Bl server.

HP does not recommend that NPS users make any changes to any settings on the Bl Server
because changes can disrupt the functionality and performance and render the Bl Server
unsupportable. The user must become familiar with the Bl Server and accept responsibility for the
outcome if Bl Server settings are modified. The Bl Server documents and tutorials are shipped and
installed with NPS, and can be accessed from the Bl Portal.

OEM license restrictions stipulate that only one Admin can log in to the Bl Server at any one time.
Console Features
The iSPI Performance interface consists of a navigation panel and a workspace.

Navigation Panel
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The navigation panel provides a series of tabs that enable you to create reports. To open a tab, click
¥ the down arrow. Clicking another tab automatically closes the previously used tab. The following
tabs are provided.

Tab Description
4 | Tracks your current selection and actions. This tab
Current Status remains open.
# | Options are:
Preferences

e Open separately

o Enable drillthroughs
Topology group tracking method
e SCD Type1

e SCD Type2

Enables you to set timing, topology, and other options
Reports prior to running a report.

e

Selections are:
¢ Quicklaunch ReportViews:
= Availability & Response for Nodes
= Capacity Planing on Node CPU%
= Executive for Interfaces
= Headline for Interfaces
= Headline for Nodes
= Most Changed Exceptions for Nodes
= Overview for Nodes
= Overview for Nodes - Business Hrs
= Response Baseline Sleeve for Nodes
= Throughput Calendar for Interfaces
= Throughput Heat Chart for Interfaces
= Top Interface Util%
= Top Interface Util% Chart
= Top Node CPU%
s Top Node CPU% Chart
o iSPI Metrics:
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Tab

Description

» AtmPvc_Health (if this Extension Pack is installed)

s Component_Health (if this Extension Pack is
installed)

= FrameRelayPvc_Health (if this Extension Pack is
installed)

= Interface_Health (if this Extension Pack is installed)
¢ Self Monitoring (admin users only):
= Quicklaunch Diagnostic Reports
n PerfSPI_Diagnostics
e User Groups:
= admin
= globalops
= guest
= levell
n level2
o All_ExtensionPacks

e My Folders

Report History

b

Lists the reports that have run. To clear the list, click the
Clear button.

Topology Fitter

e

Lists the filters that have been used. To clear the list, click
the Clear button. To select new filters, click the Launch
Topology Selector button. For a list of filters, see "Set.
Topology Filters" (on page 55).

‘TIITIE Control

e

Provides options you can set to create custom reports:
o Data Available From / Available To

e Detall

e Hourly

¢ Daily

¢ Relative Start (with options)

¢ Interval (with options)

e Grain (with options)

o TimeZone (with options)

Page 18 of 230

HP Network Node Manager iSPI Performance for Metrics Software (9.20)



Online Help
Contents

Tab Description
o Auto Refresh (with options)

o Hourof Day / Day of Week (with options)

To change any of the selected options, click the Reset
button.

To accept the selected options, click the Submit button.

Provides access to:

e

Bl Server
e Public Folders

e My Folders

o Administrator Log On

e Portal - launches the Bl Portal page

¢ Query Studio - launches the custom report feature

¢ Administration - launches the Bl Server Administration
page

Provides a direct link to the NNM console.

e

Cro=s Launching

Workspace

Selection Description

The Keep this version options enable you to

E!'.' Keep this version ¥ -
keep the report version that currently appears

b Email Report in the workspace, email it, save it as a report,

Eljsave Report or save it as a ReportView (if you are the

B save as Report View Administrator or have permission for that
option).

S Enables you to run the report selected.

Enables you to view the report in various

View in HTML Format
output formats: HTML, PDF, or Excel.

View in PDF Format
_'l.-'iew in Excel Options F

[ NNMiSPl Performance e o= | Shows the report you selected to run; for

example, the Executive report.

Run Prompts Opens the Topology Filter dialog.
Show Bookmark / Hide Bookmark Displays the url. Once, opened, you can close

it with Hide Bookmark.
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Selection Description

Help Opens the main page of the online help.

Location of Program and Runtime Files
NPS consists of static application software files and dynamic runtime files.
The default path for static application software is:

e Windows:
%$Program Files (x86)%\HP\HP BTO Software
e Linux:
/opt/OV/NNMPerformanceSPI
The default path for the dynamic runtime files is:
e Windows:
$NPSDataDir%\HP\NNMPerformanceSPI
e Linux:
/var/opt/0OV

The performance of NPS depends on the I/O performance of the disk subsystem where this
directory resides. HP strongly recommends that this data location be hosted on a high-performance
file system. For specifications, see the support matrix..

The NNMPerformanceSPI directory contains the following folders:

e contentstore

o database

o nnmappfailover

e L10ON

e logs

o PerfSPI_Diagnostics

« rconfig

o Adirectory for each installed Extension Pack

o Additional directories for any Custom Collect Report Groups created on NNMi

The folders are placed by the default NPS installation. Additional folders can be present if additional
Extension Packs are present.

Data Retention Defaults

The default settings are the following:
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Setting Default Value (Days) Table
Daily Data 800 Day
Hourly Data 70 Hour
Raw/Detailed Data 14 Raw

You can modify the default settings using the Configuration utility.

Single Sign-On Security

NPS enables you to use a security function known as Single Sign-on (SSO). SSO allows NPS to
recognize the same user names and passwords the NNMi console recognizes. When SSO is
enabled, a user who is already logged on to NNMi can move from NNMi to a report without having
to log on again.

For SSO to operate, the following conditions must be met:

o The NNM system and the NPS system must be configured with fully qualified domain names
(FQDN).

e The user must use the fully qualified domain (not "localhost" or the machine name without the
domain) when launching the NNMi console.

If the user launches NNMi using an unqualified host name, an error message will appear in the
Current Status tab of the navigation panel.

If the address, or the domain, of the NNMi management server or the NPS system changes after
you install NPS, re-run the enablement script on NNMi. Re-running the enablement script
configures NNMi with updated location information.

Direct access to NPS
You can access NPS directly, without going through NNMi, by pointing your browser at:

http://<fully-Qualified-serverName>:9300

When the login window opens, enter the same username and password you use to launch NNMi.
After you are authenticated, the NPS home page opens.

You can also use the following methods:

o From the server where NPS is installed, run launchReport.ovpl.

o Windows only: Use the menu item in Start > All Programs > HP > NNM iSPI Performance >
Report Menu.

Monitor NPS Processes
NPS includes reports for admin users only to monitor NPS processes.
To view the available reports:
1. Loginto NPS.
2. Onthe NPS home page, click the Reports tab in the navigation panel.

3. Select Self Monitoring(admin users only) > PerfSPI_Diagnostics > DiagnosticMetrics.
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Set Thresholds for Metrics in NNMi

Until you set the thresholds for the performance metrics, the reports do not track exception counts
or exception rates.

NNMi does not set thresholds for performance metrics for you automatically. You must set the
thresholds for the iSPI Performance metrics manually using the Thresholds Settings form in the
NNMi console.

For information about how to set thresholds with the NNMi console, and for a listing of metrics, see
"Configure Threshold Monitoring for Interfaces (HP Network Node Manager iSPI Performance for
Metrics Software)" in the HP Network Node Manager i Software Online Help for Administrators.

Although you might want to see exception counts as soon as possible, you should wait until you are
better acquainted with the way your network behaves. For example, if the thresholds are set wrong,
NNMi might detect too many exceptions. Or, if you configure NNMi to generate incidents in
response to threshold conditions, NNMi could generate too many incidents.

NNMi Baseline Settings

You can use configure NNMi and NPS for baseline monitoring in your network environment. For
more information, see the "Configure Baseline Settings" topic in the HP Network Node Manager
i Software Online Help for Administrators.

Support for NNMi Application Failover

Application Failover for NNMi ensures redundancy. Failover allows a secondary NNMi server to
take over immediately after the failure of a primary NNMi server. Failover relies on jboss clustering
technology, ongoing file system synchronization, and a Java keystore file that must be copied from
NNM to NPS. For details, see the HP Network Node Manager iSPI Performance for Metrics
Installation Guide.

NPS supports NNMi Application Failover, which is transparent to users. Aside from an interruption
in service lasting about 15 minutes while failover is in progress, users are not aware that a failover
took place, and the administrator is not required to perform any special tasks related to failover.

The ability of NPS to support Application Failover depends on files it retrieves from the primary
server in the cluster. NPS retrieves these files during startup. As soon as NPS has the files, it
begins monitoring the status of the primary server by checking for status changes every 5 minutes.
If NPS detects a status change, the following events take place automatically:

o NPS determines which server is the new primary server.
o NPS redirects data collection to a shared directory on the new primary server.

o NPS begins collecting data (metrics and topology files) from the new primary server in the
cluster.

Immediately after, NPS users are able to link from NPS to NNMi views on the new primary server,
just as they could before failover.

NPS reports messages relating to failover (see "Messages Related to Failover" (on page 22)).

Messages Related to Failover

The following INFO, WARN, and ERROR log file messages pertain to Application Failover.
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Failovernot | DEBUG: NNM Logged every 5 minutes if DEBUG logging is enabled
enabled Application Failoveris
not enabled.\n
Failover INFO: NNM Logged every 5 minutes
enabled Application Failoveris
enabled. Checking if
active node has
changed.\n
Failover INFO: NNM Logged every 5 minutes. Displays the current NNM
enabled Hostname currently hostname being used by NPS.
used by NPS is:
$nnm_current\n
Failover INFO: Logged every 5 minutes. Displays the NNM hostname
enabled $getNNMActiveScript | reported as the active node in the cluster.
reports active nnm
node is: $nnm_
active\n
Failover INFO: Active NNM Logged every 5 minutes.
enabled but | host is unchanged.\n
the active
host has not
changed.
Failover INFO: Changing NPS | A configuration update is imminent. This message is logged
enabled configuration to use only when the active node is different from the node
$nnm_active\n currently used by NPS.
Failover INFO: Configuration Logged after the configuration file is successfully updated in
enabled and | updated. Path to response to an Application Failover.
config files NNM is now
successfully | $newpath\n
updated
Failover WARN: NNM If NPS is running on the same machine as NNN, the path
enabled but | Application Failoveris | does not contain the hostname.
the NNM not supported on
hostname is | same-system
not in the NNM/NPS
path syntax | installations\n
Failover WARN: Cannot The user might have specified the path in a non-
enabled but | extract remote nnm conventional way; for example, by using a hard mount or
the NNM hostname from value | drive mapping. If the path does not contain the remote NNM
hostname is | of PRSPI_NNMDIR | hostname, NPS is not able to detect Application Failover.
not in the ($cfg{PRSPI_
path syntax | NNMDIR})..\n
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Condition Message Comments

Failover WARN: Expected The user might have specified the path in a non-

enabledbut | PRSPI_NNMDIR of | conventional way; for example, by using a hard mount or

the NNM form drive mapping. If the path does not contain the remote NNM

hostname is | /net/hostname/var... hostname, NPS is not able to detect Application Failover.

not in the or

path syntax | //hostname/PerfSpi\n

Failover ERROR: nnm_ This message is logged if there is no copy of nnm_

enabled but | details.xml not found | details.xml on the remote NNM machine. This condition

the nnm_ in $newpath occurs if the nnmenableperfspi script was not run on

details.xml that machine, because running the script creates the nnm

file is not details.xml file. This condition could also occur if the

available. machine configurations are not identical. For example, if the
pathnames to the shared drive are not identical, the new
path will be incorrect when NPS substitutes the new
hostname into the path. The configurations must be
identical.

Failover ERROR: Unable to NPS configuration will not change. A file permissions error

enabled but | modify timestamp of | is preventing the nnm_detail.xml file from being modified on

there is afile | $newpath/nnm_ the NNM server.

permissions | details.xml: $!.

error

Failover ERROR: Unable to Failure to update the config file could be caused by another

enabled but | write changes to process that is locking the config file.

unable to config file. Will try

update the again next time.\n

config file.

Back Up and Restore

NPS provides command-line tools that back up and restore all NPS data.

To back up NPS data:

1. Logintothe NPS system with the same account used to install NPS.

2. Run the following command:

backup.ovpl -b <dir>

[-c]

(-d] [-f]

In this instance, <dir>is the location where you want to place the backed-up data. Do not use
$NPSInstallDir% or $NPSDataDir% with this option.

Options

o Usethe —c option to back up the content store.

o Usethe —d option to back up the database.

o Usethe - £ option to back up all NPS configuration and archived data files.
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o Use the -t option to suppress creating a single compressed archive (tar.gz) file. This option
leaves the directory as is on the file system, and greatly speeds up the backup process.

o Usethe —x option to exclude the demo database from the backup. This option speeds up the
backup process.

You must specify a valid directory location as an argument of the —b option. If you do not specify
any other options, the backup script will back up the content store and the database.

The duration of the backup process depends on the size of the database. Before you start the
backup process, verify the amount of disk space used by the data you want to back up, and make
sure the system has enough free disk space. Although the script produces compressed output, the
backup process requires sufficient temporary disk space.

For command details, see backup.ovpl

To restore NPS data:
1. Logintothe NPS system with the same account used to install NPS.
2. Run the following command:

restore.ovpl [-h] [-b <file>] [-1] [-r DBFILE=>NEW PATH TO
DBFILE.iqg[, DBFILE=>NEW PATH TO DBFILE. igl]

In this instance:

-h displays this text

-b <file> specifies backup file

-1 lists file content without restoring

-r DBFILE=>NEW PATH TO allows one or more database file to be restored to the
DBFILE.iq[, DBFILE=>NEW specified (non-default) location

PATH TO DBFILE.iq]

The restore operation overwrites all preceding NPS data.

When the restore is complete, the ETL service will not be running. You must restart the service to
resume the processing of new data. To start ETL, run the startETL.ovpl, startALL.ovpl command,
or use the Start button on the Configuration Utility.

If you change the password of the database after a backup operation, you must change it again
after restoring the backed-up database.

For command details, see restore.ovpl.
Related Topics

o "Incremental Backup" (on page 26)

o "Backing Up and Restoring on the Same System" (on page 27)

o "Restoring a Backup Made on a Previous Product Version" (on page 27)
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« "Restoring a Backup Made on a Different System with Different Installation Directories" (on

page 28)
o "Restoring a Backup When Additional Files Were Added to Extend the Database" (on page 29)

Incremental Backup

A comprehensive backup strategy is essential for disaster recovery. Although full backups are
simple to implement and easy to execute when restoration is required, they can slow down
processes that are running, take a long time to complete, and require large (sometimes excessively
large) amounts of storage.

Incremental backups, however, can balance speed, resource conflicts, and required storage
against ease of restoration.

The purpose of a backup is to provide a recovery point. Different systems have different
requirements for recovery points. A backup strategy that offers daily recovery points can be
implemented through a weekly schedule of full backups combined with incremental daily backups
on all other days.

For additional security, each backup should be stored on removable media and made secure. This
should also include creating several generations of media.

To implement a backup strategy that incorporates four generational copies:
1. Run a full backup.ovpl backup on a weekly basis.

Use no backup flags (that is, c, d, orf) so that the database, the content store, and the file
system are backed up.

Here is an example:
= Linux:
SNPSInstallDir/bin/backup.ovpl -b /var/backup/full
= Windows:
$NPSInstallDir$\bin\backup.ovpl -b E:\backup\full
2. Copy the backed up data to one of four versions of backup tapes.

Backup tapes should be kept off site. Alternatively, they can be created directly using WAN
links to copy data.

3. Run anincremental backup on a daily basis.

Use no backup flags (c, d, orf), so that the database, the content store, and the file system are
backed up.

Use the optional —i flag to perform an incremental backup.
Here is an example:
= Linux

SNPSInstallDir/bin/backup.ovpl -b /var/backup/incremental -i
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= Windows
$NPSInstallDir%\bin\backup.ovpl -b E:\backup\incremental -i

Only changes since the last backup (full orincremental) are saved.

4. Copy the backed up data to one of four backup tapes.

Append the data. Do not overwrite existing backed up data.

If restoration is required:

¢ Restore from the desired full backup. See restore.ovpl.

Restore (in sequential order) each incremental backup from oldest to most recent.

Notes:

When restoring an incremental backup that includes the content store, you must restore each
backup in turn without starting the Bl Server. If you start the Bl Server, it will write to the content
store database and prohibit restoring from any further incremental backups.

If you do write to the content store database before restoring an incremental backup, you must
return to the full backup and start the restoration process again.

Related Topics

"Back Up and Restore" (on page 24)

"Backing Up and Restoring on the Same System" (on page 27)

"Restoring a Backup Made on a Previous Product Version" (on page 27)

"Restoring a Backup Made on a Different System with Different Installation Directories" (on

page 28)
"Restoring a Backup When Additional Files Were Added to Extend the Database" (on page 29)

Backing Up and Restoring on the Same System

If the backup is restored on the same system with the same installation directories and product
version as the backup, the entire contents of $SNPSDataDir will be restored, including all config
files, archived data files, the database, and the content store.

Related Topics

"Back Up and Restore" (on page 24)

"Incremental Backup" (on page 26)

"Restoring a Backup Made on a Previous Product Version" (on page 27)

"Restoring a Backup Made on a Different System with Different Installation Directories" (on

page 28)
"Restoring a Backup When Additional Files Were Added to Extend the Database" (on page 29)

Restoring a Backup Made on a Previous Product Version

Backups made on earlier product versions can be restored with some limitations.
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o User configurable settings (retention and installed Extension Pack list) are merged into the
current settings.

o Other (internal) configuration files are not restored.
o Archived data files are not restored.
o The database and content store are restored.

o All Extension Packs must be installed again to ensure that the reports and database structures
are upgraded to the latest version.

« You might have to rerun the Performance iSPI1 Enablement script (NNM) and Configuration
Utility.

Related Topics

"Back Up and Restore" (on page 24)

o "Incremental Backup" (on page 26)

o "Backing Up and Restoring on the Same System" (on page 27)

o "Restoring a Backup Made on a Different System with Different Installation Directories" (on

page 28)
o "Restoring a Backup When Additional Files Were Added to Extend the Database" (on page 29)

Restoring a Backup Made on a Different System with Different Installation
Directories

Backups made on a different system with different installation directories can be restored with
some limitations.

o User configurable settings (retention and installed Extension Pack list) are merged into the
current settings.

o Other (internal) configuration files are not restored.
o Archived data files are not restored.
o The database and content store are restored.

o All Extension Packs must be installed again to ensure that the reports and database structures
are upgraded to the latest version.

¢ You might have to rerun the Performance iSP| Enablement script (NNM) and Configuration
Utility.

Related Topics
o "Back Up and Restore" (on page 24)

o "Incremental Backup" (on page 26)

o "Backing Up and Restoring on the Same System" (on page 27)

o "Restoring a Backup Made on a Previous Product Version" (on page 27)

o "Restoring a Backup When Additional Files Were Added to Extend the Database" (on page 29)
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Restoring a Backup When Additional Files Were Added to Extend the
Database

If the dbsize.ovpl utility was used to extend a database by adding additional files to the DBSPACE,
the backup will attempt to restore these files to the same directory as the standard database files.

To relocate database files during a restore:

The -r option enables you to identify one or more DBFile names and corresponding OS path or file
name locations where each should be restored.

When dbsize.ovpl is used to add files, the DBFile names used will look like perfspi USER
MAIN <timestamp>.You can use the -1 option to determine the files to be included in your
backup (for backups made on 9.20 and later).

You can specify a different OS path or file name when restoring by using the -r option; for example,
restore.ovpl -b backup.20111027135608.tar.gz -r "perfspi USER MAIN
3466235673656=>C:/new location/perfspi USER MAIN 3466235673656.iq".

If you backed up the content store using the standard backup utility provided in earlier releases, you
will not be able to restore them in the current release. Tthe current database backup format is
incompatible with earlier releases.

Related Topics
o "Back Up and Restore" (on page 24)

o "Incremental Backup" (on page 26)

o "Backing Up and Restoring on the Same System" (on page 27)

+ "Restoring a Backup Made on a Previous Product Version" (on page 27)

« "Restoring a Backup Made on a Different System with Different Installation Directories" (on

page 28)
Configure NPS

If you install NPS on the NNMi management server, configuration takes place automatically during
the installation. After installation, you can use the Configuration utility to make changes.

If you install NPS on a dedicated server, you must use the Configuration utility to specify
configuration details. At the end of the installation, before the NPS ETL services are started, the
Configuration utility asks you necessary configuration details.

To launch the Configuration utility:
o Windows:

Select Start > All Programs > HP > NNM iSPI Performance > Configuration Utility
e Linux:

Run runConfigurationGUI.ovpl

Configuration Utility

You can use the Configuration utility to specify the following values.

Configure the iSPI Performance service to log on as:
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Windows Only

o When NPS is installed on a dedicated Windows server, you must select "Named User
account." For detailed instructions, see the "Installing NPS" section of the HP Network Node
Manager iSPI Performance for Metrics Installation Guide.

You must provide the same account information that was used with the enablement script on the
NNMi management server.

o When NPS is installed on a Windows NNMi management server, you must select "Local
System account." For detailed instructions, see the "Configuring NPS with the Configuration
Utility" section of the HP Network Node Manager iSPI Performance for Metrics Installation
Guide.

Specify the path to iSPI Performance data files folder:

o If NPS is installed on the NNMi management server, a local path is displayed in this field. You
should not change this value. For detailed instructions, see the "Using the Configuration Utility"
chapter of the HP Network Node Manager iSPI Performance for Metrics Installation Guide.

« If NPS is installed on a dedicated server, the enablement script creates a shared space on the
NNMi server.

You must specify the location of the shared space in the correct format.
Daily Data Retention Period (days)

The default setting is 800.

Hourly Data Retention Period (days)

The default setting is 70 days.

The maximum retention period is 400 days.

Raw/Detailed Data Retention Period (days)

The default setting is 14 days.

The maximum retention period is 400 days.

Service status:

Click Stop or Start to stop and start necessary NPS processes.
If you change any of the default settings, click Apply and Exit.
To retain the originally configured settings, click Exit.

See also "Master Runtime Configuration File NNMPerformanceSPI.cfg" (on page 30)

Master Runtime Configuration File NNMPerformanceSPl.cfg

The NNMPerformanceSPI.cfg file controls the operation of the iSPI Performance for Metrics.

The file contains values written by the Configuration Utility, as well as many other options with their
standard and recommended settings. Users should NOT modify the contents of this file directly.
Doing so can affect the functionality and performance of NPS and render it unsupportable.
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User Groups and Security Groups in NPS

Both NNMi and NPS restrict access to data based on user/UserGroup/SecurityGroup/node
mappings.

User Groups and Security Groups are created by NNMi administrators. For each user, NPS filters
the data queries for all reports and ad hoc queries, so that the user has access only to data for
managed nodes whose Security Groups are associated with the User Groups to which the user
belongs.

NPS data security restricts all data access according to the following policies:

o Filter the fact table queries for all report graphs and tables, including reports created using Query
Studio.

o Filter the dimension data queries used in topology filter prompts orin Query Studio.

o Filter group member queries used in topology filter prompts or in Query Studio. NPS does not
display data related to the groups, where none of the members have access to the report data.

The NNMi built-in User Groups "NNMi Administrators (admin)" and "NNMi Global Operators
(globalops)" are automatically granted visibility to all performance data regardless of security group
assignments. All users who are assigned to either the NNMi admin or globalops User Group have
full access to all data in reports and queries.

Members of the "NNMi Administrators (admin)" User Group are granted full administrative
privileges to the NPS Bl Server, and have unfettered rights to save, move,delete content (including
content created or owned by other users), and perform other administrative tasks.

Members of the "NNMi Global Operators (globalops)" User Group are granted read-only access to
all data, including reports and queries saved by other users, but do not have administrative
capabilities on the NPS Bl Server and cannot modify the content of public folders or other User
Group folders.

Example

Say that NPS data is divided among the following locations:
o Site A

o SiteB

And each location includes the following local users:

o Operator 1: This user can access data for only Site A.

o Operator 2: This user can access data for only Site B.

The following global users can access data from all locations:

o Admin: The NNMi and NPS Administrator administers both locations and accesses NPS data
from all locations.

o GlobalOperator: The user for both Site A and Site B must access NPS data in both locations.

Once the administrator (Admin in this example) creates these User Groups in NNMi, NPS ensures
that access to NPS features and data is restricted according to the privileges defined for each User
Group.
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User Account NPS User Group  NPS Access Privileges

Admin NNMi and NPS e Can access all NPS data irrespective of location

Administrator e Can access all user group datain NPS

¢ Can add, modify, or delete NPS users and user
groups using NNMi console

e Can access all report templates, schedule reports,
and define global report settings

GlobalOperator | Global Operator Can generate reports for all sites, including Site A and
Site B

Operator 1 Level 1 Operator Can generate reports for only Site A

Operator 2 Level 1 Operator Can generate reports for only Site B

For more information on configuring User Groups, see "Configuring Security" in the HP Network
Node Manager i Software Online Help for Administrators.

Check the Validity of NNM iSPI Performance Configurations

The Configuration Checker enables you to verify the validity of the configuration file entries. It
displays the following message if all the entries are valid:

INFO: Configuration File Validated OK
To launch the Configuration Checker:
e Windows:
Select Start > All Programs > HP > NNM iSPI Performance > Configuration Checker
e Linux:

Run checkConfig.ovpl

Collect Diagnostic Data for Support

The Diagnostics Collector utility enables you to collect diagnostic data for Support. The data will be
used to to diagnose the problem.

To launch the Diagnostics Collector:
e Windows:

Click Start > All Programs > HP > NNM iSPI Performance > Diagnostics Collector
e Linux:

RuncollectDiagnostics.ovpl.

The Diagnostics Collector saves the output, in the form of a compressed tar.gz file, in the following
location:

o Windows:

%NPSDataDir%\HPNNMPerformanceSPI\collectDiag
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e Linux:
/var/opt/OV/HPNNMPerformanceSPI/collectDiag

Forward the tar.gz file from the collectDiag folder to Support.

Reset NPS
The reset utility enables you to delete all data from the database with the following options:
o Keep all archived data.
« Restore archived data for re-processing.
o Delete all archived metrics/topology.
o Delete all archived data and log files and restart all services.
To launch the NPS Reset utility:
Windows:
Select Start > All Programs > HP > NNM iSPI Performance > Reset Utility
Linux:

Run resetsSPI.ovpl

The Reset Utility window displays the following options:
1. Delete all data from database, & keep all archived data

2. Delete all data from database, & restore archived data for re-
processing

3. Delete all data from database, & delete all archived
metrics/topology

4. Delete all data from database, delete all archived data and
logfiles, & restart all services

5. Delete and recreate entire database using default size, location,
and options

Enter Option (1-5), or Q to quit:

Retrieve Last Login Information for a User
Whenever a user logs in to NPS, the following information is recorded in the log file:
e Username
o Logon date
e Logontime
To find user login information:
o Windows:

%NPSDataDir%\NNMPer formanceSPI\logs\perfspiAudit.log
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e Linux:
/var/opt/OV/NNMPerformanceSPI/logs/perfspiAudit.log
Analyze Log Files
The Log File Analyzer enables you to view the following:

o A daily summary of errors, warnings, and other notifications produced by each process within
each Extension Pack

« Timing data for selected processes belonging to each Extension Pack
« Timing data for generating reports for different Extension Packs

The Log File Analyzer analyzes the prspi.logand PerfSPI Diagnostic Metrics.log
files.

To launch the Log File Analyzer:

Windows:

Select Start > All Programs > HP > NNM iSPI Performance > Log File Analyzer
Linux:

Runlog analyzer.ovpl

Warnings, Errors, and Other Notifications in iSPI for Performance Log Files

Summary data for warnings, errors, and other notifications covers the previous two weeks. The last
summary covers today. The summary for today is incomplete until midnight. Summary data
indicates the following:

e Date

o Number of errors per process, if any

o Number of warnings per process, if any

o Number of processes with fatal errors, if any
Here are examples:

prspi.20080729.1log:

WARN - 240 in ETL.Component Health
WARN - 268 in ETL.Interface Health
WARN - 285 in MainServiceLoop

ERROR - 2 in MainServiceLoop
prspi.20090915.10g:

WARN - 27 in ETL.Interface Health

WARN - 714 in MainServiceLoop

FATAL - 1 in Utility.startBI

FATAL 152 in ETL.Interface Health

FATAL - 1 in Utility.installExtensionPack

A warning normally indicates a transient condition, usually a temporary mismatch, that will self-
correct. If you see a warning message or a fatal error message, you can examine it in more detail by
viewing the associated logfile in a text editor.
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The last log in the list is today's partially complete log. This partially complete log does not have a
date attached to it. The file name for today's log is prspi.log

View Timing Data

Under the summary of all warnings and errors, if you press Enter, you can continue to see the
timing data.

The timing data shows the following:
o Total number of times a process executed over the previous two weeks
o Average execution time per process over the previous two weeks and standard deviation
o Maximum execution time per process over the previous two weeks
o Average number of records processed per execution
o Average number of records processed per second
Monitor Log Files

The log file viewer is Chainsaw 2.0. With Chainsaw, you can monitor DEBUG, INFO, WARN,
ERROR, and FATAL messages as they reach the prspi . 1og file. The file contains every
message generated since the previous midnight. The path to the file is:

e Windows:
%NPSDataDir%\NNMPer formanceSPI\logs
e Linux:
/var/opt/OV/NNMPerformanceSPI/logs
To launch the Log File monitor:
e Windows:
Select Start > All Programs > HP > NNM iSPI Performance > Log File Monitor
e Linux:

Run runChainsaw.ovpl

Use the Chainsaw Message Interface for the NNM iSPI Performance

The welcome page includes several tabs. To open the message interface, click the
NNMPerformanceSPl/logs/prspi.log tab.

The Chainsaw message interface displays the following panes:
e Event pane

o Detail event pane

o Treelogger pane

The event pane changes constantly, displaying the most recent message in prspi.log. Additional
information about that message appears in the detail event pane. When you select an older

message in the event pane, the detail event pane refreshes with additional information about that
message.
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The detail event pane indicates the following:
o Level

e Logger

e Time

e Thread

o Message

e NDC [null]

e Class [not used]

o Method [not used]

e Line

o File

o Properties

o Throwable [not used]

The logger tree pane shows the Root Logger folder.

The ETL folder, which appears under the Root Logger folder, contains three logger folders, one for
each standard Extension Pack. An additiional logger folder appears for any additional Extension
Packs that are installed.

New messages generated by the logger folders appear once every few seconds in the event pane.
To see messages for one logger only, type that logger name in the Refine focus on field; for
example:

Refine focus on:Interface Health

You can expand the event pane by closing the logger tree pane and the detail event pane.
Chainsaw version 2.0 features enable you to:

o Fully customize each tab.

o Control the frequency of updates.

o Specify your own rules for color-coding events (the defaults are yellow for WARN, red for
ERROR).

o Apply simple filters, or advanced expression-based filters.
o Save memory by setting a cyclic-based view that looks at X events only.

For more information about Chainsaw, run the tutorial under the Help menu or go to
http://logging.apache.org/chainsaw/quicktour.html

Enable Demo Data

The demo database is part of NPS. The NPS installation places the demo database on the system.
To view reports using the demo data, you must enable the demo database.

Enabling the demo database does not disrupt the ongoing data collection process of NPS. When
you disable the demo database, NPS begins to build reports using the real network data.
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Windows:

¢ Tolaunch the Demo Data Enable utility, select Start > All Programs > HP > NNM iSPI
Performance > Demo Data Enable.

o Todisable the demo database, select Start > All Programs > HP > NNM iSPI Performance >
Demo Data Disable.

Linux:
o Toenable the demo database, run:

demoData.ovpl enable

o Todisable the demo database, run:

demoData.ovpl disable

If you logged on via http://localhost:9300, you will receive an error message informing you that NPS
is unable to redirect you to the NNMi log-in page. Do either of the following:

e Login as the Bl Server Administrator. Click the link for the iSPI Performance navigation pane on
the page that is displayed. From the Bl Server pane, use the "log on as Administrator" link. (The
username is ErsAdmin, the default password is rooDkcaBnimdAsrE. The password can be
changed using the changeBlpwd.ovpl command.)

Or

o Logintothe NNMi system directly as an NNMi user, and launch NPS from NNMi.
NPS Databases

NPS offers long-term reporting on performance metrics. These metrics are stored in a database.
The database offers regular, bulk insertion of large volumes of data, as well as fast access to large
quantities of numeric data, including dynamic summarization for multiple users. This is offered by a
column store database rather than a traditional relational database.

NPS installs the Sybase 1Q column store database, which functions as the primary storage area for
collected data from all installed iSPls.

NPS also requires a traditional relational database, which provides for long-term storage of non-
numeric, lower-volume data, including report templates, data models, user and group information,
report schedules, and report schedule output for its Bl server. This database is referred to as the
content store.

NPS installs the Sybase ASE relational database, which functions as the content store.

Both databases are installed and configured automatically based on the resources available on the
server at installation.

Recreate the Database

You can recreate your Sybase |1Q data storage database and start over with the installation default
size of 2.5GB. This feature can be useful if your existing database has grown too large, or if you
want to lower your retention settings. Lowering the retention settings will maintain the smaller size
of the database for a longer period of time.

To recreate your database:
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e From the command line, run resetSPI.ovpl.
Or
¢ From the Windows Start menu:
RESET SPI
Option 1. Delete all data from database, & keep all archived data
Option 2. Delete all data from database, & restore archived data for reprocessing
Option 3. Delete all data from database, & delete all archived metrics/topology

Option 4. Delete all data from database, delete all archived data and lodfiles, & restart all
services

Option 5. Delete and recreate entire database using default size, location, and options
Enter Option (1-5), or Q to quit:

Option 5 deletes the database, discards all data stored in the database, and recreates it,
establishing the schema for each installed Extension Pack.

To restore archived data files for reprocessing (by default, NPS stores 28 days of archived data
files), use Option 2 before you recreate the database with Option 5.

Note: It is not possible to restore a previous backup into the recreated database and preserve its
smaller size. The backup restoration can only recreate the database files at the size they were
when they were backed up. It is possible, however, to relocate the database files to an alternative
location during a restore with the restore.ovpl -r option.

The database is created in the default data folder, SNPSDataDir/database. You can choose
another location by doing the following:

e On Linux, mount an alternate filesystem to $SNPSDataDir/database before running
resetSPI.ovpl.

o Back up the recreated (empty) database and restore it to a different location using the - r option.

o Leave the default 2.5GB database files in the default location, but use dbsize.ovpl toadd
sufficient additional files to the database and an alterative location.Make sure that the database
is made sufficiently large for steady state operations, so that NPS will not attempt to
automatically expand the default files to make database space at runtime.

You can find detailed information about the commands here.

Access Performance Troubleshooting

For operational performance management, NNM supports an external launch to the performance
analysis panel, which creates graphs that enable you to analyze the topology objects (nodes and
interfaces) on your system.

To access this feature, go to the NNM console. Select either a node or an interface, open the
Actions menu, select Performance > Troubleshooting.

The Performance Troubleshooting window is divided into two panes. Pane 1 shows a tree view with
the root node called Network. When expanded, all the nodes in the network that were performance
polled are shown. The interfaces for these nodes are also shown. Pane 2 appears blank. However,
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if you unselect the Quick view option, a third pane appears showing two graphs, Pre-defined and
Metrics.

You can drag and drop metrics to produce graphs for a selected time period.

For more information, see PerfSPI 4501 NNMiPerfTroubleshooting.htm.

Reference Pages
You can open a reference list of available commands by going to the command index.
Each command reference page provides the following information:
o Name

Synopsis

Description

o Author
For example, you can find information about the backup command at backup.ovpl.
To access information about the restore command, see restore.ovpl.

On Windows, many of the commands are Start menu options.

HP iSPI Performance Bl Server Portal
The HP iSPI Performance Bl Server Portal enables you to perform the following tasks:
e Open Public Folders and access reports from Bl Server Connection.
o Open My Reports and view reports with the filter preferences you saved.
¢ Set up the following preferences:
= Set up the display parameters for the reports.
= Select the report format
= Set up a schedule for running summary reports.
= Set up email report delivery.
= Modify Bl Server tuning parameters for large multi-user installations.
= Select language for your reports
o Create custom reports using Query Studio.
Launch the iSPI Performance Bl Server Portal
To launch the iSPI Performance Bl Server Portal:
1. Loginto NPS as Administrator.
2. On the navigation panel on the NPS home page, click Bl Server.

The Bl Server Log On page opens.

Page 39 of 230 HP Network Node Manager iSPI Performance for Metrics Software (9.20)



Online Help
Contents

3. Loginusing the ErsAdmin usemame and password. The default password is
rooDkcaBnimdAsrE.

HP recommends changing this password after logging in for the first time. To change the
password, run changeBIpwd.ovpl.

Optionally, you can start the iSP1 Performance Bl Server Portal as follows:

1. Select Start > All Programs > HP > NNM iSPI Performance > Bl Server Portal

2. RunlaunchReport.ovpl

Web Access:

1. Go to http://<localhost>:9300/p2pd/NPS.html.

2. Onthe login page, enter your ErsAdmin username and password.

Log In to the iSPI Performance Bl Server Portal as ErsAdmin

If you are unable to launch NNMi, you can reach the iSP1 Performance Bl Server Portal by going to
http://<localhost>:9300/p2pd.

When the login page opens, type your ErsAdmin username and password. The default password for
this useraccount is rooDkcaBnimdAsrE.

HP recommends changing this password after you log in to the iSPI Performance Bl Server Portal
for the first time using the ErsAdmin username. To change the password, run the
changeBIpwd.ovpl command.

Restart the iSP1 Performance Bl Server Portal with the new password after you change the default
password..

If you cannot launch NNMi, contact Support.

If you can open the iSPI Performance Bl Server Portal, you can confirm that the Bl Server is
running.

Change Report Format Preferences
The default report format used by NPS and the Bl Serveris HTML.

You can set the iSPI Performance Bl Server Portal preferences and enable NPS to generate reports
in any of the following formats:

e Adobe PDF

¢ Microsoft Excel 2007

o Microsoft Excel 2002

o Microsoft Excel 2000 Single Sheet

e Comma Separated Value (CSV) Files: displayed as Delimited Text (CSV) in the iSPI
Performance Bl Server Portal

o XML
To change the format of the reports generated by NPS:
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1. Loginto NPS home page with administrator privileges.

2. Onthe navigation panel, click the Bl Server tab.

w

Select the Bl Portal link.

4. IntheiSPI Performance Bl Portal form, click mMy Area.

5. Select My Preferences.

6. Inthe General tab, select a Report Format. The default format is HTML.
7. Click OK.

The new report format becomes the default report format for your user account. The Bl Portal
applies the new report format to all reports generated from your user account.

Set the Same Schedule for Multiple Reports

To set the same schedule for multiple reports, you must create a job. A job identifies a collection of
reports, report views, or queries that are scheduled together and share the same settings.

To set the same schedule for multiple reports:

1. Click the [ENew Job icon on the toolbar.
The New Job wizard opens.
2. Specify a name and location for the job.
3. Inthe Select the steps—New Job wizard form, click Add to add the job steps.

You can submit the steps in sequence or all at once. To modify the sequence of steps, click
Modify the sequence and rearrange the sequence of steps.

4. Inthe Select an action-job form, specify whether you want to save and run, schedule, or only
save the new job.

5. Click Finish.

Bl Server Guidelines for Tuning Performance

The Bl Server has tuning performance guidelines for single-server systems and distributed
systems. The HP Network Node Manager i Software Smart Plug-in is a single-system installation.
You can ignore the text about distributed systems in the Bl Server documents that discuss
performance tuning.

The following two parameters are especially important:
¢ Maximum number processes for the Interactive Report Service
o Maximum number processes for the Batch Report Service

If you have a lot of concurrent users, you might want to allocate more server resources to
processing queries. You can do that by resetting the maximum number of interactive services to
two per processor. If you have fast processors, you can set the maximum number of interactive
services to three. Thus, if you had 16 processors and set the number to two, you would end up with
32 interactive services.
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Creating a New Folder in the Bl Portal

To create a new folder in the Bl Portal:

1.
2.

In the HP NNM iSPI Performance Bl Portal, click _INew Folder.

In the New Folder Wizard form, specify the name, description, and location for the new folder.

3. Click Finish.

Bl Server Documentation

To access the Bl Server documentation, click Help on the Bl Server Portal.

Custom Poller

NNMi's Custom Poller feature uses SNMP MIB variables to gather additional device information
that is useful in managing your network. The Custom Poller enables you to:

View the list of topology nodes for which additional information is being polled as well as the
name of the associated Policy.

View the polling results. The first time the results for a specified MIB variable are discovered, the
results appear in a Polled Instance object. The Polled Instance object is updated whenever a
change in State is detected and includes the most current polled value that caused the State to
change.

View incidents that are generated by Custom Poller for a MIB Poll Variable.

For example, as an administrator, you could have NNMi monitor the Status of COM
(communication) ports on all of your Windows servers. You could also configure NNMi to send
incidents when certain MIB values are detected. Or to map returned MIB values to States and
include those States as part of the node Status calculations.

As an operator, the Custom Poller enables you to:

View the list of topology nodes for which additional information is being polled as well as the
name of the associated Policy.

View the polling results. The first time the results for a specified MIB variable are discovered, the
results appear in a Polled Instance object. The Polled Instance object is updated whenever a
change in State is detected and includes the most current polled value that caused the State to
change.

View incidents that are generated by Custom Poller for a MIB Poll Variable.

You can use the data collected by Custom Poller collections to construct and view reports using the
iSPI Performance for Metrics.

Overview of Custom Poller Collections and Their Associated Policies

Page 42 of 230 HP Network Node Manager iSPI Performance for Metrics Software (9.20)



Online Help
Contents

Custom Poller Collections ]
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See the NNMi online help for more information on the Custom Poller feature.

Reports for Custom Poller Collections

You can configure the iSPI Performance for Metrics to create reports based on the data collected by
NNMi's Custom Poller. The Report Groups tab in the Custom Poller Configuration form enables
you to generate reports from the metrics obtained from Custom Poller collections.

The iSPI Performance for Metrics creates new Extension Packs to display reports generated from
the data collected by Custom Poller collections.

Creating Additional Extension Packs

When you add a report group to the Report Groups tab, NNMi creates an Extension Pack for each
SNMP MIB table referenced in the Custom Poller collection. On the NPS home page, the
Extension Pack reflects the name of the SNMP MIB table. Multiple Custom Poller collections are
combined into a single Extension Pack if the collections use OIDs from the same MIB table.

Custom Poller Report Controls

You can use the standard report control links to access Time Controls, Topology Filters, Report
Options, and Adjust Time Range filters. You can search using any of the available attributes and
set filters to create a report based on the modification.

Time Control Tab

On the navigation panel of the NPS home page, click the Time Control tab to change the default
time filters for a report.
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Time Control Filters

Filter Usage

- Click the drop-down calendar box and select the appropriate date.
By default, the date is automatically set to the current date when you select
the Time Range.
- To set the time manually, select the Hour/Minutes/Meridian options
X separately, and then select the value by clicking the arrow.
By default, the time is automatically set to the current time when you select
the Time Range.
Time Range Click the drop-down menu to display the list of time ranges, and select the
Menu appropriate time.
If you select a time range that is beyond the Start Date and Time, the
following message appears:
Your start date/time is out of range. It will be
adjusted.
Click OK to adjust accordingly.
Auto Refresh Click the drop-down menu, and select the desired time to recreate the reports
based on the set interval.
By default, the Auto Refresh option is OFF.
The Auto Refresh option appears on the Time Controls page only after the
first report is generated.

Topology Filters Tab

On the navigation panel of the NPS home page, click the "Set Topology Filters" (on page 55) tab to
launch the Topology Selector.

The Topology Filter enables you to quickly find or select an element from the topology table using
selection mechanisms appropriate for the attribute type.

Attributes and Related Parameters Available for the Topology Filters

Attribute Parameter

Node Group Lists available Node groups in the network.
Name

Node Name Lists available Node names in the network.
Node Contact Lists available Node Contacts in the network.

Node Location

Lists available Node Locations in the network.

Node Family

Lists available Node Families in the network.

Node Vendor

Lists available Vendors in the network.
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Attribute Parameter

Node ID Lists available Node IDs in the network.

Node UUID Lists available Node UUIDs in the network.

Index Lists available Indexes in the network.
Contains the SNMP index OID values that identify specific MIB table
instances polled by Custom Poller policies. You can use these SNMP index
OID values to filter Custom Poller reports to show only specific instances
from the MIB table (use in conjunction with the NodeName filter).

Report Options

On the report, click the Options link to access the Report Options panel.

Report options provide a list of primary and secondary metrics for the selected Custom Poller
Extension Pack.

The metrics drop-down list differs according to the selected extension pack.

Create Extension Packs for Custom Poller Collections

To create an Extension Pack for a Custom Poller Collection, you must create a report group for a
Custom Poller Collection from the NNMi console.

Prerequisite: You must log on to the NNMi console with administrative privileges.
Task 1: Create a Custom Poller Collection

Create a Custom Poller Collection in the Custom Poller Configuration form by following the
instructions in "Create a Custom Poller Configuration," which can be found in the HP Network
Node Manager i Software Online Help for Administrators.

Task 2: Create a Custom Poller policy

Create a Custom Poller policy in the Custom Poller Configuration form by following the instructions
in the HP Network Node Manager i Software Online Help for Administrators.

Task 3: Create an Extension Pack for a Custom Poller Collection

1. Navigate to the Custom Poller Configuration form.
a. From the workspaces navigation pane, select the Configuration workspace.

b. Select Custom Poller Configuration.
2. Inthe Custom Poller Configuration form, select the Report Groups tab.

3. Click +i New. The Report Group form opens.

4. Inthe Report Group form, specify a name for the Extension Pack in the Basics section. Do not
use spaces in the name.

5. Inthe Report Collections tab, click '{El New. The Report Collections form opens.
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6. Toadd a Custom Poller Collection to the report group, click - Eﬁ v (the Lookup icon):
= To specify a Custom Poller Collection, click <= @uick Find... |Quick Find.
: : %jNEW
= Tocreate a new Custom Poller Collection, click New.

7. Set the Report Data Type to one of the following values:

= Gauge: Represents single non-cumulative values. Examples of Gauge data types include
Response Time, Bit Rate, and Temperature. During aggregation, the iSPI Performance for
Metrics calculates the minimum, maximum, and average values of gauge metrics.

= Percent: Represents single non-cumulative values that are formatted with a percent sign
(%) and two decimal places. Examples of Percent data types include Utilization and
Discard Rate. During aggregation, the iSPI Performance for Metrics calculates the
minimum, maximum, and average values of percent metrics.

= Counter: Represents incremental values. Examples of Counter data types include byte
counts, packet counts, and flow counts.

8. Inthe Report Collections form, click Save and Close.

9. Inthe Report Group form, click Save and Close. The iSPI Performance for Metrics creates a
new Extension Pack and adds a new tab on the Report Menu page.

Guidelines to Creating a Custom Poller Extension Pack
¢ You can associate a Custom Poller Collection with only one report group.

o If you associate more than one Custom Poller Collection with the same Report Group, make
sure the combination of Collections generates a meaningful report. Select Collections whose
MIB Variables represent the same index value across Custom Poller Collections.

o Avoid using keyboard symbols while naming the Custom Poller collection and customPoll OID.
The symbols <, >, ”, ", &, \ are replaced by a ! character in the report.

o Reports are not created if the # symbol is used in a customPoll name.
Remove Custom Poller Extension Packs
You can use command line tools to remove Custom Poller Extension Packs.
To remove Custom Poller Extension Packs:
1. Log in with administrative or root privileges to the system where NPS is installed.

2. Toview the list of Extension Packs, run:

uninstallExtensionPack.ovpl

3. Todelete a specific Extension Pack, run:

uninstallExtensionPack.ovpl -p<extension pack name>

You cannot recover the data associated with an Extension Pack if you inadvertently delete it. Make
sure to type the correct Extension Pack name with the command. Do not delete the following
default Extension Packs unless you want to remove iSPI Performance for Metrics reports:
Interface_Health, Component_Health. If you delete the PerfSPI_Diagnostics Extension Pack, you
will not be able to monitor the health of NPS processes.
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Modify Topology Attribute Values and Group Memberships from
NNMi

The topology attributes and groups help you filter the data and build the report with data polled from
the nodes and interfaces you select. NPS retrieves the topology attribute details from NNMi and
other iSPIs. If you make modifications to topology attributes and group memberships from NNMi,
the changes are reflected in NPS within about an hour.

Changes are not applied retroactively to the existing data. Changes are always forward-looking.
NPS preserves the historical accuracy of the data as it was when it was collected.

For example:

o Ifanew node is added to a group, it is only added for the new data collected going forward. NPS
cannot assume that the node was a member of the group in the past.

o If aninterface attribute changes—for example, if speed is changed from an old to a new value—
the change is applied going forward. NPS does not assume that the new speed applies to the
historical data.

If you delete or change a member of a topology attribute, the old member continues to appear in the
list of topology filters in NPS. The old attribute member continues to appear in the list of topology
filters. If you select the old member, the data collected before making the change gets sampled in
the report.

Example

Say you modify node group name A to node group name B in the NNMi console. The new node
name will appear in NPS after an hour or so. Later, the old node group name will continue to appear
in the list of node groups in the Topology Filters section. But, if you select A, you will not be able to
retrieve data samples associated with A that are polled after the node group name was changed to
B.

Suppose you had an interface group called Oracle Server Ports that identifies switch interfaces
assigned to your Oracle Server cluster, but now you have a new server cluster available online. You
decide to transfer your Oracle applications to the new one and repurpose the old servers to host the
Microsoft Exchange Server.

You therefore rename Oracle Server Ports to Exchange Server Ports and create a new interface
group for Oracle Server Ports identifying the ports associated with the new servers. If you run a
report at the end of the month to see the health of your Oracle Server Ports and your new Exchange
Server Ports, NPS will define an Oracle Server Ports group to include the data collected for the
original ports up to the time you made the change and for the new ports after that.

Likewise, NPS will define the Exchange Server Ports group to only include the ports from the time
the group was renamed. It will not include the ports while they were still being used for Oracle.

Set Polling Characteristics in NNMi

Performance polling impacts NNMi and your network. If you enable additional performance polling,
NNMi must allocate a portion of its resources to handle the additional polling. Your network must
accommodate an increase in SNMP traffic. To use the system and network resources wisely, limit
performance polling to the devices you require the most.

By default, NNMi enables performance polling for the following Node Groups:
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o Network Infrastructure Devices
¢ Routers

The following are some of the ways you can modify the performance polling defaults that will be in
place right after the iSPI is installed:

o Set thresholds for a node group you are already polling for performance data (no thresholds are
set by default).

+ Modify the frequency of performance polling.
o Add nodes to the Important Nodes group, and enable performance polling for this group.
o Enable performance polling for the Microsoft Windows Systems group.

All these processes involve monitoring configuration tasks. Monitoring configuration tasks are
related to polling.

For information about any of these processes, see the HP Network Node Manager i Software
Online Help for Administrators.

Set Thresholds for Metrics in NNMi

Until you set the thresholds for the Extension Pack metrics, the reports in that Extension Pack do
not track exception counts.

NNMi does not set thresholds for performance metrics for you automatically. You must set the
thresholds for the iISPI Performance for Metrics manually using the Thresholds Settings form in the
NNMi console. You can set thresholds for the following metrics:

e Discardratein

o Discard rate out

e Errorratein

o Errorrate out

o Utilization in

o Utilization out

e CPU 5second utilization
¢ CPU 1 minute utilization
¢ CPU 5 minute utilization
e Memory utilization

o Buffer utilization

o Buffer miss rate

o Buffer failure rate

For information about how to set thresholds using the NNMi console, see " Configure Threshold
Monitoring for Interfaces (HP Network Node Manager iSP| Performance for Metrics Software)" in
the HP Network Node Manager i Software Online Help for Administrators.
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Although you might want to see exception counts as soon as possible, setting thresholds right
away might not be feasible. You might want to wait until you are better acquainted with the way
your network behaves. If you set thresholds prematurely, you might experience problems. For
example, if the thresholds are wrong, NNMi might detect too many exceptions. Or, if you configure
NNMi to generate incidents in response to threshold conditions, NNMi might generate too many
incidents.

Threshold Terms Defined

« High Value (HV): Any value above this value is in the high range; any value in the high range
triggers a High status.

¢ High Value Rearm (HVR): Any value below High Value; indicates that the High status has
ended.

o High Trigger Count (HTC): The number of consecutive polls a high value must remain the
same before the status changes to High. A trigger count of 1 is usually appropriate.

o Low Value (LV): Any value below this value is in the low range; any value in the low range
triggers a Low status.

¢ Low Value Rearm (LVR): Any value above Low Value;indicates that the Low status has
ended.

o Low Trigger Count (LTC): The number of consecutive polls a low value must remain the same
before the status changes to Low. A trigger count of 1 is usually appropriate.

o Duration: The time limit before which the baseline metric state cannot change to Abnormal
Range or generate an incident. This time period specifies the minimum time within which the
metric value must remain out of the configured Baseline Range.

o Duration Window: The window of time in which the Upper Baseline Limt or Lower Baseline
Limit criteria must be met.

How to Use Reports

NPS and NNM iSPI Performance for Metrics generate reports on operational metrics over a
selected period of time. The content of these reports is defined in the core NPS reports, and is
extended by installing additional NNM iSPIs such as the NNM iSPI Performance for Traffic or NNM
iSPI Performance for QA.

You can perform the following tasks with NPS:
¢ View the operational performance of metrics over a period of time.

« Modify the default settings of a report to view additional attributes related to the monitored
element.

e Customize dashboards with pre-defined reportlets.
¢ Customize the schedule and format for report delivery.
o Create customized reports using Query Studio.

Avoid using Cognos Bl Report Studio to create or customize NNM iSPI Performance reports. HP
does not provide support for such reports.
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Launch Reports

You can launch reports created by NPS or NNM iSPI products from NNMi, the NPS home page, or
the iSPI Performance Bl Server Portal.

To launch a report from the NPS home page:

1. Loginto NPS using either the NNMi console or the NPS home page.

2. Onthe NPS home page, select Reports in the navigation panel.

NPS presents the default, ready-to-use Self Diagnostic Extension Pack (to generate reports on
the performance of NPS itself). Depending on the number of the NNM iSPI products or
Extension Packs available on the NPS system, you could see many other sets of reports.

3. Select areport type; for example, Chart Detail or Heat Chart.
4. Modify the default report settings, if required.

On the NNMi Network Overview workspace, if you select a node and click Actions > HP NNM
iSPI Performance > Reporting - Report Menu, the Report Menu page presents reports created
with the data collected from the selected node.

To navigate back to the NNMi console:
1. Inthe NPS home page navigation panel, click the Cross Launching tab.
2. Click NNMi Links.
3. Click NNMi Console.

The NNMi Console link enables you to go back to NNMi workspaces based on the topology
objects currently selected in NPS.

Launch Reportlets

You can launch reportlets created by NPS or NNM iSPI products from NNMi, the NPS home page,
or the iSPI Performance Bl Server Portal.

To launch a reportlet from the NPS home page:

1. Loginto NPS using either the NNMi console or the NPS home page.

2. Onthe NPS home page, select Dashboard Reportlets in the navigation panel.

NPS presents the default, ready-to-use Self Diagnostic Extension Pack (to generate reportlets
on the performance of NPS itself). Depending on the number of NNM iSPI Performance
products or Extension Packs available on the NPS system, you could see many other sets of
reportlets.

3. Select areportlet type (for example, Exceptions Pie Chart or Simple Bar and Line Chart).
4. Modify the default reportlet settings, if required.

On the NNMi Network Overview workspace (available in the Topology Maps workspace), select a
node and click Actions > HP NNM iSPI Performance > Reporting - Report Menu. The NPS
home page presents reportlets created with the data collected from the selected node.
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Change the Default Settings for Reports

NPS generates reports with a set of parameters, which are set when you launch a report from the
NPS home page or the NNMi console. Every NPS report or reportlet is built with the following sets
of parameters:

o Time controls

Time controls help you set the time range for the report or reportlet you want to view. The NPS
database stores the data collected from different nodes over a period of time. Using the time
controls parameters, you can view a report or reportlet created for the range of time of your
choice. You can also select the display grain of a report or reportlet. When a report or reportlet is
rendered, the time range is always shown in the Filter Summary section at the top of the report or
reportlet.

« Topology filters

The topology filters enable you to create a report that is filtered, or constrained in scope, by
specific topology attributes. By default, when you launch a report or reportlet for the first time
from the NPS home page, NPS generates the report or reportlet that is not filtered. However,
you can select a specific node or a set of nodes from the NNMi console (from the Topology
Maps workspace) and then launch the NPS home page to view reports or reportlets only on the
selected nodes. The topology filters extend this capability by offering a range of filters on the
NPS home page that help you select the data to be included or excluded prior to viewing the
report. When a report or reportlet is rendered, the selected filters are always shown in the Filter
Summary section at the top of the report or reportlet.

o Report options

Reports and reportlets display graphical and statistical representation of different operational
characteristics of the managed network. These characteristics are represented with metrics
(parameters that indicate the health and operational performance of the network). Althoug every
report and reportlet opens with the default metric set, the Report Options Panel helps you
generate the report or reportlet with the metrics of your choice.

Change the Default Settings for Reportlets

Reportlets display quick impressions of larger reports using the iSPI Performance for Metrics
dashboards. They consist of metrics (parameters that indicate the health and operational
performance of the network).

NPS generates reportlets with a set of parameters, which are set when you launch a reportlet from
the NPS home page. Every NPS reportlet is built with a set of parameters that is available in the
Report Options panel.

Every reportlet opens with a default metric set. To select a new metric, click E3'Show Toolbar and
WﬂOptions.

Change Report Options
The Options panel enables you to:
o Customize the report with additional options that vary for each report type.
o Select the metrics that are displayed on the report.

To change the report options:
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Launch the report from the NPS navigation panel.

Click Options.

The Report Options panel for the report opens.

You can change the following settings:

Metrics: Available only with Top N, Top N Chart, and Most Changed reports. A report
displays the metric, performance, or utilization associated with the monitored element. Most
reports open with the data for a default set of metrics.

To change the default metrics, use the Selected Metric(s) field.
To display only specific metric values, click ?Apply Filter.

Grouping By: Available only with select reports. In the Grouping By box, select an attribute
to define the grouping mechanism for the tabular data on the report.

o To select more than one attribute, click #IAdd New Metric. A new Grouping By box
with the list of attributes appears.

o Toremove a grouping attribute, click XRemove Metric.

° Todisplay or hide the start date, start time, or display grain for the report data, click N4
Apply Filter.

Top/Bottom N: Available only with the Top N and Most Changed reports. The Top/Bottom
N option helps you specify the number and order of data points for use with the Top N and
Most Changed reports.

Display Time Series Chart: Available only with the Top N report. The Display Time Series
Chart option enables you to view the time series chart at the bottom of the Top N report.

4. Click Confirm Selection. The modified report appears.

NPS preserves your choice of metrics for a report. When you come back to the report in the future,
the metrics you selected the last time are automatically used as the default metrics.

Change Reportlet Options

The Options panel enables you to:

o Customize the reportlet with additional options that vary for each reportlet type.

o Select the metrics that are displayed on the reportlet.

To change the reportlet options:

1.

2.

Launch the reportlet from the NPS navigation panel.

Click E:'Show Toolbar.

Click Tfoptions.
The Report Options panel for the reportlet opens.

You can change the following settings:
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= Metrics: Available only with select reportlets. A reportlet displays the metric, performance,
or utilization associated with the monitored element. Most reportlets open with the data for a
default set of metrics.

To change the default metrics, use the Metric field.

To display only specific metric values, click ?Apply Filter.

= Grouping By: Available only with select reportlets. In the Grouping By box, select an
attribute to define the grouping mechanism for the tabular data on the reportlet.

o To select more than one attribute, click #IAdd New Metric. A new Grouping By box
with the list of attributes appears.

o Toremove a grouping attribute, click XRemove Metric.

° Todisplay or hide the start date, start time, or display grain for the report data, click N4
Apply Filter.

= Top/Bottom N:Available only with select reportlets. The Top/Bottom N option helps you
specify the number and order of data points for use with the Top N and Most Changed
reports.

5. Click Confirm Selection. The modified reportlet appears.

NPS preserves your choice of metrics for a reportlet. When you come back to the reportlet in the
future, the metrics you selected the last time are automatically used as the default metrics.

Select a Topology Group

NPS generates reports based on topology filters and metrics. Topology filters generate reports on
network elements with specific topology attributes, and display data polled from selected network
elements. Metrics determine the health and performance of the selected topology elements.

The Preferences paneprovides the following topology group tracking methods:

e SCD Type1, which applies to data for which historical changes are not saved. For example, you
could create a new group and use it to filter data you collected previously (prior to forming the

group).

o SCD Type 2, which applies to data for which the historical changes are saved. This allows you
to keep track of the interfaces and nodes that are a member of group at a certain point in time
and see the reported data.

SCD (Slowly Changing Dimensions) is a term borrowed from data warehousing concepts and
refers to dimensions that have data that changes slowly rather than on a regular time-based
schedule.

You can define a group of topology elements and be able to look at data that was collected even
before the group existed. The data for this group would be based on current group contents. In such
case, you would select Type 1 as your filter.

Or you can monitor the statistics for a group of topology elements such that when the elements of
the group change over time, the collected historical data is not updated to reflect the current
contents of the group. You would select Type 2 as your filter.

Example
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The connectivity between the routers in Site A has been suffering from a high data loss percentage
for the past week. You decide to check the routers with the highest volume of incoming and
outgoing traffic in this location. You create a node group for the routers in Site A and generate the
Top N Report to see the list of routers with the highest volume of data. However, if you use the
traditional NodeGroup Name filter to apply the node group you created today, you cannot filter older
data. This means, using the default NodeGroup Name filter, you cannot display data older than the
node group.

Toresolve this, you can use the SCD Type 1 filter. Type 1 groups apply the most recent group
definition to all the historical data. In other words, reports generated based on Type 1 topology
groups display all data that matches the most recent definition of the group irrespective of the age of
the data. In this example, the report, when generated based on Type 1 node group, would display
past one week's data.

To select the Type 1 topology group:

1. Login to NPS from either the NNMi console or the NPS home page.

2. Inthe navigation panel, click Reports and select the report you want to view.
3. On the navigation panel, click Topology Filters.
4

Select a Type 1 group. For example, to select a Type 1 interface group, select an interface
group for the InterfaceGroup_Type1 Name topology filter. Do one of the following for the
topology attributes you want to filter:

= Toselect just one value for a topology attribute, click Single Value Select, and select a
topology filter.

= To select multiple values, click EIMulti value select and the topology filters (by using Ctrl-
click or Ctrl+Shift).

= Tosearch and select a value from a list of values, click @Search and select.

When launching reports from NNMi with a NodeGroup or InterfaceGroup selected, the default
behavior is to continue to use the traditional (Type2) "NodeGroup Name" or "InterfaceGroup
Name" filters in NPS. If, however, you use the Type1 filters, you can use the Topology Filters
page to clear the existing filters and apply the "NodeGroup_Type1 name" or "InterfaceGroup
Type1 Name" filters instead. The Type1 groups are also available in the Top-N reports as an
element group-by option.

5. To apply different types of topology filters, click Apply and repeat step 3.

Clicking the Apply button suppresses the values from the other topology attributes that are
irrelevant for your selection.

To discard your selection, click Reset.

6. Click Confirm Selection. NPS generates the report based on the specified topology
attributes.

Cookies are used to preserve your preferred method of selecting each topology filter. For example,
if you open a single value selector for an attribute, the single-valued selector will already be open
the next time you run a report. Avoid opening more selectors than you routinely need because they
add overhead (extra time) to running the report.
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Topology Group Tracking Method

Previous versions of the NNM iSPI Performance were designed to handle topology group changes
using the methodology known as Slowly Changing Dimensions (SCD) Type 2. Essentially, this
means that when you monitor the statistics associated with a collection of topology elements, if the
actual elements of that group change over time (add more nodes, delete some nodes. etc.), the
collected historical data does not get updated to reflect the current contents. This is the most
historically accurate way to track dimensional changes over time.

You can, however, define a group of topology elements and look at the historical data for the group
as a whole immediately, and look at data collected before the group existed. The data presented for
a group is based on the current group contents at the time the report is requested. This methodology
for tracking data associated with dimensional groups is known as SCD Type 1.

The terms SCD Type 1 and SCD Type 2 are borrowed from established data warehousing and
business intelligence concepts.

You can select the grouping type you prefer at any particular time. The system remembers your
choice so you do not have to set the value when you generate a report.

The navigation panel enables you to select either SCD Type 1 or SCD Type 2 as your topology
grouping method. Your selection is applied when you select a topology-based group (such as Node
Group or Interface Group) as a filter in your report.

The default selectionis SCD Type 1 upon first use. Once you select a preference, your selection
becomes the default. Making a selection has no effect until you also choose a topology group to
filter your report.

You can make topology filtering selections in several ways. You can launch from NNM with a group
already selected. Or you could launch the Topology Selector form from within the navigation panel.
This same form is included as a prompt page for every report. The top of the form includes a drop-
down that enables you to change your topology group tracking method.

Changing the value in the drop-down automatically updates the navigation panel preference setting.
Once your selection is applied, the filter display of all reports shows both the topology group and the
SCD type value in use.

Also see Select a Topology Group

Set Topology Filters

NPS generates reports created from different metrics that are polled from different nodes,
interfaces, and other network elements. You can use the Topology Filters feature to modify the
report to contain data polled from network elements you select. Topology filters enable you to filter
and generate reports with specific topology attributes.

All topology attributes are obtained from NNMi or the collectors and pollers of the iSPIs in use. You
cannot add new attributes or delete existing attributes.

By default, NPS preserves the historical integrity of topology data. Any changes made to topology
attributes (Interface Speed, ifAlias values, and so on) are not retroactively applied to the existing
historical data, but only to new data.

To use topology filters:
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1. Login to NPS from either the NNMi console or the NPS home page.
2. Inthe navigation panel, open the Reports tab and select the report you want to view.

To modify the topology filters for one of the most used reports, select a report from the My
Folders location. For more information on how to save a report into the My Folders location,
see "Save a Report into My Folder" (on page 75).

3. Inthe navigation panel, open the Topology Filter tab and click Launch Topology Selector.
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Topology Filter

Attribute Selection

Topology group tracking method ¥ SCD Type 1 j

InterfaceGroup Name 1 = R (]

NodeGroup Name DOEHBGE
MPLS L3VPN Name OB
MPLS VRF Name =) e

Qualified Interface Name =8 (g

Interface Name OB
Interface Alias DB
Interface Descr =) s e
Interface Index OEB
Interface Type DOEHBE

Interface Physical Address— = 2 (g
Interface Speed (In:0ut) — =B g

Interface ID =) s e
Interface UUID CDOEHBE
Interface ODBID DEBRE
Node Name DOEHBGE
Node Short Name OB
Mode Contact =) e
Mode Location CDOEHBE
Node Family OB
Node Vendor DOEHBGE
Node ID DOEBE
Node UUID CDEBRE
Node ODBID CDEBERE
Tenant Name OB
Tenant UUID DEBEG
SecGroup Name DB
SecGroup UUID DB
Node Annotation DOEHBE
Interface Annotation DOEHBGE

ooy

Page 57 of 230 HP Network Node Manager iSPI Performance for Metrics Software (9.20)



Online Help
Contents

4. Do one of the following for the topology attributes you want to filter;

= To select just one value for a topology attribute, click Single value select, and select a
value from the drop-down list.

= To select multiple values, click EAMulti value select, and select the values from the drop-
down list. You can click, Shift+click, Ctri+click, click Select all, or click Deselect all.

= Tosearch and select a value from a list of values, click @Search and select. The search

dialog opens.
gl _ | Keywords:

Type one or more keywords separated by spaces,

Search[g)
Options *
Results: Choice:
= » =
*

| -l

Select all Deselect all Select all Deselect all

5. To apply different types of topology filters, click Apply (which will suppress the values that are
irrelevant) and repeat step 3.

To discard your selection, click Reset.

6. Click Next > to open the Time Controls dialog.
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Data From: Relative Start | Yes J Hour of Day Day of Week
Defailled:  04/23/12 15:22 0 J Sunday
Hourly:  04/23/12 13:00 Last Roling Intenva | | monday
Dail',r: (14/23/12 00:00 2 Tuesda}r
Interval 1 Hour v
DataTo:  04/26/12 07:49 1 Wednesday
. — 4 Thursday
Display Grain | 5 Minute J 5 Friday Il
f J Saturday
Auto Refresh | Ho J
Select all Deselectal — Select all Deselect al
TimeZone | TimeZone J
Or

7. Click Finish to generate your report.

Cookies are used to preserve your preferred method of selecting each topology filter. For example,
if you open a single value selector for an attribute, the next time you run a report, the single value
selector will already be open. Be aware that opening more selectors adds extra time to running the

report.

The Self Diagnostic tab displays reports on different NPS processes with the data collected from
NPS. Therefore, you cannot see any node or interface-related attributes in the Topology Filters
section of any Self Diagnostic reports.

You can also exclude selected objects from the report.

Time Ranges with Default Display Grains

When you set a time range for a report, a predefined display grain is applied to the report. The
following table shows the mapping between the time ranges with the default display grains.

Time Range Display Grain

31 Days 1 Day
7 Days 1 Day
24 Hours 1 Hour
12 Hours 1/2 Hour
2 Hours 5 Minutes
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Time Range Display Grain

1 Hour 5 Minutes

30 Minutes 1 Minute

15 Minutes 1 Minute

5 Minutes As Polled

1 Minute As Polled

Until Now Adjusted appropriately based on Start Date/Time

Your choice of display grain defines the data source for the reports.

The following types of data sources exist within NPS:

¢ Internal Summary tables (data for up to 70 days)

o Internal Live tables (data for up to 1 day)

o Archive tables (data for up to ‘N’ days as set by the Configuration Utility)

Using a display grain of 1 hour or more ensures that your reports will source their data from the
Internal Summary tables. A display grain of less than 1 hour, combined with a Start Date/Time
within the last day, will result in the Live tables being used. A display grain of less than 1 hour,
combined with a Start Date Time prior to the last day, will force NPS to use the Archive tables to
fulfill the query. In this last case, a warning message will notify you that the report might be
relatively slower because it must perform a more time-consuming database query to retrieve the
data.

Special Scenarios

o Start Date/Time and Time Range extend beyond the available data: The Start Date and Time
automatically shift to allow the requested Time Range to be selected from the available data set.

o Start Date/Time requested is prior to the oldest data: If you request a Start Date/Time that is
prior to the oldest data in the NPS, the Start Date and Time shift to coincide with the oldest data
available. The Time Controls section notifies you of this after you make the selection.

o Start Date/Time is not on the boundary of the display grain: Graphs and charts always show
data grouped into sample sets, with the sample size defined by the display grain. The display
grain defines how samples of data are grouped across the time range. For example, a 1-hour
chart with a display grain of 5 minutes displays 12 samples of data. If the Start Date/Time is not
on the boundary of a display grain-sized sample, results can look unusual. The NPS always
attempts to round down the Start Date/Time to the beginning of the nearest display grain-sized
sample.

For example, a Start Time of 12:15 a.m. and a Time Range of 1 Day will have a default Time Grain
of 1 Hour, resulting in 24 samples. However, the samples for the hour representing 12:00 will only
have data from 45 minutes and will appear unusually low. To correct this, the Time Control will
move the Start Date/Time back to begin at 12:00 a.m. automatically.

Related Topics
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Change the Default Settings for Reports

Time Ranges with Default Display Grains

Time Changes and Time Zones
Semi-annual clock changes

If you turn clocks back one hour, statistics for one hour are recorded twice, once before the time
change, and once immediately after. Collecting statistics twice for the same hour doubles the
number of counts (volume in bytes, volume in packets) and the number of samples aggregated into
an average. If you turn clocks ahead one hour, a gap occurs because no samples are collectable for
the missing hour. Counts for that hour are zero, and counts for the whole day are artificially low.

Time zones

NNM marks performance data with a universal time stamp known as seconds since epoch. NPS
converts NNM's universal time stamp into local time, as defined by the location of NPS. From the
perspective of a user in a different time zone, NPS data is out of sync with the local time.

If NPS and the NNMi management server are running on separate systems, make sure that the
system clocks match. Otherwise, confusion will arise as you move from one application to the
other.

Change the Default Date and Time for Reports
To change the default date and time for reports:
1. Login to NPS from either the NNMi console or the NPS home page.
2. Inthe navigation panel, click Reports and select the report you want to view.

To modify the topology filters for one of the most used reports, select a report from the My
Folders location. For more information on how to save a report into My Folders location, see
Saving a Report into My Folder.

3. Inthe navigation panel, click Hour / Day Filters.
4. Select the following:
= Inthe Hour of Day list, select a default time for the reports.
= Inthe Day of Week list, select a default date for the reports.
5. Click Submit.

To cancel the selection, click Reset.

Change the Default Time Zone for Reports

By default, reports are generated according to NPS's time zone. You can select a different time
zone while viewing or scheduling a report in the Time Zone field.

NPS uses the selected time zone to generate all subsequent reports.

The selected time zone overrides the time zone preferences associated with your user account. If
you set the time zone back to the default value, NPS uses the following time zones:
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o The time zone set in your user account preferences

This overrides the NPS time zone. To change the default time zone, see Change the Report
Time Zone with the Time Control Tab

o The time zone used by NPS
If you did not set any preference for time zone in your user account, NPS uses this option.

The Filter Summary (V) of each report displays the selected time zone unless the effective time
zone is the default NPS server time zone, known as "Server Time."

Select the default time zone if you generate reports in a large scale environment. Selecting a
different time zone than Server Time requires NPS to convert the time stamps for the selected time
zone while generating the report. This can consume a lot of time.

Change the Report Time Zone with the Time Control Tab

To specify a preferred time zone:
1. Loginto NPS as Administrator.

2. Click Reports tab, select an Extension Pack, and select a report to apply the time zone.
3. Inthe navigation panel, click the Time Control tab.

4. Inthe Time Zone field, select a time zone.

5. Click Submit.

Keep in mind the following before changing the time zone.

o Semi-Annual Clock Changes

If you turn clocks back 1 hour, NPS records the metrics for that hour twice, once before the time
change, and once immediately after the time change. Collecting statistics twice for the same
hour doubles the number of counts (volume in bytes, volume in packets) and the number of
samples aggregated into an average.

But if you turn clocks ahead 1 hour, a gap of an hour occurs in the records because NPS does
not collect any data sample for the missing hour. Counts for that hour will be zero, and counts for
the whole day will be artificially low.

e Time Zones

NNMi marks performance data with a universal time stamp known as "seconds since epoch."
NPS converts NNMi's universal time stamp into local time, as defined by the time zone selected
for NPS. From the perspective of a user in a different time zone, NPS data will be out of sync
with the local time.

If NPS and the NNMi management servers are running on separate systems, the system clocks
must match.

Change the Display Grain for Reports

The Time Grain defines how samples of data are grouped across the Time Range.
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A 1 hour chart with a Time Grain of 5 minutes displays 12 samples of data. Adjusting the time range
automatically sets the Time Grain to a default value. You can adjust the Time Grain manually using
the navigation panel on the NPS home page.

To avoid partial samples of data being grouped together, NPS adjusts the Start Date/Time value to
the boundary of the default time range.

To change the default time grain for the reports:

1.

2
3
4.
5

Log in to NPS from either the NNMi console or the NPS home page.

In the navigation panel, click Reports and select the report you want to view.
In the navigation panel, select Time Control.

In the Grain section, select a time grain for your report.

Click Submit.

Your selection of Time Grain defines the data source for the reports. NPS uses the following types
of data source:

Internal Aggregate tables

Using a course time grain (1 hour or more) ensures that your reports will source their data from
the internal Aggregate tables.

Internal Live tables

Using a fine time grain (less than 1 hour) requires NPS to analyze the volume of live data in the
database and set the table type accordingly.

If the start time requested is before the earliest live data, NPS uses the internal aggregate table
as the data source. Otherwise, NPS uses the internal live table as the data source.

Archive tables

Change the Start Date or Time for Reports

The report shows the data collected from the time and date specified in the Time Control section.

To change the start date or time for a report:

—_

N o o > w0 Db

. Login to NPS from either the NNMi console or the NPS home page.

In the navigation panel, click Reports and select the report you want to view.

In the navigation panel, select Time Control.

In the Relative Start field, select No.

In the Start Date/Time section, click on the Date box, and select the appropriate date.
In the Start Date/Time section, click on the Time box, and select the appropriate time.

Click Submit

NPS adjusts the Start Date/Time automatically under the following circumstances:
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Start Date/Time and Time Range extend beyond the available data.

NPS moves back the Start Date/Time and selects the requested Time Range from the currently
available data set.

Start Date/Time requested is prior to the oldest data.

If your request for a Start Date/Time is prior to the oldest data in the system, NPS advances the
Start Date/Time to coincide with the oldest data available. The Time Control advises you of this
when your data set begins.

Start Date/Time is not on the boundary of the Time Grain.

NPS reports always show data grouped into sample sets. The sample size is defined by the
Time Grain. If the Start Date/Time is not on the boundary of a Time Grain sized sample, results
can look unusual when displayed. To prevent this, the Time Control always attempts to round
down the Start Date/Time to the beginning of the nearest Time Grain sized sample.

For example, a Start Time of 12:15 a.m. and an Interval of 24 Hours has a default Time Grain of
1 Hour, resulting in 24 samples. However, the samples for the hour representing 12:00 only have
data from 45 minutes and will appear unusually low. To correct this, the Time Control moves the
Start Date/Time back to begin at 12:00 a.m. automatically.

Change the End Date or Time for Reports

The report shows the data collected from the start time until the date specified in the Time Control
tab.

To change the end date or time for a report:

1.

N o g > 0D

Log in to NPS from either the NNMi console or the NPS home page.

In the navigation panel, click Reports and select the report you want to view.

In the navigation panel, select Time Control.

In the Relative Start field, select No.

In the End Date/Time section, click on the Date box, and select the appropriate date.
In the End Date/Time section, click on the Time box, and select the appropriate time.

Click Submit to generate the report for the time range ending on the date and time specified in
the End Date/Time.

NPS adjusts the Start Date/Time automatically under the following circumstances:

End Date/Time and Time Range extends beyond the available data.

NPS moves back the End Date/Time and selects the requested Time Range from the currently
available data set.

Time Range requested is prior to the oldest data.

If you request a time range (time between the Start Date/Time and End Date/Time) that is prior
to the oldest data in the system, NPS advances the Start Date/Time and End Date/Time to
coincide with the oldest data available.

The Time Control advises you of this when your data set begins.
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Change the Time Range (Interval) for Reports
The time ranges fall into the following categories:
o Fixed Period Length relative to the most recent sample stored in the system until now
To select this type of time range:
a. Loginto NPS from either the NNMi console or the NPS home page.
b. Inthe navigation panel, click Reports and select the report you want to view.
c. Inthe navigation panel, select Time Control.

d. Inthe Relative Start section, select Yes. If you select a Time Range that is relative to the
most recent data (for example, Last 1 Hour), NPS modifies the Start Date/Time accordingly.

o Fixed Period Length starting at the given Start Date/Time
You can select a time range applicable to a specific start and end date/time.

If you select a time range that would push the start date earlier than the available data sample,
NPS automatically adjusts the time range to set the start date/time at the earliest data record.

» To select the start date or time, see Change the Start Date or Time for the Report.

= Toselect the end date or time, see Change the End Date or Time for the Report.

Selecting a Time Range automatically sets the Time Grain to an appropriate value. You can change
the display grain manually.

Too many data points on a chart can make the results difficult to read.

Change Settings before Launching a Report

Sometimes the default options for running a report are suitable, but you can also modify the time
selections, topology filters, and report-specific options before running a report. Where appropriate,
reports include up to three separate prompt pages, which are used to supply specific values in the
three areas. The prompt pages are used when scheduling a report for automatic execution and are
also available when you want to configure the report with specific options prior to launching through
the navigation panel. The pages are:

e Time
o Topology
« Report-specific options such as the display of charts or metric choices

Within the navigation panel, left-clicking on a report in the tree will simply launch the report with
whatever choices are already in place. Right-clicking provides other choices, one of which is "Run
with prompts." This choice will guide you through the embedded prompt pages and then run the
report.

Refresh Report Data Automatically

The report is automatically refreshed with the fresh data samples if you select the auto refresh rate
with a relative start date and time.

For example, if you selected Last 1 Hour as the Time Range, and 1 Minute in the Auto Refresh field,
the report displays the data samples collected in the past hour and refreshes the data every minute.
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As aresult, if you generated the report at 12:00 p.m., the report shows data from 11:00 a.m. to
12:00 p.m., and refreshes the report data at 12:01 p.m.

To automatically refresh the report data:

1.

o o~ w0 DN

Log in to NPS from either the NNMi console or the NPS home page.

In the navigation panel, click Reports and select the report you want to view.
In the navigation panel, select Time Control.

In the Relative Start field, select Yes. By default, relative start is set to Yes.
Select the check box Auto Refresh. By default, auto refresh is set to No.

Click Submit

Select a Relative Start for Reports

The

Start Date/Time defines the point of origin of the report. The report shows the data collected

from the time and date specified in the Start Date/Time field.

To set relative start for your report:

1.

2
3
4.
5

Log in to NPS using either the NNMi console or the NPS home page.

In the navigation panel, click Reports and select the report you want to view.

. Open the Time Control pane.

In the Relative Start field, select Yes. By default, relative start is set to Yes.

In the Last field, select a time range for the report. For example, to generate a report based on

the last 31 days data, select 31 days in the Last field.

6.
7.

Select a different time grain if required.
Click Submit.

If you request a time range that is relative to the most recent sample of data, NPS moves the Start
Date/Time appropriately. In some cases, especially with a very recent installation, this can result in
a Start Date/Time that appears to be older than the start of the first data collection interval.

Adjust Time

The adjust time buttons have the following function:

Icon Description

@, Adjust time - zoom in. Enables you to view data points in a smaller time period.
=} Adjust time - zoom out. Enables you to reset and view the original data.

- Adjust time - back. Enables you to view a previous time period.

= Adjust time - forward. Enables you to select a future time period.
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Reportlet Controls

The Dashboard Reportlet page enables you to modify the reportlet properties using the following

tools.

Filter Control Description

Eﬁ Displays or hides the reportlet control toolbar
W Displays or hides the following information:

o Start date for the data displayed

o Start time for the data displayed

o Display grain for the data displayed
T Displays or hides the Report Options panel.
Displays or hides the Add Bookmark panel.

Contextual Navigation

NPS adds contextual links on the report content to navigate to related reports. By clicking a
hyperlink on the report, you can navigate to related reports with the context of the original report.

The following report types and contextual navigation are available.

Report

Type Contextual Navigation Point

Calendar X-axis: Opens report links for reports with the same Date/time context and the
same primary metric.

Chart X-axis: Opens report links for reports with the same Date/time context and the

Detail same primary metric.

Heat Chart | Hour of Day Row Header: Opens report links for reports with the same Hour of
Day filter of the selected row.

Day of Month Header: Opens report links for reports with the same Date/Time
filter of the selected row.

Data cell value: Opens report links for reports with the same Hour of Day filter of
the selected row and same Date/Time filter of the selected date.

Headline X-axis: Opens report links for reports with the same Date/Time context and same
metric.

Dashboard | Interface name from the Top 10 utilization, Response Time, or Discard
charts: Opens report links for reports with the same topology filter to selected
interface and the same metric.

Needles of the Exception Count gauges: Opens report links for reports with the
same metric.
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Top N Object name (for example, interface name or node name): Opens report links for
reports with the same topology filter.
Most Object name (for example, interface name or node name): Opens report links for
Changed reports with the same topology filter.

You can launch a report from the same Extension Pack tab, or from a different one. If you launch a
report from a different Extension Pack tab, only the relevant topology filters are preserved. Because
metrics vary between Extension Packs, the selected metric cannot be transferred to the target
report.

Cross Launch a Report

Where appropriate, the report or reportlet presents links to navigate to another related report or
reportlet. This feature enables you to refine your selection based on time, topology, or metrics
displayed on the report.

To cross launch a report or reportlet:

1.

Click the data point in the report or reportlet that launches another report or reportlet.

For example, click a point of time in the X axis of the Chart Detail report to drill down to the
Heat Chart report displaying the metric performance for the hour selected. Or, open the Top N
report to see the list of devices contributing most to the data at that interval.

You can set your browser to open either a new window or a new tab when you drill down. This
enables you to revisit the initial report and examine another data point at a later time.

Select the metrics for the drill-through report or reportlet.
NPS saves your selection for the next session.

Select a report or reportlet from the navigation panel. The new report or reportlet displays the
selected metric.

For more information on the contextual navigation available for each report type, see
Contextual Navigation.

Examples

The Dashboard report for Interface Health shows a high availability exception count. Clicking
the needle of the gauge launches the Report Menu with Availability Exceptions as the primary
metric. You can then launch the Top N report to find which set of nodes is causing the
availability exceptions.

Looking at the Top N interfaces and their network discard figures, one interface seems more
problematic than usual. Clicking the interface name launches the Report Menu with that
interface as a topology filter. You can then launch the Chart Detail report to examine discard
figures over the selected time interval for just that interface and determine when the problem
started.

Using the Heat Chart report for Interface Health shows a peak in traffic on one particular day.
Clicking the cell with the high value launches the Report Menu with that day already selected.
You can then launch the Interface Health Headline report and get an overview of multiple metrics
for each hour during that day.
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Create Bookmarks in Reports
NPS enables you to create bookmarks for reports in the NPS home page.

These bookmarks encapsulate all the selected settings (Time, filters, Options) and enable you to
quickly visit the report again from your browser.

Bookmarks are convenient for emailing and sharing reports.

To have the bookmark open the report within the same time range as the original report, select a
non-relative time range; for example, Start Date/Time with "1 Hour" and not "Last 1 hour" as the
time range. Otherwise, the report will show the most recent data.

To create a bookmark for a report:
1. Launch areport.
2. Click Show Bookmark. A URL appears.
Do the following:

= Only for Microsoft Internet Explorer. Click Add Bookmark. A bookmark to the report is
automatically added to the browser with a new entry to the Favorites list.

» Only for Mozilla Firefox: To create a new bookmark by using the displayed URL, right-click
the URL and select Bookmark This Link.

The bookmarked URL retains all the properties of the report.

Create Bookmarks in Reportlets
NPS enables you to create bookmarks for reportlets in the NPS home page.

These bookmarks encapsulate all the selected settings (Time, filters, Options) and enable you to
quickly visit the reportlet again from your browser.

Bookmarks are convenient for emailing and sharing reportlets.

If you want the bookmark to open the reportlet within the same time range as the original reportlet,
select a non-relative time range; for example, Start Date/Time with ‘1 Hour’ and not ‘Last 1 hour as
the time range. Otherwise, the reportlet will show the most recent data.

To create a bookmark for a reportlet:

1. Launch areportlet.

2. Click E:'Show Toolbar to display the reportlet toolbar.
3. Click E3show Bookmark. A URL appears.
Do the following:

» Only for Microsoft Internet Explorer. Click Add Bookmark. A bookmark to the reportlet is
automatically added to the browser with a new entry to the Favorites list.

= Only for Mozilla Firefox: Create a new bookmark by using the displayed URL.
The bookmarked URL retains all the properties of the reportlet.
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Enable Drillthrough
You can drill through reports to see more detail on elements you choose.

The Preferences tab of the navigation panel provides the option to automatically enable drillthrough
on reports you plan to run.

Preferences

Open separately
.+ Enable drilthroughs

Or you can click the q@ drillthrough icon for a report you already ran.

When drillthrough is enabled, you can click an area of interest within the report to get more details.
For example, say that you clicked inside the following Volume graph at time 01:55.

Volume (GB) Availability (Avg %)

0.06

01:35 01:40 01:45 01:50 01:55 02:00 02:05 02:10 02:15 02:2002:25 02:30 01:35 01:40 01:45 01:5001:55 02:00 02:05 02:1002:15 02:2002:25 02:30
B Gigabytes In -~ ¥ Gigabytes Out B Availability% @ Unavailability %
Utilization (Avgh and Max®) Exception Rates: Threshold and Baseline
1.00%
0.80%
0.60%
0.40%
0.20%
I
01:35 01:40 01:45 01:50 01:55 02:00 (2:05 02:10 02:1502:2002:2502:30 001:35 01:40 01:45 01:50 01:55 02:00 02:05 02:10 02:15 02:20 02:25 02:30

—In{Max) —In — Qut Max — Out B Threshold ¥ Baseline

The following detail would appear for that time period.
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01:55 01:56 ors7 01:58 01:55 0156 ons7 0158
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280%
2008
1.20%
0.40%
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Add URL Actions in the NNMi Console

After you generate a bookmark, you can create a new Actions menu item with the newly generated
bookmark, which enables you to launch a report or reportlet directly from the NNMi console.

To add URL actions in the NNMi console to launch a report or reportlet:

1. Generate the bookmark for the required report or reportlet.

2. Inthe NNMi console, select the Configuration workspace from the workspace navigation
panel.

3. Select User Interface.

4. Select Menu Items.

5. Click T New.
The Menu Item form opens.

6. Inthe basics section of the Menu Item form, specify the following details:
= Menu Item Label: The name of the report or reportlet you want to launch.
= Unique Key: A unique identifier for the menu item. Type an identifier.

You can use alpha-numeric and period (.) characters. Do not exceed 80 characters. Do not
use spaces and underline characters. To make the value unique, use the Java name space
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10.

1.
12.
13.
14.

convention while specifying this value. Include the Menu Item Label value as part of the
unique key; for example:

com.<compahy _name>.nnm.menu.1tem.<menu_item label>

B~

= Author: Specify the default value Customer, or click
example, NPS.

to add a new author name; for

= Parent Menu: Retain the default value—Actions.

= Ordering: Specify an integer between 1 and 100. The lowest number appears at the top of
the Actions menu. The highest number appears at the bottom of the Actions menu.

= Prepend Separator: Select this option to add a horizontal line before the report or reportlet
menu item in the Actions menu.

= Enable: Select this option to use the report or reportlet bookmark.

Retain all other default settings in the Basics section.

In the Menu Item Context tab, click qF-_hl New.

The Menu Item Context form opens.

b - .
In the Basics section, click el and  |New Launch sction ‘New Launch Action.

The Launch Actions form opens.
In the Launch Actions form, specify the following:
= Name in the Name box

= Bookmark URL in the Full URL section

Click % Save and Close.

Click % Save and Close in the Menu Item Context form.
Click % Save and Close in the Menu Item form.

Click % Save and Close in the User Interface Configuration form.

Now you can launch the report or reportlet from the Actions menu.

View a Report using Different Report Formats

NPS and the Bl Server use web-based HTML as the default report format.

You can also view a report in Adobe PDF or Microsoft Excel formats.

To view areport in non-HTML format:

1.

In the NNMi console, click Actions > HP NNM iSPI Performance > Reporting - Report
Menu. The NPS home page opens.

On the navigation panel, select the Reports tab. NPS presents the Self Diagnostic reports for
the default, ready-to-use Self Diagnostic Extension Pack. Depending on the number of the
NNM iSPI products or Extension Packs available on the NPS system, you could see other
report folders.
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Under an Extension Pack, select a report.

In the Time Controls tab, select a time range for the report. For information on selecting the
time range for a report, see Change Time Controls.

Click “|View in HTML Format.

Select one of the following options:
= View in PDF Format. A PDF version of the report appears in the same browser window.

= View in Excel Options and View in Excel 2007 Format, View in Excel 2002 Format, or
View in Excel 2000 Single Sheet Format.

Change Time Controls

When you launch a report from the NPS home page, the report shows the data collected over the
selected time range relative to the most recent data sample.

To change time controls:

1.
2.

Log in to NPS from either the NNMi console or the NPS home page.

In the navigation panel, click the Reports tab, select the Extension Pack and the report you
want to view.

To modify the time controls for one of the most used reports, click My reports. For information
about how to save a report into My Folders location, see Saving a Report into My Folder.

On the navigation panel, open the Time Controlpane.

You can change the following parameters:

Time Control Function

Relative Start Sets the start date for the reports based on the available data

Adjust time Adjusts the time

Interval Changes the time range for the report

Grain Changes the display grain for the report
TimeZone Enables you to select a preferred time zone
Auto Refresh Refreshes report data automatically

Hour of Day Enables you to:

» Select the appropriate hour of the day from the list.

= For multiple selections, select the appropriate hour from the list, and then hold
down CTRL to select each additional hour.

Day of Week Enables you to:

» Select the appropriate day of the week from the list.
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Time Control Function

= For multiple selections, select the appropriate day from the list, hold down
CTRL to select each additional day.

Reset Cancels the previous selection

Submit

5. Do one of the following:
= On the Report Options panel, click Submit.
» Click Confirm Selection.

If you are viewing the Time Control pane while launching the report from within the Bl Server
connection, you might see additional navigation buttons at the bottom of the screen. These buttons
enable you to move forward to the Topology Filters screen.

Button Function

Cancel | Click to cancel the report generation

Back Click to go back to the previous page of the report generation. If you are in the first page,
the option will be disabled.

Next Click to move to the next page of the report generation

Finish | Click to display the report for the selected filter.

Run a Report in Background

Some reports can take a long time to generate. You can run such reports in the background and
have the output saved to a folder on the Bl Server. You can also have it emailed.

If the report takes more than a few seconds to generate, a prompt will appear offering an alternate
delivery method for your report.

Your report i rurring.

{i,,::) Ervabeied of walilng, you Can st it o funin the
badkground with one of the following delvery
ophons:

g w5 Bemiort View
] Emad Report

Cancel

If you choose Save as Report View, enter a name for the report and save to MyFolders or to another
folder that allows you to save reports. You can then view the new ReportView at your convenience
from the left-hand navigation panel.

If you choose email, enter the email fields.
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Set Up the Email Server

To use the NPS console to email reports, you must run the configureBIEmailServer.ovpl script one
time to configure the details for your email server.

When you run the script, any existing email server information will be overwritten.

Create Shortcuts to Commonly Used Reports

You can quickly launch reports from the navigation panel using shortcuts.

You can create a custom shortcut folder that contains a set of report views (Quicklaunch
ReportView) with options you select.

To create a custom Quicklaunch ReportView:

1.
2.
3.

4.
5.

Create a folder and name it anything you want; for example, My Quicklaunch ReportViews.
Launch a report with filters by clicking Run with prompt.

Create a ReportView by clicking Keep this version and Save as Report View, selecting
Select another location, and selecting the folder you created.

Provide a name for the report view; for example, Top 10 Nodes by Volume in Last Day.

Repeat to create another Quicklaunch ReportView.

Save a Report into My Folder

To save areport in the My Folder location:

1.
2
3
4.
5

6.

Log in to NPS from either the NNMi console or the NPS home page.

On the NPS home page, click the Bl Server tab in the left navigation panel.
Click Public Folders, select an Extension Pack and the required report.
Click BfCreate a report view for this report.

In the Specify a name and description-New Report View wizard form, click Select My Folders
for the Location: section.

Click Finish.

Limit Access to Reports

The Administrator can manage access to reports that are run when a ReportView is created.

Access to such reports can be controlled in any of the following ways:

e Login as the tenant before creating the ReportView.

o Create the ReportView as Administrator but delete the saved output.

o Apply tenant name filtering before saving the ReportView.

Create Custom Reports with Query Studio

You can create custom reports with metrics from all available Extension Packs. You can also
combine metrics from all available Extension Packs while creating a custom report.

HP does not offer any support for custom reports.
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To create a new report:

1.

2
3.
4

Log in to NPS as Administrator.

. Onthe NPS home page, click the Bl Server tab in the navigation panel.

Select Query Studio. The Select a package (Navigate) window opens.

. Select a Public Folder.

The options are:

iISPI Metrics
Self Monitoring (admin users only)
Standard ReportViews

User Groups

For example, select iSPI Metrics.

Select an Extension Pack; for example, Interface_Health.

The HP NNM iSPI Performance Bl Query Studio window opens.

The Query Studio window consists of a Menu panel; two toolbars (Standard and Style), either
of which can be hidden; and the work area where you will see your report being built.

Click Insert Data in the Menu panel to list the query items for the Extension Pack you
selected.

For our Interface Health example, the options are:

d_Interface_Health_Time
d_InterfaceTopology

g_InterfaceGroup Type1_InterfaceTopology
g_InterfaceGroup Type2_InterfaceTopology
g_NodeGroup Type1_InterfaceTopology
g_NodeGroup Type2_InterfaceTopology
g_MPLS L3VPN Type1_InterfaceTopology
g_MPLS L3VPN Type2_InterfaceTopology
g_MPLS VRF Type1_InterfaceTopology
g_MPLS_VRF Type2_InterfaceTopology

f Virtual_InterfaceMetrics

nnmdetails_Interface_Health

Select a time range as follows:

a. Expand the time query item; for example, d_Interface Health_Time.

b. Right-click a time range—for example, Day (of Week)}—and click Insert or drag it into the
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work area.
The time range appears in a column in the work area. You can add more time ranges.

You can also add time dimension columns that will return relative time queries. For more
instructions, see "Adding Relative Time Queries to Custom Reports with Query Studio" (on

page 78).

To delete a time range from the work area, right-click the column for the time range, and click
Delete.

8. Select atopology group as follows:
a. Expand the InterfaceTopology query item; for example, d_InterfaceTopology.
NPS displays only the topology groups associated with your security group.
b. Right-click a topology group and click Insert.
The attribute appears in a column in the work area.

To display meaningful data in the report, select a topology group relevant to the metrics you
plan to select.

To delete an attribute from the work area, right-click the column for the attribute and click
Delete.

Node groups and interface groups are separate items in the menu. To select a node or
interface group, repeat the previous steps.

9. Add atopology context as follows:
a. Expand an InterfaceGroup or NodeGroup query item.
b. Right-click a group and click Insert.
The group will be added to your report.

To delete an attribute from the work area, right-click the column for the attribute and click
Delete.

NPS displays all topology attributes from all installed Extension Packs. However, not all
topology attributes are applicable to metrics from all Extension Packs. If you point the mouse
arrow over a topology attribute, a tool tip shows the Extension Packs that support that
attribute.

10. Select a metric for the report as follows:

a. Expandthef Virtual_InterfaceMetrics query item.

b. Right-click a metric click Insert. The metric will appear in your report.

To delete a metric from the work area, right-click the column for the metric and click Delete.
11. Format the report with the style toolbar.
12. Togive your report a title:

a. Click Title. The Edit title area window opens.

b. Enteratitle and, if you want, a subtitle.
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13.

14.

15.

c. Click OK.

To run the report, click Run Report in the Menu navigation panel. You will be prompted to enter
a TimeZone. Enter the same value you selected when you performed the Insert Data steps.

To save the report, click Manage File in the Menu navigation panel. Select the Save As...

option.

Make sure to save it in My Folder or another location. Do not save any reports made using
Query Studio in any of the Extension Pack folders.

You can view the report when you log in to the iSPI Performance Bl Server Portal.

You should avoid using Cognos Bl Report Studio to create or customize reports. This is because
support for such reports is not available.

For more information on using Query Studio, see the following Bl Server documents:

o Query Studio Quick Tour

o Query Studio User Guide

Adding Relative Time Queries to Custom Reports with Query Studio

You can add time dimension columns to your custom report that will return relative time queries.
The Date/Time dimension column provides the following time grain options:

Month

Week

Day (of Month)
Day (of Week)
Day

Hour (of Day)
Hour

Hour (epoch)

Half Hour (of Day)
Half Hour

Qtr Hour (of Day)
Qtr Hour

10 Minute (of Day)
10 Minute

5 Minute (of Day)
5 Minute

Minute

Minute (epoch)

Previous Month
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e Previous Day

o Previous Hour

o Previous

e This Week

e This Day

e This Hour

o This Minute

For example, you could build a report that calculates the difference between Week and This Week.

1. Launch Query Studio, select the Interface Health ExtensionPack and expand the f_Virtual_
InterfaceMetrics folder.

Select the options Week and This Week and drag them into the work area.

To calculate the data, press Ctrl and click both column headings.

Click the E& Calculate button. The Calculate dialog opens.

a > w0 N

In the Operation box, select - (difference in days). The options are:
= - (subtraction)

= - (difference in days)
= - (difference in months)
= - (difference in years)
= Adddays

= Add months

= Addyears

= Earliest

= Latest

= Year

= Month (number)

= Week

= Day

6. Under Order, select Days between(Week, This Week) and click Insert. A new column, Days
between(Week, This Week) is added to the report.

7. Click the new column and click the " Filter button. The Filter dialog opens.
8. Under From, enter 0, which represents "this week."
Under To, enter 7, which represents "last week."

A range can also be entered; for example, 0-7.
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Click OK.
The value is calculated.

You can add more columns to this report. For example, you could add a measure such as Utilization
(pctile95). And you can delete columns until the report reflects the information you need.

Launch Performance Troubleshooting for a Selected Node or
Interface

The NNMi performance analysis panel displays graphs that provide data about connections, nodes,
and interfaces in your system.

To use this feature:

o Select a performance-polled node from the NNM node inventory view. Click Actions > HP
NNM iSPI for Performance > Performance Troubleshooting. The feature is launched for
only the selected node.

All the interfaces of the node are also available.

o Select a performance-polled interface from the NNM node inventory view. Click Actions > HP
NNM iSPI for Performance > Performance Troubleshooting. The feature is launched for the
selected interface.

The interface appears under the parent node in the tree. All other interfaces of the node are also
visible.

If the interface is not being polled, the panel is blank.

How to Find Data for a Connection in the NNMi Analysis Panel
You can find data for NNMi L2 connections through the performance analysis panel.
To use this feature, select an interface in a view in the NNMi console.

Graphs show data captured for the interfaces that comprise the endpoints of the connection over
the past day.

You can adjust the time period shown by clicking the arrow on the top right-hand side. This opens
the time navigation panel. Any change you make is reflected in all of the graphs.

The following graphs are provided:
Graph 1:

o Availability (avg)

Graph 2:

o Utilization In (avg)

o Utilization Out (avg)

o Utilization (avg)

Graph 3:

o Error Rate (avg)

o Discard Rate (avg)
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Graph 4:

e Throughput In (avg)
o Throughput Out (avg)
o Throughput (avg)
Graph 5:

This graph is shown only if the node is capable of exporting Traffic data (netflowv5, Netflowv9,
SFlowv5, IPFIX).

¢ Volume - In Bytes (sum)

o Volume - Out Bytes (sum)

How to Find Data for an Interface in the NNMi Analysis Panel
You can find data for NNMi interfaces through the performance analysis panel.

To select an interface, start in a view in the NNMi console. The performance panel opens once you
select an interface.

Graphs show data captured over the past day.

You can adjust the time period shown by clicking the arrow on the top right-hand side. This opens
the time navigation panel. Any change you make is reflected in all of the graphs.

The following graphs are provided:
Graph 1:

o Availability (avg)
Graph 2:

¢ Utilization In (avg)

o Utilization Out (avg)

o Utilization (avg)

Graph 3:

o Discard Rate In (avg)

« Discard Rate Out (avg)
o Discard Rate (avg)
Graph 4:

e Throughput In (avg)

e Throughput Out (avg)

o Throughput (avg)
Graph 5:

This graph is shown only if the node is capable of exporting Traffic data (netflowv5, Netflowv9,
SFlowv5, IPFIX).
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o Volume - In Bytes (sum)
¢ Volume - Out Bytes (sum)

How to Find Data for a Node in the NNMi Analysis Panel
You can find data for NNMi nodes through the performance analysis panel.

To select a node, start from the Flow Enabled Nodes view in the NNMi console. The performance
panel opens once you select a node.

Graphs show data captured over the past day.

You can adjust the time period shown by clicking the arrow on the top right-hand side. This opens
the time navigation panel. Any change you make is reflected in all of the graphs.

If you select a node for which no polling is being done, the performance panel will be blank.
The following graphs are provided:

Graph 1:

« Memory Utilization (avg)

o Memory Utilization - Threshold Exception Rate

Graph 2:

o CPU Utilization (avg)

e CPU Utilization - Threshold Exception Rate

Graph 3:

o Node Backplane Utilization (avg)

o Node Backplane Utilization - Threshold Exception Rate
Graph 4:

This graph is shown only if the node is capable of exporting Traffic data (netflowv5, Netflowv9,
SFlowv5, IPFIX).

¢ Volume - In Bytes (sum)
o Volume - Out Bytes (sum)
How to Find Data for a Node Fault in the NNMi Analysis Panel
You can find data for NNMi nodes through the performance analysis panel.
When NNMi detects that a node is down (not responding), a NodeDown event is generated.

To select a NodeDown incident, start from the Incident view in the NNMi console. The performance
panel opens and displays several graphs.

The graphs report data for the following time period:
o Start Time: Time period of incident minus 1 hour
e End Time: Time period of incident plus 1 hour

If the plus 1 hour time period is not possible, data for the past 1 hour is shown.
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To navigate forward in the graph, click >. To navigate backward, click <.

You can adjust the time period shown by clicking the arrow on the top right-hand side. This opens
the time navigation panel. Any change you make is reflected in all of the graphs.

The following graphs are provided:

Graph 1:

e Memory Utilization (avg)

o CPU Utilization (avg)

Graph 2:

o CPU Utilization - Threshold Except Rate

¢ Memory Utilization - Threshold Exception Rate

How to Find Data for a Node Performance Event in the NNMi
Analysis Panel

You can find data for NNMi nodes through the performance analysis panel.

To select a performance incident for a performance-polled node, start from the NNMi Incident view
in the NNMi console. If NNMi detects that a node is violating a configured performance metric
threshold—for example, CPU utilization—a CPUOutofRangeOrMalfunctioning event is generated
and made visible in the Incident view. When you click this incident, a performance tab appears in
the analysis pane. When you click the tab, the graphs described below appear.

Supported events are:

o CPUOutofRangeOrMalfunctioning

o BufferOutOfRangeOrMalfunctioning

o MemoryOutOfRangeOrMalfunctioning

The graphs report data for the following time period:

o Start Time: Time period of incident minus 1 hour

¢ End Time: Time period of incident plus 1 hour

If the plus 1 hour time period is not possible, data for the past 1 hour is shown.

You can adjust the time period shown by clicking the arrow on the top right-hand side. This opens
the time navigation panel. Any change you make is reflected in all of the graphs.

If you select a node for which no polling is being done, the performance panel will be blank.
The following graphs are provided:

Graph 1:

e Memory Utilization (avg)

o CPU Utilization (avg)

Graph 2:
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o CPU Utilization - Threshold Exception Rate
¢ Memory Utilization - Threshold Exception Rate
Graph 3:
This graph is shown only if there is a Buffer incident.
o Buffer Utilization
o Lower and Upper Thresholds for Buffer Utilization
Graph 4:
This graph is shown only if there is a Buffer incident.
o Buffer Hits and Misses
How to Find Data for an SNMP Agent in the NNMi Analysis Panel
You can find data for NNMi nodes that host an IP address through the performance analysis panel.

To select an SNMP agent, start from the SNMP Agent Inventory view in the NNMi console. The
performance panel opens.

Graphs show data captured over the past day.

You can adjust the time period shown by clicking the arrow on the top right-hand side. This opens
the time navigation panel. Any change you make is reflected in all of the graphs.

You can refresh the graphs with the Refresh button.
The following graphs are provided:
Graph 1:
e ICMP response time
o SNMP response time
Graph 2:
o CPU Utilization (avg)
o Memory Utilization (avg)
Graph 3:
e CPU Utilization - Threshold Exception Rate
o Memory Utilization - Threshold Exception Rate
How to Find Connection Data for a Node in the NNMi Analysis Panel
You can find connection data for NNMi nodes through the performance analysis panel.

To select a node, start from the Flow Enabled Nodes view in the NNMi console. The performance
panel opens once you select a node.

Graphs show data captured over the past day.

To navigate forward in the graph, click >. To navigate backward, click <.
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You can adjust the time period shown by clicking the arrow on the top right-hand side. This opens
the time navigation panel. Any change you make is reflected in all of the graphs.

If you select a node for which no polling is being done, the performance panel will be blank.
The following graphs are provided:

Graph 1:

e Memory Utilization (avg)

e Memory Utilization - Threshold Exception Rate

Graph 2:

o CPU Utilization (avg)

e CPU Utilization - Threshold Exception Rate

Graph 3:

« Node Backplane Utilization (avg)

« Node Backplane Utilization - Threshold Exception Rate
Graph 4:

This graph is shown only if the node is capable of exporting Traffic data (netflowv5, Netflowv9,
SFlowv5, IPFIX).

¢ Volume - In Bytes (sum)

¢ Volume - Out Bytes (sum)

How to Find Interface Data for NNMi Ports in the NNMi Analysis
Panel

You can find data for NNMi ports through the performance analysis panel.

To select an interface, start in a view in the NNMi console. The performance panel opens once you
select an interface.

Graphs show data captured over the past day.

You can adjust the time period shown by clicking the arrow on the top right-hand side. This opens
the time navigation panel. Any change you make is reflected in all of the graphs.

The following graphs are provided:
Graph 1:

o Auvailability (avg)

Graph 2:

o Utilization In (avg)

o Utilization Out (avg)

o Utilization (avg)

Graph 3:
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o Discard Rate In (avg)
« Discard Rate Out (avg)
o Discard Rate (avg)
Graph 4:

e Throughput In (avg)

e Throughput Out (avg)
e Throughput (avg)
Graph 5:

This graph is shown only if the node is capable of exporting Traffic data (netflowv5, Netflowv9,
SFlowv5, IPFIX).

¢ Volume - In Bytes (sum)

o Volume - Out Bytes (sum)

How to Find Data for an Interface Performance Event in the NNMi
Analysis Panel

You can find data for interfaces through the performance analysis panel.

When NNMi detects that an interface is violating a configured performance metric threshold (for
example, utilization), an InterfaceUtilization event is generated and shown in the Incident view.
When you click this incident, the performance analysis panel opens.

The graphs report data for the following time period:
o Start Time: Time period of incident minus 1 hour
e End Time: Time period of incident plus 1 hour

If the plus 1 hour time period is not possible, data for the past 1 hour is shown.
The following types of incidents are reported:

o InterfaceFCSWLANErrorRateHigh

o InterfaceFCSLANErrorRateHigh

o InterfacelnputDiscardRateHigh

o InterfaceOutputDiscardRateHigh

o InterfacelnputUtilizationHigh

o InterfaceOutputUtilizationHigh

o InterfaceOutputErrorRateHigh

o InterfacelnputErrorRateHigh

The following graphs are provided for each incident:
¢ Interface Utilization

o Interface Availability
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o Interface Throughput

¢ Interface Discard and Error Rate

Baseline Metrics

NPS provides baseline metrics that define the normal (expected) range of values for any given
metric. Baseline metrics enable you to forecast the future value for a given metric on the basis of
historical data. They are the following:

o Seasonality — Represents a periodic and repetitive pattern in the metrics utilization levels. The
repetitive (cyclic) nature of this pattern enables NPS to predict the future utilization values for
the metric. The default period for seasonality is one week with five minutes granularity.

o Initialization period — Represents the period during which NPS collects data required for
calculating the baseline metrics. NPS does not generate any exceptions for this period,
considering the data range to be insufficient to calculate a reasonable normal range.

For example, if the initialization period is set as four weeks,NPS does not calculate any baseline
exception for these four weeks. After four weeks, NPS calculates the normal ranges of metric
values based on the data collected during these four weeks. The default initialization period for
NPS is three weeks or three seasons. The default time range for each season is one week.

« Adaptation Parameters — Represents the technique used to smooth the historical data for a
given time range and forecast the metrics value. NPS uses intercept, trend, and seasonal
adaptation formulas to smooth the historical data and calculate the forecast value.

Metric Aggregations

Various metrics provided in standard reports are available as aggregations. The following are
available:

Term Description

avg average of all samples

max maximum of all samples

min minimum of all samples

pctile05 5 percent of samples fall below, and 95 percent fall above
pctile90 90 percent of samples fall below, and 10 percent fall above
pctile95 95 percent of samples fall below, and 5 percent fall above
pctile99 99 percent of samples fall below, and 1 percent fall above
sum sum of all samples

countDistinct

Reports that are run with any of the percentile aggregations will run more slowly and use more
memory. This is because data must be retrieved from the raw data table. The retention period for
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raw data determines whether you can retrieve percentile data. To retrieve percentile data over a
long time range, you must set the retention period for the raw data so that it matches the timeframes
over which you want to retrieve the data.

Percentiles can be used in custom reports you create using "Create Custom Reports with Query
Studio” (on page 75).

Baseline Exceptions Generated by the iSPI Performance for
Metrics

NPS stores the records that are marked with baseline exceptions. These records reflect only the
most recent fact record for any affected component, interface, node, or node group. These records
reflect the average baseline exceptions for each of the metrics used by an Extension Pack.

For individual samples, the baseline exception is either represented as 0% or as 100%. The iSPI
Performance uses this table to perform the following tasks:

o Provide an interface to HP Network Node Manager i Software (NNMi). NNMi in turn creates
incidents for each interface marked with a baseline exception.

« Generate ad hoc reports for the interfaces that are currently having baseline exceptions, thus
having any network health or performance problems.

See also "Baseline Exceptions Used by the iSPI Performance for Metrics" (on page 88).

Baseline Exceptions Used by the iSPI Performance for
Metrics
Component Health

Baseline exceptions are enabled for the following metrics in the Component Health Extension
Pack:

¢ Memory Utilization

o Buffer Utilization

o Buffer Miss Rate

o Buffer Failure Rate

o Buffer No Memory Rate
e CPU 1min Utilization

¢ CPU 5sec Utilization

¢ CPU 5min Utilization
Interface Health

Baseline exceptions are enabled for the following metrics in the Interface Health Extension Pack:
o Utilization In

o Utilization Out

o ErrorRateIn

e Error Rate Out
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e Discard Rate In

e Discard Rate Out

Baseline Metrics Glossary

Baseline metrics compute the trends, seasonal patterns, and time range deviations for the iSPI
Performance products. Baseline metrics are the following.

Metric Description

Baseline Average

Average value presenting the normal (expected) range of utilization for
the selected topology filter based on the historical data

Can analyze the following using this metric:

e The actual utilization of the topology filter as compared to the normal
utilization ranges

o Forecast the topology filter utilization for a selected time range.

o ldentify the over-utilized and under-utilized topology filters before
they violate the thresholds.

Baseline Deviation

Deviation of the samples spread over a specific time range.

Represents the extent of the range of values normally seen for the
selected time range in the seasonal cycle, based on historical data.

Can analyze the following using this metric:

o Analyze the utilization pattern for the selected topology filters over a
selected time range.

o Identify the utilization values that are lower or higher than the mean
utilization. This in turn enables you to identify the over-utilized and
under-utilized topology filters.

Baseline Slope

Increase or decrease in the average utilization in one day. Negative
slope indicates a declining trend.

Can analyze the following using this metric:
o Identify any unexpected change in the topology filter utilization.

¢ Avoid resource bottlenecks by identifying gradual increase in
resource utilization.

¢ Identify the point in a selected time range when the resource
utilization was the highest or lowest. This enables you to derive a
pattern in the topology filter utilization.

Upper Normal

Upper limit of the normal range for the sample. The normal range for the
sample may vary for every iSPI Performance product.

NNMi supplies the upper normal value based on values that you enter in
the Threshold Configuration form. You can disable the upper normal
value if you do not require to set the upper threshold for the metric.
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Metric Description

See the HP Network Node Manager i Software Online Help for
Administrators for information about the Threshold Configuration form.

The value is calculated using the following formula:
Upper Normal = Baseline Average + (N1 * Baseline Deviation)

where N1 is the upper sleeve width

Lower Normal Lower limit of the normal range for the sample. The normal range for the
sample can vary for every iSPI Performance product.

NNMi supplies the lower normal value based on values you enter in the
Threshold Configuration form. You can disable the lower normal value if
you do not set the lower threshold for the metric.

See the HP Network Node Manager i Software Online Help for
Administrators for information about the Threshold Configuration form.

The value is calculated using the following formula:
Lower Normal = Baseline Average - (N2 * Baseline Deviation)

where N2 is the lower sleeve width

Days to Threshold Forecast for the topology filter utilization to reach the upper or lower
threshold limit.

Represents the number of days left for the utilization to reach the
threshold value.

NPS calculates this metric based on the following:
o Baseline Slope

e The static upper and lower thresholds defined in NNMi Threshold
Configuration form

Exception Count Total number of sample counts marked for an exception.

NPS raises an exception for the metric if the a certain number of
samples within a sample window are out of normal range.

For example, NPS raises a baseline exception if 7 samples out of a
sample window of 10 samples are beyond the upper normal range. You
must configure NNMi for the upper and lower normal ranges to enable
NPS to raise the exceptions.

If the topology filter utilization is between Upper Normal and Lower
Normal, the exception count is set to 0 (Zero) for the selected sample.

If you disable the upper or lower normal thresholds in NNMi, NPS does
not raise exceptions for the upper and lower normal ranges.

The iSPI Performance products can analyze the following using this
metric:
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Metric Description

o Analyze the performance of the selected topology filter for a specific
time range.
o Identify network performance problem if the exception count is
persistently high for the selected time range.
Baseline Exception Percentage of samples that has the exception flag set.
Rate
Forecast Baseline Average value presenting the normal (expected) range of utilization for
(avg) the selected topology filter based on the forecast data.
o 4 week Can analyze the following using this metric:
o 8week e The forecast utilization of the topology filter as compared to the
. 12 week normal utilization ranges.
o Forecast the topology filter utilization for a selected time range.
o Identify the over-utilized and under-utilized topology filters before
they violate the thresholds.
Forecast Upper Upper limit of the normal range for the forecast data. The normal range
Normal (max) for the data may vary for every iSPI Performance product.
o 4 week
o 8week
o 12week
Forecast Lower Lower limit of the normal range for the forecast data. The normal range
Normal (min) for the data may vary for every iSPI Performance product.
o 4week
o 8week
e 12 week

Custom Dashboards

You can create dashboards based on multiple reportlets from the same or different Extension
Packs.

Say that you needed to monitor the following:

o Hourly utilization of Interface A on Component X

o Average normal CPU utilization for Component X

o Number of days left for memory utilization to reach threshold

You could create a custom dashboard that combines the following reportlets:
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o Interface Health Heat Chart Report for the metric Utilization (avg)
« Component Health Simple Chart Report for the following metrics:
= Primary metric: Memory Utilization - Baseline Average (avg)

= Secondary metric:CPU 5min Utilization - Days to Threshold (min)

Create a Custom Dashboard with the iSPI Performance Bl Server
Portal

To create a custom dashboard:
Task 1: Log in to NPS
Task 2: Copy bookmarks for the reportlets to include in the dashboard
1. Onthe NPS home page, click the Dashboard Reportlets tab.
2. Select an Extension Pack; for example, iSPI Metrics > Interface Health > InterfaceMetrics.
3. Select areportlet; for example, Heat Chart reportlet.
4. Click Show Bookmark.
5. Copy the bookmark and paste it in a text editor.
Repeat these steps for all the reportlets you want included in the dashboard.
Task 3: Create the dashboard using the Bl Portal
1. Onthe NPS home page, click the Bl Server tab.
2. Select Bl Portal.
3. Select alocation for your dashboard; for example, My Folders.
4. Click EdNew Page.
5

. Inthe Specify a name and description-New page wizard form, specify the required information
about the dashboard.
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Hour / Day Filters ES
Topelogy Filters Specify & name and location For this entry, You can also specify & description and screen tip,
BI Sarvar Namne:
Utilization Dashboard - Interface 4 on Component ¥ ]
BI Partal
Public Folders Description: You must specify the following:
My Folders = Dashboard name
Preferences = Dashboard location
) - Change the pre-specified
SQuery Studio (opens in new window) location here if requwred
Screen tip: .
Other fields are optional.
Location:
My Folders -
Select another location. ..
Cancel Mext = Firish
¥
< »
6. Inthe Set columns and layout-New page wizard form, specify:

10.
1.
12.
13.

= Number of columns you require in the dashboard

= Width of the columns. For a multi-column dashboard, the columns must be the same width.
In the Set columns and layout-New page wizard form, click Add.

Select Cognos Utility.

In the Available entries column, select a utility; for example, to display multiple reportlets in the
dashboard, select HTML Viewer.

= Add to move the selected utilities in the Selected entries column.

Click
Click OK.
Click Next.

In the Set page style-New page wizard, specify the title, style, and any instructions you want
the dashboard to display.

Do not select the following:

= Hide title bars

= Hide Edit buttons on the title bar
The Edit button must be on the title bar.
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BI Server 5
BI Portal
Add a title and instruckions which appear above the portlets on the page. You can also set the style of all portlets on the page.
Public Falders
My Folders Title:
Hrefarencas Return to default » | Tahoma v(1z v A I EEE
Query Studio (opens in new window) Dashboard - Utilization of Interface A on Component X
[] Hide title on the page
Instructions:
Returnto default » | Tahoma vfi1v A B 1 1 EEEE
[7] Hide instructions on the page
Portlet Style
[ Hide borders
LI Fide thle bars | Awnid selecting any of these
Dashboard Repartlets (] Hide Edit bttons on the titlebar | options.
Cross Launching
v
¢ 3 Cancel < Back hext > Finish

14. Click Next.
15. Inthe Select an action-New page wizard form, select the required options and click Finish.
The new dashboard opens in Edit mode.
Task 4: Edit the dashboard to display the selected reportlets
1. Select any of the following tools:
= [E'Editin the title bar
= E'Editin the Actions column

2. Specify the content for the dashboard using the reportlet bookmark. For example, if you
selected HTML Viewer to view the dashboard reportlets, copy the bookmark you saved in the
text editor and paste it in the HTML content field.

3. Specify the height for the panel where Cognos displays the reportlet.
4. Click OK.

Troubleshooting

See the following topics for specific information:

o "Problem: Reports take too long to display" (on page 101)

o "Problem: You must log in again when navigating from NNMi to an iSP| Performance product
report” (on page 102)

o "Problem: NNMi Console Action menu has no link to the Reporting—Report menu" (on page 103)
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o "Error: NNMi is not polling one or more objects for perfformance data" (on page 103)

o "Problem: Leaving a report open requires re-login" (on page 103)

o "Problem: Leaving the browser open for a while prevents re-login" (on page 104)

o "Problem: Exception counts are missing from reports" (on page 104)

o "Problem: NPS stops functioning and does not show any reports" (on page 104)

o "Problem: Report shows gaps in displayed data" (on page 105)

o "Problem: Need more information about polling" (on page 105)

o "Problem: Need more information about creating new node groups" (on page 106)

Errors and Warnings Glossary

You can open a reference list of commands by going to the command index.

A B c D

E

F General

Message

Type

Cause/Suggested Actions

Exit Code {EXIT_CODE}

Attempting to extend allocated space for WARN | The database requires additional

DBSPACE {DB_SPACE} using dbsize.ovpl disk space. The ETL process
will allocate more.

Attempting to restart HP Bl Server processes WARN | The Bl server process stopped
while ETL was running. ETL will
attempt to restart the process.

Attempting to restart HP DB Server WARN | The database server process
stopped while ETL was running.
ETL will attempt to restart the
process.

Automatic NNM HA add-on configuration failed: ERROR | High availability configuration

failed.

failed.

Bl Processes not running WARN | The Bl server process stopped
while ETL was running.
Bl Processes still not running...restart attempt ERROR | The Bl server process stopped

while ETL was running. ETL has
attempted to restart the process
but failed to do so, and ETL
cannot continue. Try starting the
Bl server process manually
using startBl.ovpl.
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Message

Cause/Suggested Actions

{OVDIR}/misc/nnm/ha/nnmhaclusterinfo.ovpl -
config NNM -get NNM_INTERFACE

Cannot extract remote nnm hostname from value ERROR | On adedicated server

of PRSPI_NNMDIR ({PRSPI_NNMDIR}) installation, the configuration
entry for the NNMi shared
directory should contain the
name of the NNMi server.
Failure to determine this
hostname affects application
failover configurations.

Cannot find the OV Install Dir <{DIR}>. ERROR | %nnminstalldir¥% does not exist.
Check the NNMi installation.

Cannot find the nnm.ports.properties file to ERROR | If the jobs port cannot be

establish port for jboss http server. determined, the iSPI cannot be
enabled. Check NNMi
installation.

Check NNM HA environment, and then run ERROR | Enabling the iSPI inan HA

nnmenableperfspi.ovpl. environment must be done ina
specific order. See the HA-
specific topic in the NNMi
Deployment Guide for more
information.

Check your environment for NNM environment ERROR | Some or all required NNMi

variables and run nnmenableperfspi.ovpl. variables cannot be determined.
Check NNMi installation.

Command Failed: {PERL} getNNMActiveScript: ERROR | An application failover specific

{CHILD_ERROR} script failed. Check your
application failover environment.

Command Failed: {UNZIP} {ZIPFILE}: {CHILD_ ERROR | An error occurred unzipping the

ERROR} identified file. The CHILD_
ERROR might give more
information (corrupt zip file,
permissions issue, etc.).

Command: ERROR | A high availability specific script

{OVDIR}/misc/nnm/ha/nnmhaclusterinfo.ovpl - failed. Check your high

config NNM -get HA_PERFSPI_ADAPTER_DIR availability environment.

Command: ERROR | A high availability specific script

failed. Check your high
availability environment.
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Contents

Message Type Cause/Suggested Actions

Command: ERROR | A high availability specific script

{OVDIR}/misc/nnm/ha/nnmhaconfigure.ovpl NNM failed. Check your high

-addon PerfSPIHA availability environment.

Configuration file contains errors. ERROR | The iSPI configuration file
contains errors. Check the
associated error messages for
specifics.

Configuration: Unable to access directory ERROR | The shared directory for metrics

{PRSPI_METRICS} is inaccessible. Check that NFS
or Samba is operating properly.

Configuration: Unable to access directory ERROR | The main shared directory is

{PRSPI_NNMDIR} inaccessible. Check that NFS or
Samba is operating properly.

Configuration: Unable to access directory ERROR | The shared directory for

{PRSPI_TOPODUMP} topology information is
inaccessible. Check that NFS or
Samba is operating properly.

Configuration: Directory {PRSPI_METRICS} must | ERROR | The shared directory for metrics

have write access is not writeable. Check your
NFS or Samba configuration and
file permissions.

Configuration: Directory {PRSPI_TOPODUMP} ERROR | The shared directory for

must have write access. topology information is not
writeable. Check your NFS or
Samba configuration and file
permissions.

Configuration: java not found in 'java_dir' ({java_ ERROR | The HP Javainstallation

dir}) appears to be corrupted.

Configuration: perl not found in 'perl_dir' ({perl_dir}) | ERROR | The HP Perl installation appears
to be corrupted.

Configuration: {NAME} not defined. ERROR | A required configuration
parameter is not defined.

Configuration: {NAME} value must be a valid path. | ERROR | A required configuration

Invalid value: {VALUE} parameter must be a valid path
and it is not.

Configuration: {NAME} value must be numeric. ERROR | A required configuration

parameter must be numeric and
it is not.
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Message

DB Processes still not running...restart attempt
failed.

Type

ERROR

Cause/Suggested Actions

The database server process
stopped while ETL was running.
ETL attempted to restart the
process but failed to do so. ETL
cannot continue. Try starting the
database server process
manually using startDB.ovpl

DBSPACE {DBSPACE}, FILE {FILE}: Cannot
extend because there is no reserve space left.

WARN

The database needs to be
extended but cannot because
there is no disk space available.
You should free existing disk
space or add new disks before
your database runs out of space.

DBSPACE {DBSPACE}, FILE {FILE}: Cannot
extend {PATH} because there is insufficient disk
space left on the file system.

WARN

The database needs to be
extended but cannot because
there is no disk space available.
You should free existing disk
space or add new disks before
your database runs out of space.

Database Processes not running!

WARN

The database server stopped
while ETL was running.

Dropping connection_id {CONNECTION_ID}

WARN

The specified connection is
being dropped. This is normally
a transparent operation for report
users.

not running. Restarting

Error - Unable to remove the nnm actions foriSPI | WARN [ Check that NNM is running. You

for Performance can also remove actions from
the NNMi console.

Error running dbisql: {DB_ERROR} ({SQL}) WARN | The described SQL error
occurred. Check for other
messages associated with this
one.

Expected PRSPI_NNMDIR of form WARN | On a dedicated server install,

/net/hostname/var... or //hostname/PerfSpi the NNM directory path should
be one of the forms shown.

Extension Pack {(EXTENSION_PACK}: process WARN | An ETL process had to be

restarted.

Page 98 of 230

HP Network Node Manager iSPI Performance for Metrics Software (9.20)



Online Help
Contents

Message Cause/Suggested Actions

Failed archiving logfile PerfSPI_Diagnostic_ WARN [ The log archive process failed.
Metrics.log

Failed archiving logfile prspi.log WARN | The log archive process failed.
Failed building Extension Pack for new or updated | ERROR [ This should not be encountered
NNM metadata: {METADATA} by customers.

Failed chdirto {DIR}: {OS_ERROR} ERROR | Failed changing directory to the

specified directory. The OS error
might give more information
(directory does not exist,
permissions, etc.).

Failed command:copy({FILE_LIST}):{OS_ WARN | Failed copying the specified
ERROR} files. The OS error might give
more information (directory does
not exist, permissions, etc.).

Failed command:copy({FILE_LIST}):{OS_ ERROR | Failed copying the specified
ERROR} files. The OS error might give
more information (directory does
not exist, permissions, etc.).
The program immediately exits.

Failed command:fork():{OS_ERROR]} ERROR | Failed forking (creating a new
process). The OS error might
give more information (lack of
system resource, etc.). The
program immediately exits.

Failed command:mkpath({PATH_LIST}):{OS _ ERROR | Failed creating the specified
ERROR} directories. The OS error might
give more information (directory
does not exist, permissions,
etc.). The program immediately

exits.
Failed command:mkpath({PATH_LIST}):{OS__ WARN | Failed creating the specified
ERROR} directories. The OS error might

give more information (directory
does not exist, permissions,
etc.).
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Message Type Cause/Suggested Actions
Failed command:move({FILE_LIST}):{OS _ ERROR | Failed moving the specified
ERROR} files. The OS error might give
more information (directory does
not exist, permissions, etc.).
The program immediately exits.
Failed command:move({FILE_LIST}):{OS_ WARN | Failed moving the specified
ERROR} files. The OS error might give
more information (directory does
not exist, permissions, etc.).
Failed command:open({HANDLE},{ARGS}):{OS_ | ERROR | Failed opening the specified file.
ERROR} The arguments and OS error
might give more information
(directory does not exist,
permissions, etc.). The program
immediately exits.
Failed ERROR | Failed opening the specified file.
command:open({HANDLE},{FLAG},{ARGS}):{OS_ The arguments and OS error
ERROR} might give more information
(directory does not exist,
permissions, etc.). The program
immediately exits.
Failed command:opendir(DIR,{DIR Configuration: | WARN [ Failed opening the specified
{NAME} not defined.NAME}):{OS_ERROR} directory. The OS error might
give more information (directory
does not exist, permissions,
etc.).
Failed command:system({COMMAND}:{CHILD_ | WARN | Failed running the specified
ERRORY}) system command. The OS error
might give more information
(lack of system resources etc.).
Failed command:system({COMMAND]}):{CHILD_ | ERROR | Failed running the specified
ERROR} system command. The OS error
might give more information
(lack of system resources etc.).
The program immediately exits.
Failed command:unlink({FILE_LIST}):{OS_ ERROR | Failed removing the specified
ERROR} files. The OS error might give
more information (directory does
not exist, permissions, etc.).
The program immediately exits.
Failed command:unlink({FILE_LIST}):{OS _ WARN | Failed removing the specified

files. The OS error might give
more information (directory does

Page 100 of 230

HP Network Node Manager iSPI Performance for Metrics Software (9.20)




Online Help
Contents

Message Type

Cause/Suggested Actions

not exist, permissions, etc.).

Failed copying {SRC} to {DEST}: {OS_ERROR} | ERROR

Failed copying file from
specified source to destination.
The OS error might give more
information (directory does not
exist, permissions, etc.).

Failed creating {FILE}: {OS_ERRORY} ERROR

/N <Package name> WARN

General Warnings

Failed creating the specified file.
The OS error might give more
information (directory does not
exist, permissions, etc.).

This warning can appear for any
one of the following reasons:

e Thereis nodatainthe
topology tables for the
displayed package.

e The topology filters chosen
will result in empty reports.

e The topology filters chosen
are not appropriate for the
selected package and will be
dropped.

/% The system is currently running with WARN
demonstration data!

The system is currently running
with demonstration data.

Problem: Reports take too long to display
The problem could be due to one of the following.
« Did NNMi experience a recent topology reset?

Check the current NNMi topology:

a. Loginto NNMi console using your username and password.

b. Click Topology Map.

c. Click Network Overview. This view is updated frequently when the topology goes through a

change.

« Were one or more interface groups recently added to performance monitoring?

Check the interface groups:

a. Logintothe NNMi console using your username and password.

b. Click Inventory.
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c. Click Interface Groups.

The Interface Group-Interface Groups form displays the interface groups available in the
network.

o Are large numbers of users logged in to the system?

Enable more parallel Bl Server processes. Follow the recommendations in the Bl Server tuning
guides.

o Are the hardware resources over-utilized?

Check if NNMi generated any resource-related incidents:

a. Logintothe NNMi console using your username and password.

b. Click Incident Management.

c. Click Open Key Incidents to check for any resource-related incidents.

Check hardware statistics, especially aggregate CPU usage.

Verify that disk speed is adequate. For large networks, a RAID5 8-spindle is recommended.
General Resolution Tips

o Create areport view with the required prompts and schedule this report view to run on a regular
basis. View the scheduled output, or bookmark a URL to view the scheduled output. For more
information on scheduling reports, see Schedule Delivery of Reports.

o Filters can improve report performance. A report on a specific node group is generally faster than
a report on All Nodes/Interfaces. The same logic applies to the time dimension. For more
information on report filters, see the following topics:

n Set Topology Filters

= Change Time Controls

« Run the same report again. Data caching, which took place the first time you ran the report, will
decrease the run time the next time you run the same report.

Problem: You must log in again when navigating from NNMi to an
iSPI Performance product report

This can occur if you launch the NNM console using the IP address of the NNMi system and not
NNM's fully-qualified domain name (FQDN). Always use the FQDN of the NNMi system to login to
the NNMi console.

Whenever you navigate from NNMi to a report, account information is passed between your NNM
login session and NPS using cookies in your browser. A function known as Single Sign-On (SSO)
makes it possible for you to move from NNM to a report without having to log in a second time.

For SSO to operate, the following conditions must be met:
¢ The NNMi system and the NPS system must each be configured with an FQDN.

¢ You must use the FQDN in your browser (not "localhost" or the machine name minus the
domain) when you launch the NNMi console.

An FQDN has the following format:

http://fully_qualified_domain_name:port/nnm
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If NNMi and NPS are installed on the same machine, the SSO function will operate if you use either
of the following:

¢ NNM's FQDN
o NNM's IP address

NPS is responsible for configuring the use of NNMi's IP address. This takes place automatically
when NPS is installed.

Problem: NNMi Console Action menu has no link to the Reporting—
Report menu

If you do not completely (and successfully) run the enablement script, the NNMi console does not
display the Reporting-Report menu item in the Action menu.

See the instructions in the Installation Guide for running the enablement script
(nnmenableperfspi.ovpl)onthe NNMi management server.

Error: NNMi is not polling one or more objects for performance data
The problem could be due to either of the following.
« Is NNMi polling the specified devices for performance data?
a. Navigate to the Monitoring Configuration form in NNMi and check the polling attributes.
b. Examine the polling attributes for the device and any group the device belongs to.
« Can NNMi synchronize topology information with NPS?

NNMi and NPS share topology information. Most of the time, this information is fully
synchronized. However, certain conditions will cause the iSPI Performance's view of the
network topology to vary slightly from NNMi's view. A lack of topology synchronization can
occur under the following conditions:

= NNMiis running discovery.
= NNMirediscovers an existing network.
= NNMiis adding or removing nodes, interfaces, or groups from polling policies.
Should any of these occur, you will see:
= An error indicating that NNMi is not polling targeted objects for performance data
= "Unmanaged" next to nodes and interfaces in the Path Health report
Problem: Leaving a report open requires re-login

NPS requires you to re-login to view a report under the following conditions:

o You are trying to access NPS without being authenticated by NNMi.

o You pointed your browser at NPS without first logging in to NNMi.

e Your browser session has expired.

You can resolve this by loggin in again to return to NPS.
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Problem: Leaving the browser open for a while prevents re-login

The inactivity timeout setting for NPS is 1 hour. If your browser is inactive for 1 hour, your session
expires. You must log in again. The login window requires the administrator username and
password.

1. Close the timeout login window.
2. Logintothe NNMi console using the standard URL:
http://fully-qualified-hostname:port;/nnm
3. Navigate to the iSPI Performance report you were using.
Problem: Exception counts are missing from reports
Did you define thresholds in NNMi?
Reports will not track exception counts unless high and low thresholds are set in NNMi.
If reports are not showing exception counts, the NNMi administrator did not set thresholds.
Setting up thresholds in NNMi requires administrator privileges. To locate applicable help topics:
1. Launch the NNMi console.
2. Click Help > Help for Administrators.
3. Select Configure Threshold Monitoring for Nodes

Immediately after thresholds are set, exceptions will begin registering in reports.

Problem: NPS stops functioning and does not show any reports
Did you change the address or hostname of NPS?

If, after installing NPS, you modify the IP address, hostname, or MAC address, you cannot restart
NPS. As aresult, you cannot view any reports.

To change the IP address, hostname, or MAC address of the NPS server:

1. Onthe NPS server, run the following command:
Windows:
$NPSInstallDir%\NNMPerformanceSPI\bin\stopAll.ovpl
Linux:
/opt/OV/NNMPerformanceSPI/bin/stopALL.ovpl

2. Open the Bl Server configuration GUI with the following command:
Windows:
gNPSInstallDir3\NNMPerformanceSPI\bin\runBIConfigGUI.ovpl
Linux:
/opt/OV/NNMPerformanceSPI/bin/runBIConfigGUI.ovpl

3. Click File > Export As.
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4. Specify alocation and file name in the dialog box and click Save.
The configuration data is saved in XML format.

5. Manually delete the following directories:
Windows:
gNPSInstallDir%\nonOV\cognos\c8\configuration\signkeypair
$§NPSInstallDir@\nonOV\cognos\c8\configuration\encryptkeypair
Linux:
/opt/0OV/nonOV/cognos/c8/configuration/signkeypair
/opt/0OV/nonOV/cognos/c8/configuration/encryptkeypair

6. Copy the XML file saved in step 4 to the following directory:
Windows:
$NPSInstallDir%\nonOV\cognos\c8\configuration
Linux:
/opt/0OV/non0OV/cognos/c8/configuration

You can find detailed information about the commands by going to the command index.

Problem: Report shows gaps in displayed data

This can happen when there is a conflict between the polling interval and the display grain selected
for the report.

When you select a finer grain for your report than the polling interval selected in NNMi, the iSPI
Performance displays all the intermediate time entries and the data available for them. If these
intermediate time entries do not contain any data sample, the reports might display missing entries
in tables or gaps in the graphs and charts.

Resolution

Set a greater display grain for the report than the polling interval defined for the device in NNMi. For
example, if the polling interval for the interface is configured as 1 minute, make sure that the display
grain for the reports related to the interface is at least 1 minute.

Problem: Need more information about polling

Performance polling impacts NNMi and your network. If you enable additional performance polling,
NNMi must allocate a portion of its resources to handling the additional polling, and your network
will have to accommodate an increase in SNMP traffic. To ensure that the performance polling does
not cause wasted resources, it is important to limit performance polling to important devices.

You must have NNMi administrator privileges to enable performance polling.
To find additonal information about polling:

1. Launch the NNM console.

2. Click Help > Help for Administrators.

3. Select Monitoring Configuration.
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Problem: Need more information about creating new node groups

Creating a new node group requires setting device-level filters. After you create the new node
group, you could use the group to filter NNMi views. You could also add the node group as a filter to
the iSPI element selection tree.

Creating node groups and using the filter options are NNMi administrator tasks.

To find more information:

1.
2.
3.

Launch the NNMi console.
Click Help > Help for Administrators.

Select Monitoring.

Problem: Content store can hang during upgrade when the
database is in use for scheduled jobs or reports

If the content store database is in use for writing by schedules or jobs, the export can fail.

The solution is to go to the Bl Server portal prior to upgrade and disable the schedules and stop
some of the services the dispatcher runs.

Follow these steps:

1.

® N o 0o > w0 N

Log in to the Bl Portal and launch Bl Administration.

Open the Status tab.

Click Schedules in the list on the left.

Click the check box at the top of the list.

Click the Disable icon in the top right.

Select the Configuration tab.

Select Dispatchers and Services from the list on the left.

Click the dispatcher in the displayed list. You will see alist of services. Be aware that, by
default, there is more than one page to this list.

Click More for each of the following services, and then immediately click Stop.
= BatchReportService
= JobService

= ReportService

About ATM Reports

ATM reports show performance data for the ATM PVC Health data collected by NNMi. Graphs and
charts on these reports help you identify the following:

« Volume of data passed through the selected ATM virtual circuits

e Average, minimum, and maximum utilization of the selected ATM virtual circuits
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o Number of discarded AAL5 CPCS PDUs in the selected ATM virtual circuits

o Number of AAL5 CPCS PDUs marked for discard for the selected ATM virtual circuits

Use these reports to determine the status of the ATM PVC Health virtual circuits on your network.
Opening Reports from NNMi

From the NNMi Console, you have the following options:

o Move from NNMi to the iSPI and launch reports from the Report tab in the navigation panel.

o Launch a pre-filtered report directly from NNMi if you are interested in a particular node group,
node, interface, or virtual circuit. Otherwise, open a workspace view from NNM, move to the
iSPI, and begin your investigation from the NPS home page.

To move from NNM to the iSPI:

a. Logintothe NNMiconsole.

b. Select aworkspace.

c. Open a view of nodes, interfaces, orincidents.

d. Select Actions > HP NNM iSPI Performance > Reporting - Report Menu
ATM Calendar Report

The Calendar report uses a traditional, calendar-style layout to show hourly statistics for two
metrics in a single, extended graph spanning over multiple days.

Features and Defaults

The report defaults to:

o ATM PVC Name = All

o Dates/Times = Last 31 days

o Metric(s) Shown on Y1 Axis (Primary Metric) = Volume Bytes (sum)

o Metric(s) Shown on Y2 Axis (Secondary Metric) = CIR Utilization (avg)

The default view shows data for the current month. Depending on how long the iISPI has been
collecting data from NNMi, you may have the option of looking at data for the previous 70 days if
you use the option Until Now.

If you set the Time Range to less than 24 hours, the following message appears:

This report is not designed to operate with a time range of less than
24 hours. Please modify your time selections.

How to Use this Report

Use this report to:

e Observe gradual trends over time
o Observe isolated spikes

o Verify that an abnormal condition has returned to normal

Make comparisons
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This report reveals:
o Day of week patterns
o Hour of day patterns

For example, if utilization is spiking on Tuesdays, or if response time issues are occurring daily at
11:00 a.m., the report highlights these events.

ATM Chart Detail Report

The Chart Detail report enables you to perform a trend analysis for network health and performance
based on historical virtual circuit health data.

The report displays a comparative analysis of the selected metrics for each time unit.

For example, to compare how the volume of AAL5 CPCS PDUs received and sent was affected by
variance in the AAL5 CPCS PDU discards per millisecond for the past one week, you could
generate the Weekly ATM PVC Health report for the selected node group.

You can also select two or more nodes, node groups, virtual circuits, or interface types to generate
this report.

The report enables you to:

o Analyze the trend of network health and performance for multiple nodes, node groups, virtual
circuits, or virtual circuit groups based on one unit of time. Each unit of time is called as a
Display Grain. Each Display Grain is measured as follows:
= 5 minutes for Hourly report

= 1 hour for daily report

= One day for weekly report

= One day for monthly report
o Identify the virtual circuit that is causing ups and downs in network health and performance.
o Detect any persistent problem in virtual circuit health and performance.

o Compare the network health and performance of more than two nodes, node groups, virtual
circuits, or virtual circuit groups based on historical virtual circuit health data.

The following filters are available in the Time Controls pane:
o Start Date/Time

o Time Range

o Display Grain

o Hour of day

o Day of Week

Features and Defaults

The graph on this report tracks up to six metrics per axis over the selected time period. The default
metrics are the following:
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e ATMPVC Name = All

o Metric(s) Shown on Y1 Axis = Volume Bytes (sum)

o Metric(s) Shown on Y2 Axis = CIR Utilization (avg)

The Chart Detail report displays the selected metrics using two Y axes.

o TheleftY axis (also known as the Y1 axis) displays the performance of the main metric based
on the one you want to generate the report with.

o Theright Y axis (also known as the Y2 axis) displays the performance of the metric that should
overlay the main (primary) metric.

To add another metric, click Options and the ﬁAdd New Grouping button.

To remove a metric you already added, click Options and the xRemove Grouping button.

The Chart Detail report enables you to view the data in the tabular format as well. To view the table,
click Options, and select Table. The table appears instead of the chart. To view both the chart and
the table, click Options, and select Chart and Table.

ATM Heat Chart Report

Th Heat Chart report tracks the hourly performance of a single metric. The default metric is Volume
- Bytes (sum). The default time period is the last 31 days. Performance is color-coded, making it
easy to see whether performance has been satisfactory or unsatisfactory.

Features and Defaults

The legend at the top of the report maps a range of normalized performance values to a particular
color.

Beneath the legend, a table represents the normalized values of a performance metric (rows of the
table represent hours of the day; columns of the table represent days).

Each cell inside the table is color-coded and indicates a specific value of the metric. You can also
hover the mouse over the cell to see the absolute metric value of each hour.

The default topology filters for the report are as follows:

e ATMPVC Name = All

e Time Period = Last 31 days

o Hourof Day = All

o Day of Week = All

o Metric = Volume - Bytes (sum)

Time range options are any period that is not less than 24 hours.
How to Use this Report

Use the Heat Chart report to identify gradual shifts from one range of performance to another range,
to spot an isolated instance of poor performance that affected the results for past 24 hours, to spot
day-of-week patterns, and to verify that an abnormal condition returned to normal after a problem
was corrected.
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ATM Managed Inventory Report

The Managed Inventory report enables you to view the number of instances of each topology
attribute seen in the collected data within the selected time range. For example, if the report is run
for "Last 1 Hour," you would see the number of unique values for each attribute seen in the data
collected over the last hour. This report can be useful for checking the number of nodes polled over
any given time range.

You can use the available attributes to filter the data and create a report that represents only the
elements you are interested in. The report presents the list of attributes in the form of a table. The
Count column of the table indicates the number of entries for each attribute. For example, count 5
for the topology item Node Location means that all nodes on your network can be grouped based on
five different locations that host the nodes.

You can use the following topology attributes with the virtual circuit Health reports:
¢ Qualified ATM PVC Name
e ATMPVC Name

e ATMPVCID

¢ Qualified Interface Name
¢ Interface Name

¢ Interface Alias

o Interface Physical Address
¢ Interface Annotation

¢ ATMPVC UUID

¢ Node Name

¢ Node Contact

¢ Node Location

¢ Node Family

¢ Node Vendor

e NodelD

e Node UUID

¢ Node Annotation

¢ Interface ODBID

o Node ODBID

e Tenant Name

e Tenant UUID

o SecGroup Name

e SecGroup UUID)
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The Managed Inventory report can take significant time to build if you select a time range greater
than 24 hours.

ATM Most Changed Report

The Most Changed report compares components for two different (consecutive) time periods and
ranks them according to the amount of change. The sort order is most-changed to least-changed.

Features and Defaults

This report contains one table, which provides data for one metric only.

The table columns are:

o Grouping by levels: one to five columns, each displaying a level

o Performance for the previous time period

o Performance for the current time period

o Growth, expressed as a percentage increase

e Change

The default filters for the Most Changed report are:

o Grouping by Elements = Qualified ATM PVC Name

o Start Date/Time = depends on default Time Range and data available in database
o Hourof Day (HOD) = All

o Day of Week (DOW) = All

o Ranking Metric = Volume - Bytes (sum)

e Top N Option=Top 10

You can select multiple grouping attributes with the '{EIAdd New Grouping button. Use the P
Remove Grouping button to remove a grouping attribute.

How to Use this Report

You can use this report to spot objects at a grouping level that experienced significant growth from
the previously selected time period to the currently selected time period. Significant growth could
point to a developing problem. You can change the ranking metric and the number of elements
listed.

ATM Overview Report

The Overview report displays the utilization and performance of the most commonly monitored
metrics in the ATM PVC Health extension pack.

Using this report, you can:
o Monitor the daily utilization and performance of a set of pre-defined metrics.

o Identify the virtual circuits with unusual performance or utilization and drill down to other reports
to analyze the problem.

o Rank the virtual circuits according to their utilization levels.
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« lIdentify the metrics that are close to the threshold. Use the following sections to identify such
virtual circuits:

= 12 Weeks CIR In Utilization Forecasts
= 12 Weeks CIR Out Utilization Forecasts

The default display grain for this report is 1 hour. To select a different time grain or time range, use
the Time Controls tab in the navigation panel.

To change the topology filters, use the Topology Filters tab in the navigation panel.

You cannot select the metrics for this report.

ATM Peak Period Report

The Peak Period report ranks the utilization and performance of an interface during the busiest time
of the selected time range.

This report enables you to:
o Identify the performance and utilization of the selected metrics during the peak period.

« lIdentify the interfaces that have the highest or lowest performances or utilization levels during
the peak period.

o Compare the performance for multiple interfaces during the peak period using this report.
You can use this report to:

o lIdentify a group of virtual circuits that have a common network performance problem.

o Identify the virtual circuit that is suffering from a persistent performance problem.

« Identify the period when the virtual circuit utilization was the highest.

Report Options

e Top/ Bottom N

o Select Metric(s)

e Grouping by Time Period

This report tracks up to six metrics over the selected time period.

To add another metric, click Options and the ¥ IAdd New Grouping button.

To remove a metric you already added, click Options and the XRemove Grouping button.

To select a range of values for the metric, click “{F_hl and .

Type the ranges of metric values the report should consider. Make sure that the ranges are one of
the following:

o Decimal multiplier (1 to specify 100%, 0.5 to specify 50%, etc.)
« Range with the % (Percentage) symbol (100%, 50%, etc.)

For example, to see the top five virtual circuits for node 15.2.103.112 with average utilization
between 10% and 90%, type the following ranges:
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e 0.10r10% as Lowest Value
o 0.90r90% as the Highest Value
By default, the report groups data by Qualified ATM PVC Name. You can select multiple grouping

attributes using *1. Use Pt to remove a grouping attribute.
Tips:
¢ Check this report once a day to see which virtual circuit might need special attention.

o Check this report periodically throughout the day to see which virtual circuit is performing at the
extremes and might, therefore, need special attention.

ATM Top N Report

The Top N report ranks network elements by the metric selected. Use this report to spot the
element that performed at the extremes and to analyze the historical data for elements that are
exhibiting unusual utilization levels.

This report enables you to:
o Detect the ATM virtual circuits that have a health or performance problem.

¢ Analyze the utilization of the NNMi managed ATM virtual circuits based on a specific time
range.

e Detect the over-utilized and under-utilized ATM virtual circuits in the network.

o Compare the performance of multiple ATM virtual circuits for a single node or multiple nodes
using this report.

Example

One of the routers in your network is performing poorly. Using this report, you can group the ATM
virtual circuit for the router reporting the highest average error rate. That virtual circuit is ranked first.

Interface Health Top N Reports Options
The report displays the following options:
e Top/BottomN

o Select Metric(s): The report ranks the selected virtual circuits according to the value of the first
metric listed in the Select Metric(s) field.

¢ Display Time Series Chart
o Grouping By

This report tracks up to six metrics for each metric type over the selected time period.

To add another metric, click Options and the ﬁAdd New Grouping button.

To remove a metric you already added, click Options and the XRemove Grouping button.

To select a range of values for the metric, click ‘{F_hl and .
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Select a range of metric values the report should consider. Make sure the range is one of the
following formats:

o Decimal multiplier (1 to specify 100%, 0.5 to specify 50%, etc.)
¢ Range with the % (Percentage) symbol (100%, 50%, etc.)

For example, to see the top five interfaces for the node 15.2.103.112, where average utilization is
between 10% and 90%, enter the following ranges:

¢ 0.10r10% as Lowest Value

e 0.90r90% as the Highest Value

By default, the report groups data by Qualified ATM PVC Name. You can select multiple grouping
attributes with the 1 button. Use the X button to remove a grouping attribute.

The Time Series Chart report displays the selected metrics using two Y axes.

o TheleftY axis (the Y1 axis) displays the performance of the main metric on which you want to
generate the report.

e Theright Y axis (the Y2 axis) displays the performance of the metric that should overlay the
main (primary) metric.

By default, the Top N Report does not display the Time Series Chart. To view the chart with the
detail table:

o Select Options > Display Time Series Chart > Confirm Selection.

¢ Click Show Chart link below the detail table.

Tips:

Check this report once a day to see which network interface might need special attention.

Check this report periodically throughout the day to see which network interfaces are performing at
the extremes and might need special attention.

ATM Top N Chart Report
The Top N Chart report ranks the ATM virtual circuits by the metric you select.
This report enables you to:
e Spot the virtual circuits that perform at the extremes.
o Analyze historical data for virtual circuits that exhibite unusual utilization levels.
o Detect virtual circuits that have a health or performance problem.

o Analyze the utilization of the NNMi managed ATM virtual circuits based on a specific time
range.

o Detect the over-utilized and under-utilized ATM virtual circuits in the network.

o Detect the underlying reason of a persistent problem with a virtual circuit. You can compare the
performance for multiple virtual circuits using this report.

Chart Options

The Top N Chart displays the following options:
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e Top/ Bottom N
o Select Metric(s)
e Grouping By

This report tracks up to six metrics over the selected time period.

To add another metric, click Options and the #Add New Grouping button.

To remove a metric you added previously, click Options and the xRemove Grouping button.

To select a range of value for the metric, click '{F_hl and .

Select a range of metric values the report should consider. Make sure the ranges are one of the
following:

o Decimal multiplier (1 to specify 100%, 0.5 to specify 50%, etc.)
¢ Range with the % (Percentage) symbol (100%, 50%, etc.)

For example, to see the top five ATM virtual circuits for node 15.2.103.112 with average utilization
between 10% and 90%, type the following ranges:

e 0.10r10% as Lowest Value
e 0.90r90% as the Highest Value
By default, the report groups data by Qualified ATM PVC Name. You can select multiple grouping

attributes using ﬁ Use X to remove a grouping attribute.
The Top N Chart report displays the selected metrics using two Y axes.

e TheleftY axis (the Y1 axis) displays the performance of the main metric based on which you
want to generate the report.

o Theright Y axis (the Y2 axis) displays the performance of the metric that should overlay the
main (primary) metric.

Tips:
o Check this report once a day to see which interface may need special attention.

o Check this report periodically throughout the day to see which interfaces are performing at the
extremes and may need special attention.

ATM Top N CSV Report

The Top N CSV report can have performance problems when it retrieves a huge amount of data
from the NPS database for the selected time range. You can, however, schedule the following
reports in CSV format:

e Top N CSV report: Ranks the selected topology element according to the utilization level of the
selected metric in the descending order.

o Top N Detail CSV report: Lists metric utilization for the selected topology element according to
the selected time grain.
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This report displays the ranks of the elements based on total metric utilization for the selected
time range and breaks up the metric utilization value for each time grain. For example, you could
select the following options:

= Time Range: Last 24 Hours. The default Display Grain is 1 hour.
= Topology Element: Qualified ATM Pvc Name
= Metric: Volume — Bytes (sum) and Utilization (avg)

The displayed report ranks the Qualified ATM Pvc Names based on the metric Volume—Bytes
(sum). The Qualified ATM Pvc Name with the highest volume of data passing through it receives
the highest rank. The Top N Detail CSV report then calculates and lists the volume of data
passed through this element every hour in past 24 hours.

Glossary of ATM Metrics

Available only on ATM interfaces

Metric Name Description

AAL5VCC Total number of 32-bit and 64-bit AAL5 CPCS (Common Part Convergence
PDUs In Sublayer) PDUs received on the selected AAL5 VCC (virtual circuit) at the
selected AALS interface

AAL5VCC Total number of 32-bit and 64-bit AAL5 CPCS PDUs transmitted on the selected
PDUs Out AALS5 virtual circuit at the selected AAL5 interface

Discarded Total number of AAL5 CPCS PDUs dropped at the receive side and transmit
AAL5VCC side of the selected AAL5 VCC at the selected AALS5 interface

PDUs . .
Calculated using the following formula:

([VCC Discarded AALS5 PDUs In] + [VCC Discarded AAL5 PDUs
outl])

Discarded Percentage of AAL5 CPCS PDUs dropped from the total number of AAL5 CPCS
AAL5VCC PDUs received and transmitted on the selected AAL5 VCC
PDUs

Percentage Calculated using the following formula:

([VCC Discarded AALS5 PDUs In]+ [VCC Discarded AALS5 PDUs
Out])/ (([VCC AAL5 PDUs Out + VCC Discarded AAL5 PDUs
Out])+([VCC AALS5 PDUs Out + VCC Discarded AALS5 PDUs
Out])) /100

Discarded Total number of AAL5 CPCS PDUs dropped at the receive side of the selected
AAL5VCC AAL5 VCC at the selected AALS interface
PDUs In
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Discarded Percentage of AAL5 CPCS PDUs dropped from the total number of AAL5 CPCS
AAL5VCC PDUs received
PDUs In Calculated using the following formula:
Percentage alculated using the following formula:
[VCC Discarded AAL5 PDUs In]/ ([VCC AAL5 PDUs In + VCC
Discarded AAL5 PDUs In])
Discarded Total number of AAL5 CPCS PDUs dropped at the transmit side of the selected
AAL5VCC AAL5 VCC at the selected AALS interface
PDUs Out
Discarded Percentage of AAL5 CPCS PDUs dropped from the total number of AAL5 CPCS
AAL5VCC PDUs transmitted
PDUs Ot 1 . culated using the following formula:
Percentage alculated using the following formula:
[VCC Discarded AAL5 PDUs Out]/([VCC AAL5 PDUs Out + VCC
Discarded AALS5 PDUs Out])
AAL5VCC In | Total number of 32 bit and 64 bit AAL5 CPCS PDU octets received on the
Octets selected AALS virtual circuit at the selected AALS interface
AAL5VCC Total number of 32-bit and 64-bit AAL5 CPCS PDU octets transmitted on the
Out Octets selected AALS virtual circuit at the selected AALS interface
AAL5VCC In | Average utilization for the selected virtual circuit
Utilization . )
Calculated using the following formula:
([Number of octets received by the AALS5 VCC] * 8 *
100) / ([Interface in speed] * Number of seconds the AALS5
interface was available)
AAL5VCC Average utilization for the selected virtual circuit
Out
Utilization Calculated using the following formula:
([Number of octets transmitted by the AAL5 VCC] * 8 *
100) / ([Interface out speed] * Number of seconds the AALS5
interface was available)
Reboot (avg) | Generated if the selected AALS5 interface was restarted during the poll and no

data could be retrieved from the interface

NNMi checks the sysUptime metric to determine whether the interface was
restarted during the last poll.

Unresponsive

Generated when the SNMP agent did not respond when collecting metrics fora

Target (avg) | particular polling policy
Invalid Data | Generated when NNMi successfully polls data from the target, but determines
(avg) that the data is invalid. For example, this metric is calculated when the number

of packets is greater than the number of octets.

Target Error
(avg)

Generated if the selected AAL5 interface returns any of the following SNMP error
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responses:
¢ Authentication error
e Nosuchname

¢ Nosuch object

About Reportlets

In a large enterprise network, the NNM iSPI Performance products (HP NNM iSPI Performance for
Metrics, HP NNM iSPI Performance for Quality Assurance, and HP NNM iSPI Performance for
Traffic) can produce a large amount of data and large cardinality. Enterprise networks often have a
very large number of unique IP addresses, source nodes, destination nodes, virtual circuits,
interfaces, and components that each produce a large amount of data. Generating reports can
therefore be time-consuming.

Reportlets enable you to generate quick impressions of the larger reports using the NNM iSPI
Performance dashboard.

To display the reportlets:
1. Log on to the NPS home page.
2. Onthe left navigation panel, select Dashboard Reportlets.
3. Select an extension pack and a reportlet.

You can also create custom dashboards using the reportlets.

Simple Bar Chart

Compares the performance of two metrics for the selected time range.
Enables you to:
o Compare the performance trends of multiple metrics.

¢ Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports two metrics.

To select a new metric for your reportlet, see Change Reportlet Options in the Using Reports >
Change Default Settings section.

Simple Bar and Line Chart

Displays the performance trend of ATM PVC Health virtual circuits for the past 24 hours using the
following values:

e Primary Metric on the bar chart
e Secondary Metric on the line chart

Enables you to:
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o Compare the performance trends of multiple metrics.

« Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports two metrics.

To generate a reportlet with the metrics of your choice, click E:'Show Toolbar and ifﬂOptions.

Calendar

Displays a comparative study of the selected Primary Metric and Secondary Metric

The default display grain is set to 1 hour. You cannot change the display grain of this reportlet.
Enables you to monitor the following:

o Daily CIR or EIR utilization for the selected ATM PVC Health virtual circuits

« Volume of data passed through the virtual circuit for past 24 hours

o Performance of the virtual circuit for past 24 hours

This reportlet supports two metrics.

To generate a reportlet with the metrics of your choice, click E:'Show Toolbar and WOptions.
Gauge

Evaluates the metric for the selected point of time.

Select only the metrics that display the percentage values.
Enables you to:

o Measure the daily performance of the selected metric.

o Detect any abnormal or unexpected performance level.
This reportlet supports one metric.

When the NPS database has no data, the needle icon on the gauge does not appear.

To generate a reportlet with the metrics of your choice, click E:'Show Toolbar and ﬁﬂOptions.

Heat Chart

Grades the performance of the selected metric for the selected time range.
The metric performance is aggregated according to an hourly display grain.
Enables you to:

o View how the performance of the selected ATM PVC Health virtual circuits is affected by a
varying metric.

o Compare the hourly performance of the selected metric.

o Detect the time range when the performance of the selected ATM PVC Health virtual circuits is
affected adversely because of the fluctuating metric value.

This reportlet supports one metric.
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To generate a reportlet with the metrics of your choice, click E:'Show Toolbar and 'ﬁ’ﬂOptions.
Metric Snapshot

Displays the metric performance for the selected time range.
Enables you to:

o Build a performance history for the selected metric and analyze how the metric performance
changes over time. The history can help you determine the baseline value for the metric.

o Compare the performance of multiple metrics over a specified time range. You can generate a
snapshot report for a single metric, save the snapshot report for various metrics, and compare
the performance of each metric over a time range.

This reportlet supports one metric.

To generate a reportlet with the metrics of your choice, click E:'Show Toolbar and WOptions.

Most Changed

Compares the metric performance between the following:

o Selected time range

o Period preceding the selected time range

Aggregates metric utilization and ranks performance in descending order.
Enables you to:

o Measure performance fluctuations for ATM PVC Health virtual circuits.

o Detect the top N ATM PVC Health virtual circuits that have a common performance or utilization
problem.

You can enhance the reportlet usability using the following features:
e Top/ Bottom N
¢ Grouping By

This reportlet supports one metric.

To generate a reportlet with the metrics of your choice, click E:'Show Toolbar and 'ﬁ’ﬂOptions.

Multimetric Chart

Analyzes the performance trend for the selected metrics for the selected time range.

Enables you to:

o Perform a comparative analysis of the selected metrics for each display grain. The default
display grainis 1 hour.

o Analyze the reason for ups and downs in the performance of the selected ATM PVC Health
virtual circuits.

o Detect any persistent problem in the performance of the ATM PVC Health virtual circuits.

This reportlet supports up to six metrics.
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To generate a reportlet with the metrics of your choice, click E:'Show Toolbar and 'ﬁ’ﬂOptions.
Simple Chart

Analyzes the utilization trend for the selected metrics for the selected time range.

Enables you to:

o Perform comparative analysis of the selected metrics for each display grain. The default display
grainis 1 hour.

¢ Analyze the reason for ups and downs in the performance of the selected ATM PVC Health
virtual circuits.

o Detect any persistent problem in the performance of the selected ATM PVC Health virtual
circuits

This reportlet supports two metrics.

To generate a reportlet with the metrics of your choice, click E:'Show Toolbar and ﬁﬂOptions.
Simple Table

Analyzes the utilization trend for the selected metrics for the selected time range.
The default display grain is 1 hour.

Enables you to:

¢ Analyze the hourly performance of the metrics.

o Detect any abnormal or unexpected performance for the selected ATM PVC Health virtual
circuits.

o Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports up to six metrics.

To generate a reportlet with the metrics of your choice, click E:'Show Toolbar and WOptions.
Sparkline

Evaluates the trend of how the selected metric value has changed for the selected time range.

Enables you to:

¢ Analyze variations in performance for the selected metric.

o Determine whether the expected behavior for the selected metric should be reassessed.

This reportlet supports one metric.

To generate a reportlet with the metrics of your choice, click E:'Show Toolbar and WOptions.

Top N Chart

Ranks the individual contribution of each metric for the performance of the selected ATM PVC
Health virtual circuits for the selected time range.
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Performance of the interface is aggregated on an hourly basis.

Enables you to:

e Spot the virtual circuits for which the performance metrics present extreme values.
o Investigate the aggregated data for the virtual circuits that exhibit unusual utilization levels.

o Select the metric on which to generate the report. The metric you select is used to rank the
virtual circuits.

o Group the report data based on a specific parameter. To add a subgroup, click '{EIAdd Group.

This reportlet supports one metric.

To generate a reportlet with the metrics of your choice, click E:'Show Toolbar and ﬁﬂOptions.

Top N Line Chart

Ranks the utilization trend for the selected metrics for the selected time range.

The performance of the virtual circuits is aggregated on an hourly basis.

Enables you to:

o Spot the virtual circuits for which the performance metrics present extreme values.

o Investigate the aggregated data for the virtual circuits that exhibit unusual utilization levels.

o Select the metric on which to generate the report. The metric you select is used to rank the
virtual circuits.

o Group the report data based on a specific parameter. To add a subgroup, click '{EIAdd Group.

This reportlet supports one metric.

To generate a reportlet with the metrics of your choice, click E:'Show Toolbar and WOptions.

Top N Stacked Chart

Ranks the individual contribution of each virtual circuit based on the selected metrics.

The performance of each interface is aggregated for the default display grain of 1 hour.
Enables you to:

o Spot the virtual circuits for which the performance metrics present extreme values.

« Investigate the aggregated data for virtual circuits that exhibit unusual utilization levels.
o Detect the network paths that have a common network performance problem.

This reportlet supports up to six metrics.

To generate a reportlet with the metrics of your choice, click E:'Show Toolbar and ifﬂOptions.
Top N Table

Ranks the interfaces based on the selected metric.

Enables you to:
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e Spot the virtual circuits for which the performance metrics present extreme values.
« Investigate the aggregated data for virtual circuits that exhibit unusual utilization levels.

o Select the metric on which to generate the report. The metric you select is used to rank the
virtual circuits.

o Group the report data based on a specific parameter. To add a subgroup, click '{EIAdd Group.

This reportlet supports up to six metrics.

To generate a reportlet with the metrics of your choice, click E:'Show Toolbar and ifﬂOptions.
Top N Table with Bars

Ranks the ATM PVC Health virtual circuits based on the selected metric, and displays a horizontal
bar depicting the aggregated metric value.

Enables you to:
e Spot the virtual circuits for which the performance metrics present extreme values.
o Investigate the aggregated data for virtual circuits that exhibit unusual utilization levels.

o Select the metric on which to generate the report. The metric you select is used to rank the
virtual circuits.

o Group the report data based on a specific parameter. To add a subgroup, click '{EIAdd Group.

This reportlet supports up to six metrics.

To generate a reportlet with the metrics of your choice, click E:'Show Toolbar and ﬁﬂOptions.

About Component Health Reports

Component Health reports show performance data for network components in your environment.
Graphs and charts on these reports reflect details for the following device elements:

e CPU

¢ Memory

o Buffer

o SNMP response time

Use Component Health reports to determine if a component is over-utilized or needs an upgrade.

Opening Reports from NNMi

If you are interested in a particular component, you can launch a pre-filtered report from NNMi. Or
you can open a workspace view from NNMi, move to the iSPI, and begin your investigation from
the Report menu.

To move from NNMi to the iSPI:
1. Logintothe NNMi console.

2. Select aworkspace.
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3. Open aview (nodes, interfaces, components, or incidents).

4. Select Actions > HP NNM iSPI Performance > Reporting - Report Menu.

Component Health Baseline Sleeve Report

This report analyzes how close the metric performance value is to the threshold levels. It enables
you to analyze when the metric will reach the threshold. You can:

o Analyze if the component utilization is within the expected (normal) range for the selected time
range.

o Detect if the metric performance is about to cross the high and low thresholds.

For example, if you generate the Baseline Sleeve Chart report for the baseline metric Memory
Utilization, the chart displays the how close the baseline buffer utilization is to the high and low
threshold.

o Save multiple Baseline Sleeve Reports for a specific metric for different time ranges, and
analyze the metric performance trend.

This report supports one metric.

Component Health Calendar Report

This report uses a traditional, calendar-style layout to show hourly statistics for two metrics ina
single extended graph that spans multiple days.

The report default values are the following:

o Nodes/Components = All

o Dates/Times = Last 1 hour

o Metric(s) Shown on Y1 Axis = Memory Utilization (avg)

o Metric(s) Shown on Y2 Axis = CPU 1 min Utilization (avg)

The default view shows data for the current month. Depending on how long the iSPI has been
collecting data from NNMi, you could see data for a longer time period.

If you set the Time Range to less than 24 hours, the following message appears:

This report is not designed to operate with a time range of less than
24 hours. Please modify your time selections.

You can use the following time control parameters:
o Start Date/Time

o Time Range

¢ Auto Refresh

Use this report to:

¢ Observe gradual trends over time

e Spot isolated spikes
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o Verify that an abnormal condition has returned to normal

o Make comparisons

For example, you could compare the data for the past month with data for the preceding month.
The report reveals:

o Day of week patterns

o Hour of day patterns

For example, if utilization spikes on Tuesdays, or response time issues occur each day at 11:00
a.m., the report highlights those events.

Component Health Chart Detail Report

This report enables you to perform a trend analysis for network health and performance based on
historical component health data. It displays a comparative analysis of the selected metrics for
each time unit.

For example, to compare how the average Threshold Exception Rate was affected by variance in
the average SNMP Response Time per millisecond for the past week, you could generate the
Weekly Component Health report for the selected node group.

You can also select two or more component or component groups.
You can:

o Analyze the trend of network health and performance for multiple components or component
groups based on one unit of time. Each unit of time is called a display grain. Each display grain is
measured as follows:

= 5 minutes for Hourly report

= 1 hour for daily report

= One day for weekly report

= One day for monthly report
¢ Analyze the reason for any ups and downs in network health and performance.
o Detect any persistent problem in network health and performance.

o Compare the network health and performance of more than two components or component
groups based on historical component health data.

The default report values are the following:
o Metric(s) Shown on Y1 Axis = Memory Utilization (avg)
o Metric(s)S Shown on Y2 Axis = CPU 1 min Utilization (avg)

Chart or Table: To view the table, click Options and select Table. To view both the chart and the
table, click Options and select Chart and Table.

The report displays the selected metrics using two Y axes.

o TheleftY axis (the Y1 axis) displays the performance of the main metric on which you want to
generate the report.

Page 125 of 230

HP Network Node Manager iSPI Performance for Metrics Software (9.20)



Online Help
Contents

e Theright Y axis (the Y2 axis) displays the performance of the metric that should overlay the
main (primary) metric.

To add another metric, click Options and the ﬁ button.

To remove a metric, click Options and the X button.

Component Health Dashboard Report

The Dashboard report provides an overview of the components available on your network using a
combination of gauges, heat charts, and ordered Top 5 lists. It displays threshold violations for
volume, error, and availability. Threshold violations can point to a network-related problem or
indicate that your thresholds within NNMi need to be changed.

To group the data within the dashboard:
1. Click Options.
2. Inthe Grouping By field, select a topology filter to group the dashboard data.

For example, if you use a grouping option of Node Name, all Availability exceptions that fall
within the time and topology constraints are grouped by Node Name and displayed as a
percentage of the total samples in the left gauge.

Dashboard Sections
Gauge: The gauges provide the following exception count statistics:

o Memory Utilization Exceptions (% samples)

Buffer Utilization Exceptions (% samples)
o Buffer Miss Rate Exceptions (% samples)
o CPU Utilization Exceptions (% samples)

When the NPS database has no data, the needle icons on the gauges on the Dashboard report do
not appear.

Top 5 Lists: These lists display the nodes responsible for the exceptions that show up in the
gauges:

o Top 5 Qualified Component Names by Memory Utilization Exceptions
o Top 5 Qualified Component Names by CPU Utilization Exceptions

Top 5 Qualified Component Names by Buffer Utilization Exceptions and Buffer Utilization Heat
Chart: Enables you to:

¢ Analyze the pattern of buffer utilization exception for the past hour.
o Compare the buffer utilization performance of different components.
o Detect the time range in the past hour when the buffer utilization performance was the lowest.

If the gauges are showing few or no exceptions, none of your nodes, including the nodes in the Top
5 lists, are experiencing problems with memory, buffer, or CPU utilization.

For example, say that your network is divided into groups that represent regions or strategic
locations for your enterprise. With the grouping option set to Node Group name, the report lists each
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of your strategic Node Groups (as defined within NNMi) and provides the current statistics for
exceptions within each group.

If an unexpected change in exception counts is noted, you can click the appropriate gauge needle or
Node Group within the Top 5 lists and launch another report (such as Chart Detail) to investigate
trends or changes within the network as they occur.

The thresholds that create exceptions are set from NNMi, not from the iSPI. To set or modify
thresholds, refer to the online help for NNMi administrators.

Component Health Executive Report

This report provides a broad view of component performance for the selected time range, using the
following graphs:

« Average Memory Utilization and Exception Percentage

o Average Backplane Utilization and Exception Percentage

o Average Buffer Utilization and Exception Percentage

o Maximum Rate of Buffer Miss, Buffer Failure, and No Memory Exceptions
o Average 1 minute CPU Utilization and Exception Percentage

o Average Disk Space Utilization and Exception Percentage

You can:

o View every aspect of performance at once.

o View trends and verify that performance is meeting expectations.

« lIdentify isolated aberration in the graphs and detect any unexpected performance trend.
The report does not provide options to create graphs based on other metrics.
The default display grain is 1 hour.

The report shows data for exceptions only if thresholds for performance metrics are set in NNMi.

Component Health Headline Report

This report provides a broad view of component performance for the selected time range, using the
following graphs:

o Average availability and reachability for the selected node
¢ Maximum, average, and minimum ICMP response time in milliseconds

« Average Memory Utilization and Exception Percentage (displayed as a percentage of the total
samples collected during the selected time range)

¢ Average Backplane Utilizationand Exception Percentage

o Average Buffer Utilization and Exception Percentage (displayed as a percentage of the total
samples collected during the selected time range)

o Maximum Rate of Buffer Miss, Buffer Failure, and No Memory Exceptions

o Average 1 minute CPU Utilization and Exception Percentage (displayed as a percentage of the
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total samples collected during the selected time range)

o Average Disk Space Utilization and Exception Percentage (displayed as a percentage of the

total samples collected during the selected time range)

The default time range for this report is 24 hours.

You can:

o View every aspect of performance at once.

o View trends and verify that performance is meeting expectations.

« lIdentify isolated aberration in the graphs and detect any unexpected performance trend.

The report does not provide options to create graphs based on other metrics.

The report shows data for exceptions only if thresholds for performance metrics are set in NNMi.

Component Health Heat Chart Report

This report tracks the hourly performance of a single metric. The default metric is Memory
Utilization (avg). The default time period is the last 31 days. Performance is color-coded, making it
easy to spot a condition that is gradually worsening and to distinguish satisfactory performance
from unsatisfactory performance.

The legend at the top of the report maps a range of normalized performance values to a particular
color.

Beneath the legend, a table represents the normalized values of a performance metric, with rows
representing hours of the day and columns representing days.

Each cell inside the table is color-coded and indicates a specific value of the metric. You can hover
the mouse pointer on the cell to see the absolute metric value of each hour.

The defaults are:

Nodes/Components = All

Time Period = Last 31 days

Hour of Day = Al

Day of Week = All

Metric = Memory Utilization (avg)

When selecting the time controls parameters, choose from the following values:

A specific day other than Last Day

A specific week this month (or partial week)

A specific week in a previous month (or partial week)
Last 31 days

A previous month

If you set the time range to less than 24 hours, the following message appears:
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This report is not designed to operate with a time range of less than
24 hours. Please modify your time selections.

The report tracks percentages. If you open the Heat Chart from a report that is using a non-
supported metric (for example, Sample Count or Response Time), you will be told to open the report
controls window and select an alternate metric.

You can:

Identify gradual shifts from one range of performance to another range.

Spot an isolated instance of poor performance that affected the results for one day.

Spot day-of-week or hour-of-day patterns.

Verify that an abnormal condition returned to normal after a problem was corrected.

Component Health Managed Inventory Report

This report enables you to view the number of instances of each topology attribute seenin the
collected data within the selected time range. For example, if the report is run for Last 1 Hour, you
will see the number of unique values for each attribute seen in the data collected over the past hour.
This report can be useful, for example, for checking the number of nodes polled over any given time
range.

You can use the available attributes to filter the data of your interest and create a report that
represents only the elements of your interest. The report presents the list of attributes in the form of
a table, with the Count column indicating the number of entries for each attribute. For example,
count 5 for the topology item Node Location means that all nodes on your network can be grouped
based on five different locations that host the nodes.

You can use the following topology attributes with Component Health reports:
¢ Qualified Component Name
e Component Name

e Component Type

e Component ID

e Component UUID

¢ Node Name

+ Node Contact

¢ Node Location

¢ Node Family

¢ Node Vendor

e NodeID

o Node UUID

¢ Node Annotation

¢ Interface Annotation

The report can take significant time to build if you select a time range greater than one day.
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Component Health Most Changed Report

This report compares performance of the components for two different (consecutive) time periods
and ranks components by the amount of change. The sort order is most-changed to least-changed.

The report contains one table with the following columns:

e Component

o Performance for the previous time period

o Performance for the selected time period

o Growth, expressed as a percentage increase

e Change

The report defaults to:

¢ Grouping by Elements = Qualified Component Name

o Start Date/Time = Depends on default Time Range and data available in the database
o Time Range = Last 1 hour

o Hourof Day = All

o Day of Week = All

¢ Rank Metric = Memory Utilization (Avg%)

e Top N Option=Top 10

The report groups data by Qualified Component Name. You can select multiple grouping attributes

using the ﬁ (Add New Grouping) button. To remove a grouping attribute, use the P (Remove
Grouping) button.

Use this report to identify components that experienced significant change from one time period to
the next. Significant change could point to a developing problem. The report shows the rate of
change in the Growth Rate column. You can change the ranking metric and how many elements are
listed.

Component Health Overview Report

The Overview report displays the utilization and performance of the most commonly monitored
metrics in the Component Health extension pack.

You can:
o Monitor the daily utilization and performance of a set of pre-defined metrics.

¢ Identify the components with unusual performance or utilization and drill down to other reports to
analyze the problem.

« Rank the components based on their utilization levels.

« Identify the metrics that are close to the threshold. Use the following sections to identify such
components:
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= Top 10 CPU Forecasts
s Top 10 Memory Forecasts

The default display grain is 1 hour. To select a different time grain or time range, use the Time
Controls tab in the navigation panel.

You cannot select the metrics for this report.

Component Health Peak Period Report

This report ranks the utilization and performance of a component during the busiest time of the
selected time range.

You can:
« lIdentify the performance and utilization of the selected metrics during the peak period.

« Identify the components that have the highest or lowest performances or utilization levels during
the peak period.

o Compare the performance for multiple components during the peak period using this report.
Use this report to:

o Identify a group of components or nodes having a common network performance problem.
« Identify the component that is suffering from a persistent performance problem.

Report options:

e Top/Bottom N

o Select Metric(s)

o Grouping by Time Period

To add another metric, click Options and the ﬁ /> button.

To remove a metric, click Options and the X button.

To select a range of value for the metric, click the # button and 7. Select a range of metric value
the report should consider.

When specifying the range for a percentage metric, make sure that the ranges are in one of the
following formats:

o Decimal multiplier (for example, 1 to specify 100%, 0.5 to specify 50%, etc.)
+ Range with the % (Percentage) symbol (for example, 100%), 50%)

For example, to see the top five CPUs with average memory utilization between 10% and 90%,
type the following ranges:

o 0.10r10% as Lowest Value
o 0.90r90% as the Highest Value

By default, the report groups data by Qualified Component Name. You can select multiple grouping

attributes with the ﬁ button. To remove a grouping attribute, click the P button.
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Tips:
Use this report to identify the period when the component utilization was the highest.
Check this report once a day to see which component might need special attention.

Check this report periodically throughout the day to see which component is performing at the
extremes and might need special attention.

Component Health Threshold Sleeve Report

This report analyzes how close the metric performance value is to the threshold levels. It enables
you to analyze when the metric will reach the threshold.

You can:
o Forecast over-utilization or under-utilization of the selected component.
o Detect if the metric performance is about to cross the high and low thresholds.

For example, if you generate the Threshold Sleeve Chart report for Buffer Utilization (avg), the
chart displays how close the average buffer utilization is to the high and low threshold.

o Save multiple Threshold Sleeve Reports for a specific metric for different time ranges, and
analyze the metric performance trend.

Component Health Top N Chart Report

This report ranks the components by the metric you select. It displays an individual chart for each
topology filter and metric selected for the report.

Using this report, you can:

o Spot the component that performed at the extremes.

« Analyze the historical data for components that are exhibiting unusual utilization levels.

o Detect the component having a health or performance problem.

« Analyze the utilization of the NNMi managed components based on a specific time range.
o Detect the over-utilized and under-utilized components in the network.

o Detect the underlying reason of a persistent problem with a component. You can compare the
performance for multiple components using this report.

For example, say that some of the routers in your network are performing poorly. You could group
the routers that report the highest average response time. The router with the highest response time
is ranked first.

Report options:

e Top/Bottom N
o Select Metric(s)
¢ Grouping By

The report displays the selected metrics usingtwo Y axes.
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e TheleftY axis (the Y1 axis) displays the performance of the main metric based on which you
want to generate the report.

o Theright Y axis (the Y2 axis) displays the performance of the metric that should overlay the
main (primary) metric.

To add another metric, click Options and the qu._hlAdd new metric button.

To remove a metric, click Options and the XRemove metric button.

To select a range of value for the metric, click the (Apply Filter button, and select a range of metric
value the report should consider.

While specifying the range for a percentage metric, make sure that the ranges are one of the
following formats:

o Decimal multiplier (1 to specify 100%, 0.5 to specify 50%, etc.)
o Range with the % (Percentage) symbol (100%, 50%, etc.)

For example, to see the top five CPUs with average memory utilization between 10% and 90%,
type the following ranges:

e 0.10r10% as Lowest Value
e 0.90r90% as the Highest Value
By default, the report groups data by Qualified Component Name. You can select multiple grouping

attributes with the ﬁ button. Use the x button to remove a grouping attribute.
Component Health Top N Report

This report ranks network elements by the metrics you select. Use this report to spot the element
that performed at the extremes and to analyze historical data for elements that are exhibiting
unusual utilization levels. You can:

o Detect the component that has a health or performance problem.
o Analyze the utilization of the NNMi-managed network components during a specific time range.
¢ Detect over-utilized and under-utilized components in the network.

o Compare performance for multiple network components.
How to Run the Top N Report

Selecting the Top N report in the Reports pane automatically runs the report. The values selected
the previous time the report was run are used. You can change the values with the Options menu
and customize the report. The following report options are available:

e Top/Bottom'N'

¢ Select Metric(s):
o Display Time Series Chart

¢ Grouping by:
Report Options

Page 133 of 230 HP Network Node Manager iSPI Performance for Metrics Software (9.20)



Online Help
Contents

Top / Bottom 'N'

You can select from the following:

Ranking Number Description

Top5

Top 10

Top 25

Top 50

Top 100

Bottom 5

Bottom 10

Bottom 25

Bottom 100

Sort All in Descending

Sort All in Ascending

Select Metric(s)
You can select up to six metrics for each metric type over the selected time period. To add a metric,

click '{F._hl Add new grouping. To remove a metric, click P Remove metric.

To select a range of values for the metric, click ‘{F_hl and ¥ Apply Filter, and select a range of metric
values the report should consider. Make sure that the ranges are in one of the following formats:

o Decimal multiplier (1 to specify 100%, 0.5 to specify 50%, and so on)
« Range with the % (Percentage) symbol (100%, 50%, and so on)

For example, to see the top five interfaces for node 15.2.103.112, where the average utilization is
between 10% and 90%, type the following ranges:

e 0.10r10% as Lowest Value
e 0.90r90% as the Highest Value
By default, the report groups data by Qualified Interface Name.

The selected interfaces are ranked according to the value of the first metric listed in the Select
Metric(s) field. You can select any of the metrics listed in the two drop-down boxes. The metrics
you select are displayed along the two Y axes of the resulting chart.

o The selections you make in the left box appear along the left (Y1) axis of the resulting chart.
o The selections you make in the right box appear along the right (Y2) axis.

A number of metrics provide aggregated (avg, max, min, and percentile) values. Percentiles have
the following meaning:
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pctile05) - 5 percent of samples fall below, and 95 percent fall above.

pctile95) - 95 percent of samples fall below, and 5 percent fall above.

(

o (pctile90) - 90 percent of samples fall below, and 10 percent fall above.
(
(

pctile99) - 99 percent of samples fall below, and 1 percent fall above.

Display Time Series Chart
Selecting Yes produces a chart that displays the selected metrics alongtwo Y axes.

o The left (Y1) axis displays the performance of the main metric on which you want to generate the
report.

o Theright (Y2) axis displays the performance of the metric that should overlay the main (primary)
metric.

Grouping by:

This option enables you to select a Grouping Attribute. The selections are the following.

Grouping Attribute Description

NodeGroup Name

Qualified Component
Name

Component Name

Component Type

Component UUID

Node Name

Node Short Name

Node Contact

Node Location

Node Family

Node Vendor

Node UUID

Node ODBID

Tenant Name

Tenant UUID

SecGroup Name

SecGroup UUID

Node Annotation
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You can add another grouping by clicking the ﬁ Add new grouping button.

When your report completes, you can save it as a Report View. To save it, click the Keep this
version drop-down list and select Save as Report View. The Save as report view window opens.
You can specify a name and location. When done, click OK.

Tips:
Check this report once a day to see which network component might need special attention.

Check this report throughout the day to see which network components are performing at the
extremes and might need special attention.

About Reportlets

In a large enterprise network, the NNM iSPI Performance products (HP NNM iSPI Performance for
Metrics, HP NNM iSPI Performance for Quality Assurance, and HP NNM iSPI Performance for
Traffic) can produce a large amount of data and large cardinality. Enterprise networks often have a
very large number of unique IP addresses, source nodes, destination nodes, virtual circuits,
interfaces, and components that each produce a large amount of data. Generating reports can
therefore be time-consuming.

Reportlets enable you to generate quick impressions of the larger reports using the NNM iSPI
Performance dashboard.

To display the reportlets:
1. Log ontothe NPS home page.
2. Onthe left navigation panel, select Dashboard Reportlets.
3. Select an extension pack and a reportlet.

You can also create custom dashboards using the reportlets.
Simple Bar Chart

Compares the performance of two metrics for the selected time range.
Enables you to:
o Compare the performance trends of multiple metrics.

« Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports two metrics.
Simple Bar and Line Chart

Displays the trend of component performance for the past one day using the following values:
o Primary Metric on the bar chart
e Secondary Metric on the line chart

Enables you to:
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o Compare the performance trends of multiple metrics.

« Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports two metrics.
Baseline Sleeve Chart

Analyzes how close the metric performance value is to the threshold levels.
Enables you to:
o Detect if the metric performance is about to cross the high and low thresholds.

For example, if you generate the Baseline Sleeve Chart reportlet for Utilization (avg), the chart
displays how many exceptions are raised on average utilization in the past one day,

o Save multiple Sleeve Reports for a time range, and for analyze the trend of performance for the
metric.

This reportlet supports one metric.
Baseline Metric Snapshot with Range

Displays the aggregated metric performance for the selected time range.

Enables you to:

o Build a performance history for the selected baseline metric and analyze how the metric
performance changes over time.

Such history may help you to select an expected performance level for the metric
o Compare the performance for multiple metrics over a specified time range.

Though you can generate snapshot report for a single metric, you can save the snapshot report
for various metrics and compare the performance of each metric over a time range.

This reportlet supports one metric.
Baseline Sparkline

Evaluates the trend of how the selected baseline metric value has changed for the selected time
range.

Enables you to:

« Analyze the variations in the performance for the selected metric.

o Decide whether the expected behavior for the selected metric should be reassessed.
This reportlet supports one metric.

Baseline Sparkline with Range

Evaluates the trend of how the selected baseline metric value has changed for the selected time
range.

Enables you to:
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o Evaluate the performance trend of the selected metric for the selected time range.
« Compare the present performance trend with the normal (expected) performance range.
o Measure the performance of past one day in percentage.

This reportlet supports one metric.
Calendar

Displays a comparative study of the selected Primary Metric and Secondary Metric.

The default display grain is set to 1 hour. You cannot change the display grain of this reportlet.
Enables you to monitor:

o Daily component utilization

o Volume of data passed through the component for the past one day

o Performance of the component for the past one day

Supports two metrics.
Gauge
Evaluates the metric for the selected point of time.
Select only the metrics that displays the percentage values.
Enables you to:
o Measure the daily performance of the selected metric.
o Detect any abnormal or unexpected performance level.
This reportlet supports one metric.
When the NPS database has no data, the needle icon on the gauge does not appear.

Heat Chart

Grades the performance of the selected metric for the selected time range.
The metric performance is aggregated based on an hourly display grain.
Enables you to:

« View how the component performance gets affected by a varying metric.
o Compare the hourly performance of the selected metric.

o Detect the time range when the component performance was affected adversely because of the
fluctuating metric value.

This reportlet supports one metric.
Metric Snapshot

Displays the metric performance for the selected time range.

Enables you to:
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o Build a performance history for the selected metric and analyze how the metric performance
changes over time.

Such history may help you to decide the baseline value for the metric
o Compare the performance for multiple metrics over a specified time range.

Though you can generate snapshot report for a single metric, you can save the snapshot report
for various metrics and compare the performance of each metric over a time range.

This reportlet supports one metric.
Most Changed

Compares the metric performance between the following:

o Selected time range

o Period preceding the selected time range

Aggregates the metric utilization and ranks the performance in a descending order.
Enables you to:

o Measure the performance fluctuations for the components.

o Detect the top N components having a common performance or utilization problem.
You can enhance the report usability using the following features:

e Top/BottomN

¢ Grouping By

This reportlet supports one metric.

Multimetric Chart

Analyzes the performance trend for the selected metrics for the selected time range.
Enables you to:
o Perform comparative analysis of the selected metrics for each display grain.
The default display grain is one hour.
¢ Analyze the reason for any ups and downs in the component performance.
o Detect any persistent problem in the component performance.

This reportlet supports up to six metrics.

Simple Chart
Analyzes the utilization trend for the selected metrics for the selected time range.
Enables you to:

o Perform comparative analysis of the selected metrics for each display grain.

The default display grain is one hour.
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o Analyze the reason for any ups and downs in the component performance.
o Detect any persistent problem in the component performance.
This reportlet supports two metrics.

Simple Table

Analyzes the utilization trend for the selected metrics for the selected time range.
The default display grain is one hour.

Enables you to:

¢ Analyze the hourly performance of the metrics.

o Detect any abnormal or unexpected component performance.

¢ Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports up to six metrics.

Sparkline

Evaluates the trend of how the selected metric value has changed for the selected time range.
Enables you to:

¢ Analyze the variations in the performance for the selected metric.

o Decide whether the expected behavior for the selected metric should be reassessed.

This reportlet supports one metric.

Threshold Sleeve Chart

Analyzes how close the metric performance value is to the threshold levels.
Enables you to:
o Detect if the metric performance is about to cross the high and low thresholds.

For example, if you generate the Exception Sleeve Chart reportlet for Utilization (avg), the chart
displays how many exceptions are raised on average utilization in the past one day,

o Save multiple Sleeve Reports for a time range, and analyze the trend of performance for the
metric.

This reportlet supports one metric.

Top N Chart

Ranks the individual contribution of each metric for the component performance for the selected
time range.

The performance of the component is aggregated on hourly basis.

Enables you to:
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o Spot the components for which the performance metrics present extreme values.
« Investigate the aggregated data for the components that are exhibiting unusual utilization levels.

o Select the metric based on which you want to generate the report. The metric that you select is
used to rank the components.

¢ Group the report data based on a specific parameter. To add a subgroup, click the ﬁAdd
Group button.

This reportlet supports one metric.
Top N Line Chart

Ranks the utilization trend for the selected metrics for the selected time range.

The performance of the component is aggregated on hourly basis.

Enables you to:

o Spot the components for which the performance metrics present extreme values.

¢ Investigate the aggregated data for the components that are exhibiting unusual utilization levels.

o Select the metric based on which you want to generate the report. The metric that you select is
used to rank the components.

o Group the report data based on a specific parameter. To add a subgroup, click the ﬁAdd
Group button.

This reportlet supports one metric.
Top N Stacked Chart

Ranks the individual contribution of each component based on the selected metrics.

The performance of each component is aggregated for the default display grain of one hour.
Enables you to:

e Spot the components for which the performance metrics present extreme values.

« Investigate the aggregated data for the components that are exhibiting unusual utilization levels.
o Detect the network path having a common network performance problem.

This reportlet supports up to six metrics.
Top N Table

Ranks the components based on the selected metric.

Enables you to:

o Spot the components for which the performance metrics present extreme values.

o Investigate the aggregated data for the components that are exhibiting unusual utilization levels.

o Select the metric based on which you want to generate the report. The metric that you select is
used to rank the components.
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Group the report data based on a specific parameter. To add a subgroup, click the ﬁAdd
Group button.

This reportlet supports up to six metrics.

Top N Table with Bars

Ranks the components based on the selected metric and displays a horizontal bar to depict the
aggregated metric value.

Enables you to:

Spot the components for which the performance metrics present extreme values.
Investigate the aggregated data for the components that are exhibiting unusual utilization levels.

Select the metric based on which you want to generate the report. The metric that you select is
used to rank the components.

Group the report data based on a specific parameter. To add a subgroup, click the ﬁAdd
Group button.

This reportlet supports up to six metrics.

Calculating Node Availability

NPS calculates node availability af follows:

1.

NNMi polls the SNMP sysUpTime value for each managed node and passes the sysUpTime
value to NPS.

NPS calculates the number of seconds the node was available for polling using the following
formula:

= [f anode is reachable and the SNMP agent responds with the sysUpTime during the polling
interval:

Available Seconds = Delta Time = delta sysUpTime

This formula is applied only when the sysUpTime counter is not reset, and delta sysUpTime
is greater than or equal to the elapsed clock time since the last successful sysUpTime poll.

= If node sysUpTime was reset, or delta sysUpTime is less than the elapsed clock time since
the last successful poll:

Available Seconds = sysUpTime as seconds (because sysUpTime was reset)
where, Delta Time = elapsed clock time since the last successful sysUpTime poll
NPS calculates node availability using the following formula:
Node Availability = Available Seconds / Delta Time

If the node does not respond to polling during the polling interval, NPS creates a metric entry
indicating an unresponsive target. The Node Availability value is set to NULL.

Calculating Node Reachability

NPS calculates node reachability as follows:

Page 142 of 230 HP Network Node Manager iSPI Performance for Metrics Software (9.20)



Online Help
Contents

1. NNMi performs ICMP polls of the node's management address and passes the polling result to
NPS.

2. NPS calculates node reachability using the following formula:
= Reachable Seconds = Delta Time = Polling Interval

The formula is applied only when the node is reachable (when the node's management
address responds to the ICMP ping during any polling interval).

n Delta Time = Polling Interval
When Reachable Seconds = 0.

Reachable seconds are considered as zero, when the node is not reachable (when the
node's management address does not respond to the ICMP ping during the polling interval).

3. NPS calculates node reachability using the following formula:

Node Reachability = Reachable Seconds / Delta Time
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Glossary of Metrics

Term Definition

Memory Utilization Percentage of memory in use compared to the total amount of
memory available.

Buffer Utilization Percentage of buffer space in use compared to the total amount of
buffer space available.

Buffer Miss Rate A counter measures the number of buffers available in the buffer
pool. An exception is recorded when the number of buffers drops
below a minimum number. The miss rate percentage shows how
the number of below-minimum samples compares to total samples.

Buffer Failure Rate A counter measures the number of times buffer creation fails due to
insufficient memory. An exception occurs when the number of
failures crosses a threshold. The buffer failure rate is a percentage
that shows how the number of buffer creation failures compares to
the total number of buffer creations.

CPU Utilization Percentage of CPU utilization in use compared to the total amount
of CPU capacity available. (This metric maps to the CPU 1m
utilization value from NNMi.)

CPU 5-Second Utilization | Average CPU utilization over a 5-second period, providing a
snapshot of the past 5-seconds at the time of polling. Available
from Cisco devices only.

CPU 1-Minute Utilization Average CPU utilization over a 1-minute period, providing a
snapshot of the previous minute at the time of polling. Available
from Cisco and Nortel Passport devices.

CPU 5-Minute Utilization Average CPU utilization over a 5-minute period, providing a
snapshot of the previous 5 minutes at the time of polling. Available
from Cisco devices only.

Response Time The time it takes a node to respond to an SNMP request from
NNMi
SampleCount Number of samples. Some nodes do not support the full range of

metrics. To avoid skewing the averages, separate counts are kept
for each metric received.

NodeCount Number of nodes polled.

ComponentCount Number of components polled.

Glossary of Backplane Utilization Metrics

Backplane utilization indicates how much traffic is flowing through the switches available in a
network.
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Metric Name Description

Backplane Utilization (avg) Average rate of network traffic flowing through the
components available in the network

Backplane Utilization (min) Minimum rate of traffic flowing through the components
available in the network

Backplane Utilization (max) Maximum rate of traffic flowing through the components
available in the network

Backplane Utilization - Threshold Total number of times the backplane utilization for the

Exception Count (sum) switches available in the network crossed the threshold
level.
Indicates that the data being transmitted over a switch's
backplane is excessive.

Backplane Utilization - Threshold Rate of the backplane utilization exceptions for the

Exception Rate (avg) switches available in the network

Glossary of Disk Space Utilization Metrics

Metric Name Description

Disk Space Utilization - Threshold Total number of times the disk space utilization has

Exception Count (sum) crossed the threshold level

Disk Space Utilization - Threshold Rate of disk space utilization exceptions for the available
Exception Rate (avg) hosts in a network

Disk Space Total - MB (avg) Average amount of disk space allocated by all the

selected hosts

Disk Space Total - MB (min) Minimum amount of disk space allocated by all the
selected hosts

Disk Space Total - MB (max) Maximum amount of disk space allocated by all the
selected hosts

Disk Space Used - MB (avg) Average amount of host disk space used by the selected
components
Disk Space Used - MB (min) Minimum amount of host disk space used by the

selected components

Disk Space Used - MB (max) Maximum amount of host disk space used by the
selected components

Disk Space Free - MB (avg) Average amount of free host disk space available for the
selected components

Disk Space Free - MB (min) Minimum amount of free host disk space available for the
selected components
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Glossary of Node Availability Metrics

Metric Name Description

Node Availability
e Average
e Maximum

e Minimum

Amount of time the node was
available for polling.

Node availability depends on the
sysUpTime of the node.

See Calculating node availability.

Node Reachability
o Average
e Maximum

e Minimum

Amount of time the node's
management address was available
to the ICMP polls performed by
NNMi.

See Calculating node reachability.

.ICMP ResponseTime (Milliseconds)

e Average

¢ Maximum

e Minimum

o Baseline Average

o Average Baseline Deviation

o Average Slope

e Maximum Upper Normal Value

¢ Minimum Lower Normal Value

e Minimum Days to Threshold

o Average Forecast Baseline (for four weeks)
o Average Forecast Baseline (for eight weeks)

o Maximum Forecast Upper Normal value (for 12
weeks)

e Minimum Forecast Lower Normal value (for 12
weeks)

o Sum of Baseline Exception Count

o Average Baseline Exception Rate

o Average Baseline Intercept Component
o Average Baseline Trend Component

o Average Baseline Seasonal Component

ICMP response time as
milliseconds.

If NNMi poll does not receive any
responses from the node's
management address, NPS
considers this value to be NULL.
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Metric Name Description

e Maximum value for Anomaly Sample Flags Window
o Average Baseline Linear Samples Used

o Average Baseline Seasonal Samples Used

e Maximum value for the Upper Threshold

¢ Minimum value for the Lower Threshold

e Sum of Threshold Exception Count

o Average Threshold Exception Rate

Glossary of Polling Metrics

Metric Name

Target Error (avg)

Description

Generated when the target component returns any of the following
SNMP error responses:

o Authentication error
¢ Nosuchname

¢ No such object.

Reboot (avg)

Generated when the target component was restarted during the poll
and no data could be retrieved from the component.

NNMi checks the sysUptime metric to determine whether the
component was restarted during the last poll.

Invalid Data (avg)

Generated when NNMi has successfully polled data from the
target, but has determined that the data is invalid. For example, this
metric is calculated when the number of packets is greater than the
number of octets.

Unresponsive Target (avg)

Generated when the SNMP agent did not respond when collecting
metrics for a particular polling policy.

About Frame Relay Health Reports

Frame Relay Health reports provide performance data for the Frame Relay virtual circuits in your

environment.

These reports can let you see when a virtual circuit is being over-used or needs an upgrade.

You can open reports from NNMi or from the NPS home page.

You can also open a workspace view from NNMi, move to the iSPI, and begin your investigation

from the NPS home page.

To open a report from the NNMi console:
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1. Logintothe NNMi Console.

2. Select aworkspace.

3. Open aview (nodes, interfaces, components, or incidents).
4

Select Actions > HP NNM iSPI Performance > Reporting - Report Menu.

Frame Relay Calendar Report

The Calendar report uses a traditional, calendar-style layout to show hourly statistics for two
metrics in a single, extended graph spanning multiple days.

Defaults are:

¢ FrameRelay Pvc Name = All

o Dates/Times = Last 31 days

o Metric(s) Shown on Y1 Axis (Primary Metric) = Volume Bytes (sum)

o Metric(s) Shown on Y2 Axis (Secondary Metric) = CIR Utilization (avg)

The default view shows data for the current month. Depending on how long the iSPI has been
collecting data from NNMi, you could have the option of looking at data for the previous 70 days if
you use the option Until Now.

If you set the Time Range to less than 24 hours, the following message appears:

This report is not designed to operate with a time range of less than
24 hours. Please modify your time selections.

Use Case

This report enables you to:

o Observe gradual trends over time and isolated spikes

o Verify that an abnormal condition has returned to normal

o Make comparisons

This report also reveals day of week and hour of day patterns.

For example, if utilization is spiking on Tuesdays, or if response time issues are occurring daily at
11:00 a.m., the report will highlight these events.

Frame Relay Chart Detail Report

The Chart Detail report enables you to perform a trend analysis for network health and performance
based on historical virtual circuit health data. It displays a comparative analysis of the selected
metrics for each time unit.

For example, to compare how the volume of frames received and sent was affected by variance in
the frame discards per millisecond for the past week, you would generate the Weekly Frame Relay
report for the selected node group.

You can select two or more nodes, node groups, virtual circuits, or interface types.

The report enables you to:
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« Analyze the trend of network health and performance for multiple nodes, node groups, virtual
circuits, or virtual circuit groups based on one unit of time. Each unit of time is called a Display
Grain. Each Display Grain is measured as follows:
= 5 minutes for the hourly report

= 1 hour for the daily report

= 1 day for the weekly report

= 1 day for the monthly report
o Identify the virtual circuit that is causing ups and downs in network health and performance.
o Detect any persistent problem in the virtual circuit health and performance.

o Compare the network health and performance of more than two nodes, node groups, virtual
circuits, or virtual circuit groups based on historical virtual circuit health data.

The following filters are available in the Time Controls pane:
o Start Date/Time

o Time Range

¢ Display Grain

o Hour of day

o Day of Week

The graph on this report tracks up to six metrics per axis over the selected time period. The defaults
are:

o FrameRelay Pvc Name = All

o Metric(s) Shown on Y1 Axis = Volume Bytes (sum)

e Metric(s) Shown on Y2 Axis = CIR Utilization (avg)

The Chart Detail report displays the selected metrics using the following Y axes:

o TheleftY axis (the Y1 axis) displays the performance of the main metric on which you want to
generate the report.

o Theright Y axis (the Y2 axis) displays the performance of the metric that should overlay the
main (primary) metric.

To add another metric, click Options and the #Add New Grouping button.

To remove a metric that you already added, click Options and the xRemove Grouping button.

The Chart Detail report enables you to view the data in tabular format. To view the table, click
Options and select Table. The table appears instead of the chart. To view both the chart and the
table, click Options and select Chart and Table.

Frame Relay Dashboard Report

The Dashboard report provides an overview of the interfaces available on your network using a
combination of gauges, heat charts, and ordered Top 5 lists. The report displays the threshold
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violations for volume, error, and availability. Threshold violations can point to a network-related
problem or indicate that your thresholds within NNMi need to be changed.

To group the data within the dashboard:
1. Click Options.
2. Inthe Grouping By: field, select a topology filter to group the dashboard data.

For example, if you use a grouping option of Node Name, all Availability exceptions that fall
within the time and topology constraints are grouped by Node Name and displayed as a
percentage of the total samples in the left gauge.

Dashboard Sections
o Gauge
Gauges provide the following exception count statistics:
= Availability Exceptions (% samples)
= Utilization Exceptions (% samples)
= Discard Rate Exceptions (% samples)
= Error Rate Exceptions (% samples)

When the NPS database has no data, the needle icons on the gauges on the Dashboard report
do not appear.

e Topb5Lists
These lists display nodes responsible for the exceptions that show up in the gauges:
= Top 5 Qualified Interface Names by Utilization Exceptions
= Top 5 Qualified Interface Names by Availability Exceptions
o Top 5 Qualified Interface Names by Discard Exceptions Heat Chart
You can:
= Analyze the pattern of discard exceptions for the past 1 hour.
= Compare the discard performance of different interfaces.
= Detect the time range in the past 1 hour when the discard rates were the highest.
Example

If the gauges are showing few or no exceptions, none of your interfaces, including the interfaces in
the Top 5 lists, are experiencing problems with utilization or availability.

Say that your network is divided into groups that represent regions or strategic locations for your
enterprise. With the grouping option set to Node Group name, the report lists each of your strategic
Node Groups (as defined within NNMi) and provides the current statistics for exceptions within
each group.

If an unexpected change in exception counts is noted, you can click the appropriate gauge needle or
Node Group within the Top 5 lists and launch another report (such as Chart Detail) to investigate
trends or changes within the network as they are occur.
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The thresholds that create exceptions are set from NNMi, not from the iSPI. To set or modify
thresholds, refer to the online help for NNMi administrators.

Frame Relay Executive Report

The Executive report provides a broad view of interface performance for the selected time range
with the following graphs:

Volume of data passed through the interface (in GB)

Average percentage of interface availability

Average and maximum interface utilization percentage

Threshold and baseline utilization exception rates

Volume of data aggregated based on:

= Volume of data passed through the node groups

= Volume of data passed for each hour of the for the selected time range

Average percentage of interface utilization for the node groups for the selected time range

Average number of threshold and baseline exceptions faced by the node groups for the selected
time range

You can:

View every aspect of interface utilization and performance at once.
View trends and verify that interface utilization and performance are meeting expectations.

Identify isolated aberration in the graphs and detect any unexpected utilization or performance
trend.

View the trend of utilization for the node groups for the selected time range

The Executive report does not provide options to create graphs based on other metrics.

The default display grain for the Executive report is 1 hour.

This report shows the data for exceptions only if thresholds for performance metrics are set in
NNMi.

Frame Relay Headline Report

The Headline report provides a broad view of interface performance for the past day with the
following graphs:

Volume of data passed through the interface (in MB)

Average percentage of interface availability

Average and maximum interface utilization percentage

Threshold and baseline utilization exception rates

Maximum throughput per second (in bps)

Total number of data packets transmitted or received using unknown protocol

Maximum percentage of discard rate
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o Total number of discard rate exceptions

o Maximum percentage of error rate

o Total number of error rate exceptions

You can:

o View every aspect of interface utilization and performance at once.

o View trends and verify that interface utilization and performance are meeting expectations.

« lIdentify isolated aberration in the graphs and detect any unexpected utilization or performance
trend.

The Headline report does not provide options to create graphs based on other metrics.

This report shows the data for exceptions only if thresholds for performance metrics are set in
NNMi.

Frame Relay Headline-Wireless LAN Report
Available only on WLAN interfaces—following IEEE802dot11 performance policy

The Headline-Wireless LAN report provides a performance overview of the wireless LAN interfaces
available in your network. It displays interface availability and performance for the past 24 hours
with the following graphs:

o Total number of fragmented packets the interfaces have transmitted (sent and received)
successfully

o Total number of successful RTS compared to the total number of failed RTS
« Average and maximum number of wireless clients using the interface
o Maximum number of active bridges and repeaters available in the network for past 24 hours

o Total number of wireless stations available in the network. The graph displays the total number
of associated, authenticated, roamed in and roamed away stations available in the network.

o Total number of ACK failures that occurred in the wireless LAN for past 24 hours

o Total number of duplicate frames transmitted by the wireless LAN

¢ Total number of maxed out transmission attempts made by the wireless LAN

o Total number of undecryptable frames received by the wireless LAN in the past 24 hours
o Total number of FCS errors that occurred in the wireless LAN for the past 24 hours

You can:

o View every aspect of wireless LAN interface utilization and performance.

o View trends and verify that utilization and performance of the wireless LAN interfaces are
meeting expectations.

o Identify isolated aberrations in the graphs and detect any unexpected utilization or performance
trends.

The Headline-Wireless LAN report does not provide options to create graphs based on other
metrics.
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This report shows data for exceptions only if thresholds for performance metrics are set in NNMi.

Frame Relay Heat Chart Report

The Heat Chart report tracks the hourly performance of a single metric. The default metric is
Volume-Bytes (sum). The default time period is the last 31 days. Performance is color-coded,
which makes it easy to see if performance was satisfactory or unsatisfactory.

Features and Defaults

The legend at the top of the report maps a range of normalized performance values to a particular
color.

Beneath the legend, a table represents the normalized values of a performance metric. Rows of the
table represent hours of the day. Columns of the table represent days.

Each cell inside the table is color-coded. Each cell inside the table indicates a specific value of the
metric. You can hover the mouse pointer on the cell to see the absolute metric value of each hour.

The default topology filters are:

o FrameRelay Pvc Name = All

e Time Period = Last 31 days

e Hour of Day = All

o Day of Week = Al

¢ Metric = Volume - Bytes (sum)

Time range options are any period that is not less than 24 hours.
How to Use This Report

You can use this report to identify gradual shifts from one range of performance to another range,
spot an isolated instance of poor performance that affected the results for past 24 hours, spot day-
of-week patterns, and verify that an abnormal condition returned to normal after a problem was
corrected.

Frame Relay Managed Inventory Report

The Managed Inventory report enables you to view the number of instances of each topology
attribute seen in the collected data within the selected time range. For example, if the report is run
for "Last 1 Hour," you would see the number of unique values for each attribute seen in the data
collected over the past hour. The report can be useful for checking the number of nodes polled over
any given time range.

You can use attributes to filter the data and create a report that represents the elements you are
interested in. The report presents the list of attributes in the form of a table. The Count column
indicates the number of entries for each attribute. For example, count 5 for the topology item Node
Location means all nodes on your network can be grouped according to five different locations that
host the nodes.

You can use the following topology attributes with the virtual circuit Health reports:
¢ Qualified FrameRelay Name

o FrameRelay Pvc Name

Page 153 of 230 HP Network Node Manager iSPI Performance for Metrics Software (9.20)



Online Help
Contents

e FrameRelay Pvc DLCI
e FrameRelay Pvc ID

¢ Qualified Interface Name
¢ Interface Name

o Interface Alias

o Interface Physical Address
¢ Interface Annotation

e FrameRelay Pvc ID

o FrameRelay Pvc UUID
e Node Name

¢ Node Contact

¢ Node Location

o Node Family

+ Node Vendor

e NodelD

e Node UUID

¢ Node Annotation

¢ Interface ODBID

« Node ODBID

e Tenant Name

e Tenant UUID

e SecGroup Name

e SecGroup UUID)

The Managed Inventory report can take a significant time to build if you select a time range greater
than 24 hours.

Frame Relay Most Changed Report

The Most Changed report compares the performance of components for two different (consecutive)
time periods and ranks the components by the amount of change. The sort order is most-changed to
least-changed.

The report contains one table, which provides data for one metric only.
The table columns are:

o Grouping by levels; one to five columns, each displaying a level

o Performance for the previous time period

o Performance for the current time period
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o Growth, expressed as a percentage increase

e Change

The default filters are:

¢ Grouping by Elements = Qualified FrameRelay Name

o Start Date/Time = depends on default Time Range and data available in database
o Hourof Day (HOD) = All

o Day of Week (DOW) = All

o Ranking Metric = Volume - Bytes (sum)

e Top N Option=Top 10

You can select multiple grouping attributes with the '{EIAdd New Grouping button. Toremove a
grouping attribute, use the XRemove Grouping button.

How to Use This Report

Use this report to spot objects at a grouping level that saw significant growth from the previous
selected time period to the selected time period. Significant growth could point to a developing
problem you need to know about. You can change the ranking metric and how many elements are
listed.

Frame Relay Overview Report

The Overview report displays the utilization and performance of the most commonly monitored
metrics in the Frame Relay extension pack.

You can:
« Monitor the daily utilization and performance of a set of pre-defined metrics.

o Identify the virtual circuits with unusual performance or utilization and drill down to other reports
to analyze the problem.

o Rank the virtual circuits based on their utilization levels.

o Identify the metrics that are close to the threshold. Use the following sections to identify such
virtual circuits:

= 12 Weeks CIR In Utilization Forecasts
s 12 Weeks CIR Out Utilization Forecasts

The default display grain for this report is 1 hour. To select a different time grain or time range, use
the Time Controls tab in the navigation panel.

You cannot select the metrics for this report.

Frame Relay Peak Period Report

The Peak Period report ranks the utilization and performance of an interface during the busiest time
of the selected time range.

You can:
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« lIdentify the performance and utilization of the selected metrics during the peak period.

o Identify the interfaces that have the highest or lowest performances or utilization levels during
the peak period.

o Compare the performance for multiple interfaces during the peak period using this report.
Use this report to:

o Identify a group of virtual circuits having a common network performance problem.

« Identify the virtual circuit that is suffering from a persistent performance problem.
Frame Relay Peak Period Report Options

e Top/Bottom N

o Select Metric(s)

o Grouping by Time Period

This report tracks up to six metrics over the selected time period.

To add another metric, click Options and the #Add New Grouping button.

To remove a metric you already added, click Options and the XRemove Grouping button.

To select a range of values for the metric, click # and “F, and type a range of metric values the
report should consider.

When specifying the range for a percentage metric, make sure that the ranges are in one of the
following formats:

o Decimal multiplier (for example, 1 to specify 100%, 0.5 to specify 50%, etc.)
« Range with the % (Percentage) symbol (for example, 100%, 50%, etc.)

For example, to see the top five virtual circuits for node 15.2.103.112 with average utilization
between 10% and 90%, type the following ranges:

e 0.10r10% as Lowest Value
e 0.90r90% as the Highest Value
By default, the report groups data by Qualified FrameRelay Name. You can select multiple grouping

attributes with the ﬁ button. To remove a grouping attribute, use the P button.

Frame Relay Threshold Sleeve Report

The Threshold Sleeve report analyzes how close the metric performance value is to the threshold
levels. It enables you to analyze when the metric will reach the threshold.

You can:
o Forecast over-utilization or under-utilization of the selected Frame Relay virtual circuit.

o Detect if the metric performance is about to cross the high and low thresholds.
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For example, if you generate the Threshold Sleeve Chart report for Availability (avg), the chart
displays the how close the average virtual circuit availability is to the high and low threshold.

o Save multiple Threshold Sleeve Reports for a specific metric for different time ranges, and
analyze the metric performance trend.

This report supports one metric.

Frame Relay Top N Report

The Top N report ranks network elements by the metric you select. Use this report to spot the
element that performed at the extremes and to analyze historical data for elements that exhibit
unusual utilization levels.

You can:
o Detect the Frame Relay virtual circuits that have a health or performance problem.

« Analyze the utilization of the NNMi managed Frame Relay virtual circuits based on a specified
time range.

o Detect over-utilized and under-utilized Frame Relay virtual circuits in the network.

o Compare the performance of multiple Frame Relay virtual circuits for a single node or multiple
nodes using this report.

For example, say that one of the routers in your network is performing poorly. You could group the
Frame Relay virtual circuit for the router reporting the highest average error rate. The virtual circuit
reporting the highest average error rate is ranked first.

Interface Health Top N Reports Options
The Top N report displays the following options:
e Top/BottomN

o Select Metric(s): The report ranks the selected virtual circuits based on the value of the first
metric listed in the Select Metric(s) field.

o Display Time Series Chart
o Grouping By

This report tracks up to six metrics for each metric type over the selected time period.

To add another metric, click Options and the ﬁAdd New Grouping button.

To remove a metric you already added, click Options and the xRemove Grouping button.

To select a range of values for the metric, click the ﬁ button and ¥, and select a range of metric
values the report should consider. Make sure that the range is in one of the following formats:

o Decimal multiplier (for example, 1 to specify 100%, 0.5 to specify 50%, etc.)
« Range with the % (Percentage) symbol (for example, 100%, 50%, etc.)

For example, to see the top five interfaces for node 15.2.103.112 with average utilization between
10% and 90%, type the following ranges:
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e 0.10r10% as Lowest Value
o 0.90r90% as the Highest Value

By default, the report groups data by Qualified FrameRelay Name. You can select multiple grouping

attributes with the ﬁ button. To remove a grouping attribute, use the X button.
The Time Series Chart report displays the selected metrics using two Y axes:

o TheleftY axis (the Y1 axis) displays the performance of the main metric on which you want to
generate the report.

o Theright Y axis (the Y2 axis) displays the performance of the metric that should overlay the
main (primary) metric.

By default, Top N Report does not display the Time Series Chart. To view the chart with the detail
table:

o Select Options > Display Time Series Chart > Confirm Selection.
¢ Click tje Show Chart link below the detail table.
Check this report once a day to see which network interface might need special attention.

Check this report periodically throughout the day to see which network interfaces are performing at
the extremes and might need special attention.

Frame Relay Top N Chart Report
The Top N Chart report ranks the Frame Relay virtual circuits by the metric you select.
This report enables you to:
e Spot the virtual circuits that performed at the extremes.
¢ Analyze the historical data for virtual circuits that are exhibiting unusual utilization levels.
o Detect the virtual circuits having a health or performance problem.

o Analyze the utilization of the NNMi managed Frame Relay virtual circuits based on a specific
time range.

o Detect the over-utilized and under-utilized Frame Relay virtual circuits in the network.

o Detect the underlying reason of a persistent problem with a virtual circuit. You can compare the
performance for multiple virtual circuits using this report.

Top N Chart Options
e Top/BottomN

o Select Metric(s)

o Grouping By

This report tracks up to six metrics over the selected time period.

To add another metric, click Options and the #Add New Grouping button.

To remove a metric you already added, click Options and the XRemove Grouping button.
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To select a range of values for the metric, click # and ¥, and select a range of metric values the
report should consider.

When specifying the range for a percentage metric, use one of the following formats:
o Decimal multiplier (for example, 1 to specify 100%, 0.5 to specify 50%, etc)
« Range with the % (Percentage) symbol (for example, 100%, 50%, etc)

For example, to see the top five Frame Relay virtual circuits for node 15.2.103.112 with average
utilization between 10% and 90%, type the following ranges:

e 0.10r10% as Lowest Value
e 0.90r90% as the Highest Value

By default, the report groups data by Qualified FrameRelay Name. You can select multiple grouping

attributes with the ¥ 1 button. To remove a grouping attribute, use the Pt button.
The Top N Chart report displays the selected metrics using the following Y axes:

o TheleftY axis (the Y1 axis) displays the performance of the main metric on which you want to
generate the report.

e Theright Y axis (the Y2 axis) displays the performance of the metric that should overlay the
main (primary) metric.

Check this report once a day to see which interface might need special attention.

Check this report periodically throughout the day to see which interfaces are performing at the
extremes and might need special attention.

Frame Relay Top N CSV Report

The Top N CSV report retrieves a huge amount of data from the NPS database for the selected time
range, which could result in performance problems.

You can, however, schedule the following reports in CSV format:

e The Top N CSV report ranks the selected topology element according to the utilization level of
the selected metric in descending order.

o The Top N Detail CSV report lists metric utilization for the selected topology element according
to the selected time grain.

This report ranks the elements based on total metric utilization for the selected time range and
breaks up the metric utilization value for each time grain. For example, say you selected the
Time Range: Last 24 Hours option. The default display grain for this time range is 1 hour.

o Topology Element: FrameRelay Pvc Name
Metric: Volume—Bytes (sum) and CIR Utilization (avg)

This report ranks the FrameRelay Pvc Names based on the metric Volume—Bytes (sum). The
FrameRelay Pvc Name with the highest volume of data passing through it receives the highest
rank. The Top N Detail CSV report then calculates and lists the volume of data passed through
this element every hour in the past 24 hours.
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Glossary of Frame Relay Health Metrics

Available only for Frame Relay interfaces.

Metric Description

Discards - Frames (sum) Total number of inbound frames dropped due to any of the following
reasons:

e Format errors

o Inactive Virtual Circuit (VC)

BECN In - Frames (sum) Total number of frames received from the network indicating
backward congestion since the VC was created.

Backward congestion occurs in the following circumstances:
o When the remote DTE sets the BECN flag to 1.

o When a switch in the network receives the frame from a trunk
with congested transmission queue.

FECN In - Frames (sum) Total number of frames received from the network indicating
forward congestion since the VC was created.

Forward congestion occurs in the following circumstances:
o When the remote DTE sets the FECN flag to 1.

o When a switch in the network enqueues the frame to a trunk
with congested transmission queue.

FECN Frames In Rate Rate of frames received from the network indicating forward
congestion as compared to the total number of frames received

c avg over the selected VC

s min Calculated using the following formula:

e Max . . .
100.00 * (Sum of frames indicating forward
congestion / Sum of frames received)

BECN Frames In Rate Rate of frames received from the network indicating backward
congestion as compared to the total number of frames received

° avg over the selected VC

¢ min Calculated using the following formula:

e Max

100.00 * (Sum of frames indicating backward
congestion / Sum of frames received)

FECNPIusBECN Frames | Rate of frames received from the network indicating congestion
In Rate (backward or forward) as compared to the total number of frames

received over the selected VC
e avg

. Calculated using the following formula:
e MIN

e Max
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100.00 *
congestion + Sum of frames indicating forward

(Sum of frames indicating backward

congestion) / Sum of frames received

DE Frames In Rate
e avg
e Min

e Max

Rate of frames received from network that were eligible for discard
as compared to the total number of frames received over the
selected VC

100.00 *
discard / Sum of frames received)

(Sum of frames marked as eligible for

DE Frames Out Rate
e avg
e min

e Mmax

Rate of frames sent to the network that were eligible for discard as
compared to the total number of frames sent over the selected VC

100.00 * (Sum of frames marked as eligible for
discard / Number of frames sent)

Volume - Bytes (sum)

Total number of octets received and sent over the selected VC for
the time range that you selected.

Volume - Bytes In (sum)

Total number of octets received over the selected VC for the time
range that you selected.

Volume - Bytes Out (sum)

Total number of octets sent over the selected VC for the time range
that you selected.

Volume - Frames (sum)

Total number of frames received and sent over the selected VC for
the time range that you selected

Volume - Frames In (sum)

Total number of frames received over the selected VC for the time
range that you selected.

Volume - Frames Out
(sum)

Total number of frames sent over the selected VC for the time
range that you selected.

Volume - DE Frames (sum)

Total number of frames sent and received from the network that
were eligible for discard for the selected VC for the time range you
selected.

Volume - DE Frames In
(sum)

Total number of frames received from the network that were eligible
for discard for the selected VVC for the time range you selected.

Volume - DE Frames Out
(sum)

Total number of frames sent to the network that were eligible for
discard for the selected VC for the time range you selected.

Volume - NonDE Frames
(sum)

Total number of frames sent and received from the network that
were not eligible for discard for the selected VC for the time range
you selected.

Calculated using the following formula:

(Sum of frames sent from the selected VC + Sum
of frames received on the selected VC) - (Sum
of DE frames sent from the selected VC + Sum of
DE frames received on the selected VC)
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Volume - NonDE Frames Total number of frames received from the network that were not
In (sum) eligible for discard for the selected VC for the time range you
selected.

Calculated using the following formula:

(Sum of frames received on the selected VC) -
(Sum of DE frames received on the selected VC)

Volume - NonDE Frames Total number of frames sent to the network that were not eligible
Out (sum) for discard for the VC for the selected time range

Calculated using the following formula:

(Sum of frames sent from the selected VC) -
(Sum of DE frames sent from the selected VC)

Frames Size - Bytes Sum of octets in total number of frames sent and received over the
VC for the selected time range

e avg

e MmMin

e max

Frames Size - Bytes In Sum of octets in total number of frames received over the VC for
the selected time range

e avg

e Min

e Max

Frames Size - Bytes Out Sum of octets in total number of frames sent over the VC for the
selected time range

e avg
e min

e Mmax

CIR Utilization Amount of data (in bits) that the selected VC agrees to transmit
under normal conditions.

e avg
e min

e Max
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CIR In Utilization
e avg
e Mmin

e Mmax

Amount of data (in bits) that the selected VC receives under normal
conditions.

Calculated using the following formula:

(Number of octets received * 8 * 100)/(CIR *
sysUpTimeDelta in seconds)

sysUpTimeDelta = number of seconds since the node was
restarted

CIR Out Utilization

Amount of data (in bits) that the selected VC sends under normal
conditions.

e avg
. Calculated using the following formula:

e MIN
(Number of octets sent * 8 * 100)/(CIR *

e Max . .
sysUpTimeDelta> in seconds)
sysUpTimeDelta = number of seconds since the node was
restarted

EIR Utilization Amount of uncommitted data bits that the selected VC attempts to
transmit over the selected time period.

e avg

e min

e max

EIR In Utilization
e avg
e min

e Max

Amount of uncommitted data bits that the selected VC receives
over the selected time period.

EIR Out Utilization

Amount of uncommitted data bits that the selected VC sends over
the selected time period.

e avg

e min

e max

Availability The state of the VC, as reported to NPS. The state can be either
active or not active.

SNMP Response Time The time it takes the VC to respond to an SNMP request from

(msecs) NNMi

Period Length (secs) The duration (in seconds) between consecutive polling cycles of

NNMi.
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Unresponsive Target

Generated when the SNMP agent did not respond when collecting
metrics for a particular polling policy.

Target Error

Generated if the target VC returns any of the following SNMP error
responses:

o Authentication error
¢ Nosuchname

e Nosuch object

Reboot Generated if the target VC was restarted during the poll and no data
could be retrieved from the component.
Invalid Data Generated when NNMi has successfully polled data from the

target, but has determined that the data is invalid. For example, this
metric is calculated when the number of packets is greater than the
number of octets.

About Reportlets

In a large enterprise network, the NNM iSPI Performance products (HP NNM iSPI Performance for
Metrics, HP NNM iSPI Performance for Quality Assurance, and HP NNM iSPI Performance for
Traffic) can produce a large amount of data and large cardinality. Enterprise networks often have a
very large number of unique IP addresses, source nodes, destination nodes, virtual circuits,
interfaces, and components that each produce a large amount of data. Generating reports can

therefore be time-consuming.

Reportlets enable you to generate quick impressions of the larger reports using the NNM iSPI

Performance dashboard.

To display the reportlets:

1. Log ontothe NPS home page.

2. Onthe left navigation panel, select Dashboard Reportlets.

3. Select an extension pack and a reportlet.

You can also create custom dashboards using the reportlets.

Simple Bar Chart

This reportlet compares the performance of two metrics for the selected time range.

It enables you to:

o Compare the performance trends of multiple metrics.

« Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports two metrics.

To select a new metric for your reportlet, see Change Reportlet Options in the Using Reports >
Change Default Settings section.
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Simple Bar and Line Chart

Displays the trend of performance of the Frame Relay virtual circuits for past 24 hours using the
following values:

o Primary Metric on the bar chart

e Secondary Metric on the line chart

Enables you to:

o Compare the performance trends of multiple metrics.

¢ Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports two metrics.

To select a new metric for your reportlet, see Change Reportlet Options in the Using Reports >
Change Default Settings section.

Calendar

Displays a comparative study of the selected Primary Metric and Secondary Metric

The default display grain is set to one hour. You cannot change the display grain of this reportlet.
Enables you to monitor the following:

« Daily CIR or EIR utilization for the selected Frame Relay virtual circuits

o Volume of data passed through the virtual circuit for past 24 hours

o Performance of the virtual circuit for past 24 hours

This reportlet supports two metrics.

To select a new metric for your reportlet, see Change Reportlet Options in the Using Reports >
Change Default Settings section.

Gauge
This reportlet evaluates the metric for a selected point in time.
Select only the metrics that display the percentage values.
It enables you to:
o Measure the daily performance of the selected metric.
o Detect any abnormal or unexpected performance level.
The reportlet supports one metric.
When the NPS database has no data, the needle icon on the gauge does not appear.

To select a new metric for your reportlet, see Change Reportlet Options in the Using Reports >
Change Default Settings section.
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Heat Chart

This reportlet grades the performance of the selected metric for the selected time range.
The metric performance is aggregated according to an hourly display grain.

It enables you to:

« View how the performance of the selected Frame Relay virtual circuits are affected by a varying
metric.

o Compare the hourly performance of the selected metric.

o Detect the time range when the performance of the selected Frame Relay virtual circuits were
affected adversely because of the fluctuating metric value.

This reportlet supports one metric.

To select a new metric for your reportlet, see Change Reportlet Options in the Using Reports >
Change Default Settings section.

Metric Snapshot

This reportlet displays the metric performance for the selected time range.

It enables you to:

o Build a performance history for a selected metric and analyze how its performance changes over
time. This history can help you decide the baseline value for the metric.

o Compare the performance of multiple metrics over a specified time range. You can generate a
shapshot report for a single metric, and you can save the snapshot report for various metrics and
compare the performance of each metric over a time range.

This reportlet supports one metric.

To select a new metric for your reportlet, see Change Reportlet Options in the Using Reports >
Change Default Settings section.

Most Changed

This reportlet compares the metric performance of the selected time range with the period that
preceded the time range.

It aggregates metric utilization and ranks performance in descending order.
It enables you to:
o Measure the performance fluctuations for the Frame Relay virtual circuits.

o Detect the top N Frame Relay virtual circuits that have a common performance or utilization
problem.

You can enhance the usability of the reportlet through the following features:
e Top/Bottom N
o Grouping By

The reportlet supports one metric.
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To select a new metric for your reportlet, see Change Reportlet Option in the Using Reports >
Change Default Settings section.

Multimetric Chart

This reportlet analyzes the performance trend for the selected metrics for the selected time range.
It enables you to:

o Perform a comparative analysis of the selected metrics for each display grain. The default
display grain is one hour.

« Analyze the reason for ups and downs in the performance of the selected Frame Relay virtual
circuits.

o Detect any persistent problem in the performance of the Frame Relay virtual circuits.
The reportlet supports up to six metrics.

To select a new metric for your reportlet, see Change Reportlet Options in the Using Reports >
Change Default Settings section.

Simple Chart

This reportlet analyzes the utilization trend for the selected metrics for the selected time range.
It enables you to:

o Perform comparative analysis of the selected metrics for each display grain. The default display
grain is one hour.

« Analyze the reason for ups and downs in the performance of the selected Frame Relay virtual
circuits.

o Detect any persistent problem in the performance of the selected Frame Relay virtual circuits
The reportlet supports two metrics.

To select a new metric for your reportlet, see Change Reportlet Options in the Using Reports >
Change Default Settings section.

Simple Table

This reportlet analyzes the utilization trend for the selected metrics for the selected time range. The
default display grain is one hour.

It enables you to:
¢ Analyze the hourly performance of the metrics.
o Detect any abnormal or unexpected performance for the selected Frame Relay virtual circuits.

« Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

The reportlet supports up to six metrics.

To select a new metric for your reportlet, see Change Reportlet Options in the Using Reports >
Change Default Settings section.
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Sparkline

This reportlet evaluates how the selected metric value changed during the selected time range.
It enables you to:

¢ Analyze variations in performance for the selected metric.

o Decide whether the expected behavior for the selected metric should be reassessed.

The reportlet supports one metric.

To select a new metric for your reportlet, see Change Reportlet Options in the Using Reports >
Change Default Settings section.

Threshold Sleeve Chart

This reportlet analyzes how close the metric performance value is to the threshold levels.
It enables you to:
o Detect if the metric performance is about to cross the high and low thresholds.

For example, if you generate the Exception Sleeve Chart reportlet for CIR Utilization (avg), the
chart displays how many exceptions are raised on average CIR utilization in the past 24 hours,

o Save multiple Sleeve Reports for a time range, and for analyze the trend of performance for the
metric.

The reportlet supports one metric.

To select a new metric for your reportlet, see Change Reportlet Options in the Using Reports >
Change Default Settings section.

Top N Chart

This reportlet ranks the individual contribution of each metric for the performance for the selected
Frame Relay virtual circuits for the selected time range.

The performance of the interface is aggregated on an hourly basis.
It enables you to:
o Spot the virtual circuits for which the performance metrics present extreme values.

¢ Investigate the aggregated data for the virtual circuits that are exhibiting unusual utilization
levels.

o Select the metric on which to generate the report. The metric you select is used to rank the
virtual circuits.

o Group the report data based on a specific parameter. To add a subgroup, click the ﬁAdd New
Grouping button.

The reportlet supports one metric.

To select a new metric for your reportlet, see Change Reportlet Options in the Using Reports >
Change Default Settings section.

Page 168 of 230 HP Network Node Manager iSPI Performance for Metrics Software (9.20)



Online Help
Contents

Top N Line Chart

This reportlet ranks the utilization trend for the selected metrics for the selected time range.
The performance of the virtual circuits is aggregated on an hourly basis.

It enables you to:

e Spot the virtual circuits for which the performance metrics present extreme values.

¢ Investigate the aggregated data for the virtual circuits that are exhibiting unusual utilization
levels.

o Select the metric on which to generate the report. The metric you select is used to rank the
virtual circuits.

o Group the report data based on a specific parameter. To add a subgroup, click the '{EIAdd New
Grouping button.

The reportlet supports one metric.

To select a new metric for your reportlet, see Change Reportlet Options in the Using Reports >
Change Default Settings section.

Top N Stacked Chart

This reportlet ranks the individual contribution of each virtual circuit based on the selected metrics.
The performance of each interface is aggregated for the default display grain of 1 hour.

It enables you to:

e Spot the virtual circuits for which the performance metrics present extreme values.

¢ Investigate the aggregated data for the virtual circuits that are exhibiting unusual utilization
levels.

o Detect network paths that have a common network performance problem.
The reportlet supports up to six metrics.

To select a new metric for your reportlet, see Change Reportlet Options in the Using Reports >
Change Default Settings section.

Top N Table

This reportlet ranks the interfaces based on the selected metric.
It enables you to:
e Spot the virtual circuits for which the performance metrics present extreme values.

« Investigate the aggregated data for the virtual circuits that are exhibiting unusual utilization
levels.

o Select the metric on which to generate the report. The metric you select is used to rank the
virtual circuits.
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o Group the report data based on a specific parameter. To add a subgroup, click the ﬁAdd New
Grouping button.

The reportlet supports up to six metrics.

To select a new metric for your reportlet, see Change Reportlet Options in the Using Reports >
Change Default Settings section.

Top N Table with Bars

This reportlet ranks the Frame Relay virtual circuits based on the selected metric and displays a
horizontal bar to depict the aggregated metric value.

It enables you to:
e Spot the virtual circuits for which the performance metrics present extreme values.

¢ Investigate the aggregated data for the virtual circuits that are exhibiting unusual utilization
levels.

o Select the metric on which to generate the report. The metric you select is used to rank the
virtual circuits.

¢ Group the report data based on a specific parameter. To add a subgroup, click the ﬁAdd New
Grouping button.

The reportlet supports up to six metrics.

To select a new metric for your reportlet, see Change Reportlet Options in the Using Reports >
Change Default Settings section.

About Interface Health Reports

Interface Health reports provide performance data for network interfaces. Graphs and charts
provide details that help you identify:

o Interface utilization
e Errors ininterfaces

Interface discard rate

o Availability of interfaces
You can use these reports to determine the status of the interfaces on your network.
To open a report from the NNMi console:
You have the following options.
o Move from NNMi to the iSPI, and launch reports from the Report Menu.
Or
o Launch pre-filtered reports directly from NNMi.

If you are interested in a particular node, node group, or interface, you will probably want to launch a
pre-filtered report from NNMi. Otherwise, open a workspace view from NNM, move to the iSPI, and
begin your investigation from the Report menu.

To move from NNM to the iSPI:
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1. Logintothe NNMi console.

2. Select aworkspace.

3. Open aview of nodes, interfaces, orincidents.
4

. Select Actions > HP NNM iSPI Performance > Reporting - Report Menu

Interface Health Baseline Sleeve Report

The Baseline Sleeve report analyzes how close the metric performance value is to the threshold
levels. In other words, this report enables you to analyze when the metric will reach the threshold.

Using this report, you can:

o Analyze if the interface utilization or performance is within the expected (normal) range for the
selected time range.

o Detect if the metric performance is about to cross the high and low thresholds.

For example, if you generate the Baseline Sleeve Chart report for the baseline metric Utilization
In, the chart displays the how close the interface utilization for incoming flow is to the high and
low threshold.

o Save multiple Baseline Sleeve Reports for a specific metric for different time ranges, and
analyze the metric performance trend.

Interface Health Calendar Report

The Calendar report uses a traditional, calendar-style layout to show hourly statistics for two
metrics in a single, extended graph spanning over multiple days.

Features and Defaults

The report defaults to:

o Interfaces = All

o Dates/Times = Last 31 days

o Metric(s) Shown on Y1 Axis (Primary Metric) = Volume Bytes (sum)
o Metric(s) Shown on Y2 Axis (Secondary Metric) = Utilization (avg)

The default view shows data for the current month. Depending on how long the iSPI has been
collecting data from NNMi, you could have the option of looking at data for the previous 70 days if
you use the Until Now option.

If you set the Time Range to less than 24 hours, the following message appears:

This report is not designed to operate with a time range of less than
24 hours. Please modify your time selections.

How to Use this Report

You can use this report to:

o Observe gradual trends over time and isolated spikes

o Verify that an abnormal condition has returned to normal

o Make comparisons
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This report also reveals:
o Day of week patterns
o Hour of day patterns

For example, if utilization is spiking on Tuesdays, or if response time issues are occurring daily at
11:00 a.m., the report will highlight these events.

Interface Health Chart Detail Report

The Chart Detail report enables you to perform a trend analysis for the network health and
performance based on historical interface health data.

The report displays a comparative analysis of the selected metrics for each time unit.

For example, if you need to compare how the average Threshold Exception Rate was affected by
variance in the average Response Time per millisecond for the past one week, you can generate
the Weekly Interface Health report for the selected node group.

You can also select two or more nodes, node groups, interfaces, or interface groups to generate the
report.

This report enables you to:

o Analyze the trend of network health and performance for multiple nodes, node groups,
interfaces, or interface groups based on one unit of time. Each unit of time is called as a Display
Grain. Each Display Grain is measured as follows:

= 5 minutes for Hourly report

= 1 hour for daily report

= One day for weekly report

= One day for monthly report
o lIdentify the interface that is causing any ups and downs in network health and performance.
o Detect any persistent problem in the interface health and performance.

o Compare the network health and performance of more than two nodes, node groups, interfaces,
or interface groups based on historical interface health data.

The following filters are available in the Time Controls pane:
o Start Date/Time

o Time Range

¢ Display Grain

o Hour of day

o Day of Week

Features and Defaults

The graph on this report tracks up to six metrics per axis over the selected time period. Unless you
modify the defaults, Chart Detail defaults to the following:
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¢ Interfaces = All

o Metric(s) Shown on Y1 Axis = Volume Bytes (sum)

o Metric(s) Shown on Y2 Axis = Availability - Utilization (avg)

The Chart Detail report displays the selected metrics using two Y axes.

o TheleftY axis (the Y1 axis) displays the performance of the main metric on which you want to
generate the report.

o Theright Y axis (the Y2 axis) displays the performance of the metric that should overlay the
main (primary) metric.

To add another metric, click Options and the ﬁAdd new grouping button.

To remove a metric that you already added, click Options and the xRemove Grouping button.

The Chart Detail report enables you to view the data in tabular format. To view the table, click
Options and select Table. The Table appears instead of the chart. To view both the chart and the
table, click Options and select Chart and Table.

Interface Health Dashboard Report

The Dashboard report provides an overview of the interfaces available on your network using a
combination of gauges, heat charts, and ordered Top 5 lists. It displays the threshold violations for
volume, error, and availability. Threshold violations can point to a network-related problem or
indicate that your thresholds within NNMi need to be changed.

To group the data within the dashboard:
1. Click Options.
2. Inthe Grouping By: field, select a topology filter to group the dashboard data.

For example, say you use a grouping option of Node Name. All Availability exceptions that fall
within the time and topology constraints would be grouped by Node Name and displayed as a
percentage of the total samples in the left gauge.

Dashboard Sections
« Gauges provide the following exception count statistics:
= Availability Exceptions (% samples)
= Utilization Exceptions (% samples)
» Discard Rate Exceptions (% samples)
= Error Rate Exceptions (% samples)

When the NPS database has no data, the needle icons on the gauges on the Dashboard report
do not appear.

o Top 5 Lists display nodes responsible for the exceptions showing up in the gauges:
= Top 5 Qualified Interface Names by Utilization Exceptions

= Top 5 Qualified Interface Names by Availability Exceptions
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o Top 5 Qualified Interface Names by Discard Exceptions Heat Chart enables you to:
= Analyze the pattern of discard exceptions for the past 1 hour.
» Compare the discard performance of different interfaces.
= Detect the time range in the past 1 hour when the discard rates were the highest.
Example

If the gauges show few or no exceptions, this means that none of your interfaces, including the
interfaces in the Top 5 lists, are experiencing problems with utilization or availability.

For example, your network is divided into groups that represent regions or strategic locations for
your enterprise. With the grouping option set to Node Group name, the report lists each of your
strategic Node Groups (as defined within NNMi) and provides the current statistics for exceptions
within each group.

If an unexpected change in exception counts is noted, you can click the appropriate gauge needle or
Node Group within the Top 5 lists, and then launch another report (such as Chart Detail) to
investigate trends or changes within the network as they are occurring.

The thresholds that create exceptions are set from NNMi, not from the iSPI. If you want to set or
modify thresholds, refer to the online help for NNMi administrators.

Interface Health Executive Report

The Executive report provides a broad view of interface performance for the selected time range,
using the following graphs:

o Volume of data passed through the interface (in GB)

o Average percentage of interface availability

o Average and maximum interface utilization percentage
o Threshold and baseline utilization exception rates

« Volume of data aggregated based on the following:
= Volume of data passed through the node groups

= Volume of data passed for each hour of the for the selected time range
o Average percentage of interface utilization for the node groups for the selected time range

o Average number of threshold and baseline exception faced by the node groups for the selected
time range

This report enables you to:
o View every aspect of interface utilization and performance at once.
o View trends and verify that interface utilization and performance are meeting expectations.

« lIdentify isolated aberration in the graphs and detect any unexpected utilization or performance
trend.

o View the trend of utilization for the node groups for the selected time range
The Executive report does not provide options to create graphs based on other metrics.

The default display grain for the Executive report is one hour.
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This report shows the data for exceptions only if thresholds for performance metrics are set in
NNMi.

Interface Health Headline Report

The Headline report provides a broad view of interface performance for the past one day, using the
following graphs:

« Volume of data passed through the interface (in MB)

o Average percentage of interface availability

o Average and maximum interface utilization percentage

o Threshold and baseline utilization exception rates

o Maximum throughput per second (in bps)

o Total number of data packets transmitted or received using unknown protocol
o Maximum percentage of discard rate

o Total number of discard rate exceptions

« Maximum percentage of error rate

o Total number of error rate exceptions

This report enables you to:

o View every aspect of interface utilization and performance at once.

« View trends and verify that interface utilization and performance are meeting expectations.

o Identify isolated aberration in the graphs and detect any unexpected utilization or performance
trend.

The Headline report does not provide options to create graphs based on other metrics.

This report shows the data for exceptions only if thresholds for perfformance metrics are set in
NNMi.

Interface Health Headline-Wireless LAN Report
Available only on WLAN interfaces — Following IEEE802dot11 performance policy

The Headline-Wireless LAN report provides a performance overview of the wireless LAN interfaces
available in your network. It displays interface availability and performance for the past 24 hours
using the following graphs:

o Total number of fragmented packets the interfaces have transmitted (sent and received)
successfully

o Total number of successful RTS compared to the total number of failed RTS
o Average and maximum number of wireless clients using the interface
o Maximum number of active bridges and repeaters available in the network for the past 24 hours

o Total number of wireless stations available in the network. The graph displays total number of
associated, authenticated, roamed in and roamed away stations available in the network.

o Total number of ACK failures occurring in the wireless LAN in the past 24 hours
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o Total number of duplicate frames transmitted by the wireless LAN

o Total number of maxed out transmission attempts made by wireless LAN

o Total number of undecryptable frames received by wireless LAN in the past 24 hours
o Total number of FCS errors occurring in the wireless LAN in the past 24 hours

This report enables you to:

o View every aspect of the wireless LAN interface utilization and performance at once.

o View trends and verify that the utilization and performances of the wireless LAN interfaces are
meeting expectations.

« lIdentify isolated aberration in the graphs and detect any unexpected utilization or performance
trend.

The Headline-Wireless LAN report does not provide options to create graphs based on other
metrics.

This report shows the data for exceptions only if thresholds for performance metrics are set in
NNMi.

Interface Health Heat Chart Report

The Heat Chart report tracks the hourly performance of a single metric. The default metric is
Volume-Bytes (sum). The default time period is the past 31 days. Performance is color-coded,
making it easy to see whether performance has been satisfactory or unsatisfactory.

Features and Defaults

The legend at the top of the report maps a range of normalized performance values to a particular
color.

Beneath the legend, a table represents the normalized values of a performance metric (rows of the
table represent hours of the day; columns of the table represent days).

Each cell inside the table is color-coded and each cell inside the table indicates a specific value of
the metric. You can also hover the mouse pointer on the cell to see the absolute metric value of
each hour.

The default topology filters for the Heat Chart are as follows:

o Interfaces = All

e Time Period = Last 31 days

o Hourof Day = All

o Day of Week = All

e Metric = Volume - Bytes (sum)

Time range options are any period that is not less than 24 hours.
How to Use this Report

You can identify gradual shifts from one range of performance to another range, to spot an isolated
instance of poor performance that affected the results for past 24 hours, to spot day-of-week
patterns, and to verify that an abnormal condition returned to normal after a problem was corrected.
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Interface Health Managed Inventory Report

The Managed Inventory report enables you to view the number of instances of each topology
attribute seen in the collected data within the selected time range. For example, if the report is run
for Last 1 Hour, you would see the number of unique values for each attribute seen in the data
collected over the last hour. This report can be useful for checking, for example, the number of
nodes polled over any given time range.

You can use the available attributes to filter the data of your interest and create a report that
represents only the elements of your interest. The report presents the list of attributes in the form of
atable. The Count column of the table indicates the number of entries for each attribute. For
example, count 5 for the topology item Node Location means that all nodes on your network can be
grouped based on five different locations that host the nodes.

You can use the following topology attributes with the Interface Health reports:
¢ Qualified Interface Name
¢ Interface Name

o Interface Alias

o Interface Descr

¢ Interface Index

o Interface Type

o Interface Physical Address
o Interface Speed (In:Out)
o Interface ID

¢ Interface UUID

¢ Interface Annotation

o Node Name

¢ Node Contact

¢ Node Location

o Node Family

¢ Node Vendor

e NodelD

e Node UUID

¢ Node Annotation

¢ Interface ODBID

« Node ODBID

e Tenant Name

e Tenant UUID
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o SecGroup Name

e SecGroup UUID)

Interface Health Most Changed Report

The Most Changed report compares performance the components for two different (consecutive)
time periods and ranks components by the amount of change. The sort order is most-changed to
least-changed.

Features and Defaults

This report contains one table. The table provides data for one metric only.

The table columns are:

o Grouping by levels; one to five columns, each displaying a level

o Performance for the previous time period

o Performance for the current time period

o Growth, expressed as a percentage increase

e Change

The default filters for the Most Changed report defaults to:

o Grouping by Elements = Qualified Interface Name

o Start Date/Time = depends on default Time Range and data available in database
o Hourof Day (HOD) = All

o Day of Week (DOW) = All

o Ranking Metric = Volume - Bytes (sum)

e Top N Option=Top 10

You can select multiple grouping attributes with the '{EIAdd New Grouping button. You can
remove a grouping attribute with the xRemove Grouping button.

How to Use this Report

Use this report to spot objects at selected grouping level that saw significant growth from the
previous selected time period to the selected time period. Significant growth could point to a
developing problem you need to know about. You can change the ranking metric and you can
change how many elements are listed.

Interface Health Overview Report

The Overview report displays the utilization and performance of the most commonly monitored
metrics in the Interface Health extension pack.

You can:
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o Monitor the daily utilization and performance of a set of pre-defined metrics.

o Identify the interfaces with unusual performance or utilization and drill down to other reports to
analyze the problem.

o Rank the interfaces based on their utilization levels.

« Identify the metrics that are close to the threshold. Use the following sections to identify such
interfaces:
= 12 Weeks Utilization In Forecasts

s 12 Weeks Utilization Out Forecasts

The default display grain for this report is one hour. To select a different time grain or time range,
use the Time Controls tab in the navigation panel.

You cannot select the metrics for this report.

Interface Health Peak Period Report

The Peak Period report ranks the utilization and performance of an interface during the busiest time
of the selected time range.

You can:
« lIdentify the performance and utilization of the selected metrics during the peak period.

o Identify the interfaces that have the highest or lowest performances or utilization levels during
the peak period.

o Compare the performance for multiple interfaces during the peak period using this report.
How to Use this Report

Use this report to:

o Identify a group of interfaces having a common network performance problem.

o lIdentify the interface that is suffering from a persistent performance problem.

Interface Health Peak Period Report Options

e Top/BottomN

e Metric

e Grouping by Time Period

This report tracks up to six metrics over the selected time period.

To add another metric, click Options and the ﬁAdd New Grouping button.

To remove a metric that you have already added, click Options and the XRemove Grouping
button.

To select a range of value for the metric, click '{EI and I, and type a range of metric value that the
report should consider. Make sure that the ranges are any of the following formats:

o Decimal multiplier (for example, 1 to specify 100%, 0.5 to specify 50%, etc)
« Range with the % (Percentage) symbol (for example, 100%, 50%, etc)
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For example if you want to see the top five interfaces for the node 15.2.103.112 with the average
utilization between 10% and 90% type the following ranges:

¢ 0.10r10% as Lowest Value
e 0.90r90% as the Highest Value

By default, the report groups data by Qualified Interface Name. You can select multiple grouping

attributes by using the ﬁ (Add New Grouping) button. Use the P (Remove Grouping) button
to remove a grouping attribute.

Tips:
o Use this report to identify the period when the interface utilization was the highest.
o Check this report once a day to see which interface may need special attention.

o Check this report periodically throughout the day to see which interface is performing at the
extremes and may need special attention.

Interface Health Threshold Sleeve Report

The Threshold Sleeve report analyzes how close the metric performance value is to the threshold
levels. In other words, this report enables you to analyze when the metric will reach the threshold.

Using this report, you can:
o Forecast over-utilization or under-utilization of the selected interface.
o Detect if the metric performance is about to cross the high and low thresholds.

For example, if you generate the Threshold Sleeve Chart report for Availability (avg), the chart
displays the how close the average interface availability is to the high and low threshold.

« Save multiple Threshold Sleeve Reports for a specific metric for different time ranges, and
analyze the metric performance trend.

This report supports one metric.

Interface Health Top N Report
The Top N report ranks network elements by the metrics you select. The report enables you to:
o Detect any network interface that is having a health or performance problem.
« Analyze the utilization of the NNMi-managed network interfaces for a specific time range.
¢ Detect over-utilized and under-utilized network interfaces in the network.
o Compare the performance of multiple network interfaces for a single node or multiple nodes.

For example, say that one of the routers in your network is performing poorly. With this report, you
can group the router interfaces that report the highest average error rate. The interface reporting the
highest average error rate is ranked first.

How to Run the Top N Report

Selecting the Top N report in the Reports pane automatically runs the report. The values selected
the previous time the report was run are used. You can change the values with the Options menu
and customize the report. The following report options are available:
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o Top/Bottom'N'

o Select Metric(s):
Display Time Series Chart

¢ Grouping by:
Report Options

Top / Bottom 'N'

You can select from the following:

Ranking Number Description

Top5

Top 10

Top 25

Top 50

Top 100

Bottom 5

Bottom 10

Bottom 25

Bottom 100

Sort All in Descending

Sort All in Ascending

Select Metric(s)
You can select up to six metrics for each metric type over the selected time period. To add a metric,

click '{F._hl Add new grouping. To remove a metric, click P Remove metric.

To select a range of values for the metric, click ‘{F_hl and ¥ Apply Filter, and select a range of metric
values the report should consider. Make sure that the ranges are in one of the following formats:

o Decimal multiplier (for example, 1 to specify 100%, 0.5 to specify 50%, etc.)
« Range with the % (Percentage) symbol (for example, 100%, 50%, etc.)

For example, to see the top five interfaces for node 15.2.103.112, where the average utilization is
between 10% and 90%, type the following ranges:

e 0.10r10% as Lowest Value
e 0.90r90% as the Highest Value
By default, the report groups data by Qualified Interface Name.
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The selected interfaces are ranked according to the value of the first metric listed in the Select
Metric(s) field. You can select any of the metrics listed in the two drop-down boxes. The metrics
you select are displayed along the two Y axes of the resulting chart.

o The selections you make in the left box appear along the left (Y1) axis of the resulting chart.
o The selections you make in the right box appear along the right (Y2) axis.

A number of metrics provide aggregated (avg, max, min, and percentile) values. Percentiles have
the following meaning:

o (pctile05) - 5 percent of samples fall below, and 95 percent fall above.

(
(pctile90) - 90 percent of samples fall below, and 10 percent fall above.
(pctile95) - 95 percent of samples fall below, and 5 percent fall above.
(

pctile99) - 99 percent of samples fall below, and 1 percent fall above.

For a full list of the available metrics, see "List of Metrics".
Display Time Series Chart
Selecting Yes produces a chart that displays the selected metrics along two Y axes.

o The left (Y1) axis displays the performance of the main metric on which you want to generate the
report.

o Theright (Y2) axis displays the performance of the metric that should overlay the main (primary)
metric.

Grouping by:

This option enables you to select a Grouping Attribute. The selections are the following.

Grouping Attribute = Description

Interface Group Name

NodeGroup Name

MPLS L3VPN Name

MPLS VRF Name

Qualified Interface
Name

Interface Name

Interface Alias

Interface Descr

Interface Type

Interface Physical
Address

Interface Speed
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Grouping Attribute Description

(In:Out)

Interface UUID

Interface ODBID

Node Name

Node Short Name

Node Contact

Node Location

Node Family

Node Vendor

Node UUID

Node ODBID

Tenant Name

Tenant UUID

SecGroup Name

SecGroup UUID

Node Annotation

Interface Annotation

You can add another grouping by clicking ‘{F_hl

When your report completes, you can save it as a Report View. To save it, click the Keep this
version drop-down list and select Save as Report View. The Save as report view window opens.
You can specify a name and location. When done, click OK.

Tips:

o Check this report once a day to see which network interface might need special attention.

o Check this report periodically throughout the day to see which network interfaces are performing
at the extremes and might need special attention.

Interface Health Top N Chart Report

The Top N Chart report ranks the interfaces by the metric you select.

You can:

e Spot the interface that performed at the extremes.

o Analyze the historical data for interfaces that are exhibiting unusual utilization levels.
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o Detect the interface having a health or performance problem.
« Analyze the utilization of the NNMi managed interfaces based on a specific time range.
o Detect the over-utilized and under-utilized interfaces in the network.

o Detect the underlying reason of a persistent problem with a interface. You can compare the
performance for multiple interfaces using this report.

Top N Chart Options

The Top N Chart displays the following options:
e Top/ Bottom N

e Metric

o Grouping By

The report tracks up to six metrics over the selected time period.

To add another metric, click Options and the ﬁAdd New Grouping button.

To remove a metric that you already added, click Options and the xRemove Grouping button.

To select a range of value for the metric, click '{F_hl and ", and select a range of metric value the
report should consider. Make sure that the ranges are in one of the following formats:

o Decimal multiplier (for example, 1 to specify 100%, 0.5 to specify 50%, etc.)
« Range with the % (Percentage) symbol (for example, 100%, 50%, etc.)

For example, to see the top five interfaces for node 15.2.103.112, with average utilization between
10% and 90%, type the following ranges:

e 0.10r10% as Lowest Value
e 0.90r90% as the Highest Value

By default, the report groups data by Qualified Interface Name. You can select multiple grouping

attributes with the '{F_bl (Add New Grouping) button. To remove a grouping attribute, use the P
(Remove Grouping) button.

The Top N Chart report displays the selected metrics using two Y axes.

o Theleft Y axis (the Y1 axis) displays the performance of the main metric based on the report you
want to generate.

e Theright Y axis (the Y2 axis) displays the performance of the metric that should overlay the
main (primary) metric.

Tips:
o Check this report once a day to see which interface might need special attention.

o Check this report periodically throughout the day to see which interfaces are performing at the
extremes and might need special attention.
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About Reportlets

In a large enterprise network, the NNM iSPI Performance products (HP NNM iSPI Performance for
Metrics, HP NNM iSPI Performance for Quality Assurance, and HP NNM iSPI Performance for
Traffic) can produce a large amount of data and large cardinality. Enterprise networks often have a
very large number of unique IP addresses, source nodes, destination nodes, virtual circuits,
interfaces, and components that each produce a large amount of data. Generating reports can
therefore be time-consuming.

Reportlets enable you to generate quick impressions of the larger reports using the NNM iSPI
Performance dashboard.

To display the reportlets:
1. Logintothe NPS home page.
2. Onthe left navigation panel, select Dashboard Reportlets.
3. Select an extension pack and a reportlet.

You can also create custom dashboards using the reportlets.

Baseline Metric Snapshot with Range
Displays the aggregated metric performance for the selected time range.

Enables you to:

o Build a performance history for the selected baseline metric and analyze how the metric
performance changes over time.

Such history may help you to select an expected performance level for the metric
o Compare the performance for multiple metrics over a specified time range.

Though you can generate snapshot report for a single metric, you can save the snapshot report
for various metrics and compare the performance of each metric over a time range.

This reportlet supports one metric.

To select a new metric for your reportlet, click E:'Show Toolbar and ifﬂOptions.
Baseline Sleeve Chart

Analyzes how close the metric performance value is to the threshold levels.

Enables you to:

o Detect if the metric performance is about to cross the high and low thresholds.

For example, if you generate the Baseline Sleeve Chart reportlet for Utilization (avg), the chart
displays how many exceptions are raised on average utilization in the past 24 hours,

o Save multiple Sleeve Reports for a time range, and for analyze the trend of performance for the
metric.

This reportlet supports one metric.

To select a new metric for your reportlet, click E:'Show Toolbar and 'ﬁ’ﬂOptions.
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Baseline Sparkline

Evaluates the trend of how the selected baseline metric value has changed for the selected time
range.

Enables you to:
o Analyze the variations in the performance for the selected metric.
o Decide whether the expected behavior for the selected metric should be reassessed.

This reportlet supports one metric.

To select a new metric for your reportlet, click EbShow Toolbar and ifﬂOptions.
Baseline Sparkline with Range

Evaluates the trend of how the selected baseline metric value has changed for the selected time
range.

Enables you to:

o Evaluate the performance trend of the selected metric for the selected time range.

o Compare the present performance trend with the normal (expected) performance range.
o Measure the performance of past 24 hours in percentage.

This reportlet supports one metric.

To select a new metric for your reportlet, click EbShow Toolbar and ifﬂOptions.
Calendar

Displays a comparative study of the selected Primary Metric and Secondary Metric

The default display grain is set to one hour. You cannot change the display grain of this reportlet.
Enables you to monitor the following:

o Daily interface utilization

« Volume of data passed through the interface for past 24 hours

o Performance of the interface for past 24 hours

This reportlet supports two metrics.

To select a new metric for your reportlet, click EbShow Toolbar and WOptions.
Gauge

Evaluates the metric for the selected point of time.

Select only the metrics that displays the percentage values.

Enables you to:
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o Measure the daily performance of the selected metric.
o Detect any abnormal or unexpected performance level.
This reportlet supports one metric.

When the NPS database has no data, the needle icon on the gauge does not appear.

To select a new metric for your reportlet, click E:'Show Toolbar and (l‘fﬂOptions.
Heat Chart

Grades the performance of the selected metric for the selected time range.
The metric performance is aggregated based on an hourly display grain.
Enables you to:

« View how the interface performance gets affected by a varying metric.
o Compare the hourly performance of the selected metric.

o Detect the time range when the interface performance was affected adversely because of the
fluctuating metric value.

This reportlet supports one metric.

To select a new metric for your reportlet, click E:'Show Toolbar and ﬁﬂOptions.
Metric Snapshot

Displays the metric performance for the selected time range.
Enables you to:

o Build a performance history for the selected metric and analyze how the metric performance
changes over time.

Such history may help you to decide the baseline value for the metric
o Compare the performance for multiple metrics over a specified time range.

Though you can generate snapshot report for a single metric, you can save the snapshot report
for various metrics and compare the performance of each metric over a time range.

This reportlet supports one metric.

To select a new metric for your reportlet, click E:'Show Toolbar and WOptions.
Most Changed

Compares the metric performance between the following:

o Selected time range

o Period preceding the selected time range

Aggregates the metric utilization and ranks the performance in a descending order.

Enables you to:
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o Measure the performance fluctuations for the interfaces.

o Detect the top N interfaces having a common performance or utilization problem.
You can enhance the reportlet usability using the following features:

e Top/ Bottom N

¢ Grouping By

This reportlet supports one metric.

To select a new metric for your reportlet, click EbShow Toolbar and ifﬂOptions.

Multimetric Chart
Analyzes the performance trend for the selected metrics for the selected time range.
Enables you to:
o Perform comparative analysis of the selected metrics for each display grain.
The default display grain is one hour.
« Analyze the reason for any ups and downs in the interface performance.
o Detect any persistent problem in the interface performance.

This reportlet supports up to six metrics.

To select a new metric for your reportlet, click EbShow Toolbar and ﬁﬂOptions.
Simple Bar and Line Chart

Displays the trend of interface performance for past 24 hours using the following values:

¢ Primary Metric on the bar chart

e Secondary Metric on the line chart

Enables you to:

o Compare the performance trends of multiple metrics.

« Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports two metrics.
To select a new metric for your reportlet, click EbShow Toolbar and WOptions.
Simple Bar Chart

Compares the performance of two metrics for the selected time range.

Enables you to:
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o Compare the performance trends of multiple metrics.

« Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports two metrics.

To select a new metric for your reportlet, click E:'Show Toolbar and ifﬂOptions.
Simple Chart

Analyzes the utilization trend for the selected metrics for the selected time range.

Enables you to:

o Perform comparative analysis of the selected metrics for each display grain.
The default display grain is one hour.

¢ Analyze the reason for any ups and downs in the interface performance.

o Detect any persistent problem in the interface performance.

This reportlet supports two metrics.

To select a new metric for your reportlet, click E:'Show Toolbar and 'ﬁ’ﬂOptions.
Simple Table

Analyzes the utilization trend for the selected metrics for the selected time range.
The default display grain is one hour.

Enables you to:

¢ Analyze the hourly performance of the metrics.

o Detect any abnormal or unexpected interface performance.

« Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports up to six metrics.
To select a new metric for your reportlet, click E:'Show Toolbar and ifﬂOptions.
Sparkline

Evaluates the trend of how the selected metric value has changed for the selected time range.
Enables you to:

o Analyze the variations in the performance for the selected metric.

o Decide whether the expected behavior for the selected metric should be reassessed.

This reportlet supports one metric.

To select a new metric for your reportlet, click E:'Show Toolbar and ﬁﬂOptions.
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Threshold Sleeve Chart

Analyzes how close the metric performance value is to the threshold levels.
Enables you to:
o Detect if the metric performance is about to cross the high and low thresholds.

For example, if you generate the Exception Sleeve Chart reportlet for Utilization (avg), the chart
displays how many exceptions are raised on average utilization in the past 24 hours,

o Save multiple Sleeve Reports for a time range, and for analyze the trend of performance for the
metric.

This reportlet supports one metric.

To select a new metric for your reportlet, click E:'Show Toolbar and ﬁﬂOptions.

Top N Chart

Ranks the individual contribution of each metric for the interface performance for the selected time
range.

The performance of the interface is aggregated on hourly basis.

Enables you to:

o Spot the interfaces for which the performance metrics present extreme values.

o Investigate the aggregated data for the interfaces that are exhibiting unusual utilization levels.

o Select the metric based on which you want to generate the report. The metric that you select is
used to rank the interfaces.

o Group the report data based on a specific parameter. To add a subgroup, click the ﬁAdd New
Grouping button.

This reportlet supports one metric.

To select a new metric for your reportlet, click E:'Show Toolbar and ifﬂOptions.
Top N Line Chart

Ranks the utilization trend for the selected metrics for the selected time range.

The performance of the interface is aggregated on hourly basis.

Enables you to:

o Spot the interfaces for which the performance metrics present extreme values.

¢ Investigate the aggregated data for the interfaces that are exhibiting unusual utilization levels.

o Select the metric based on which you want to generate the report. The metric that you select is
used to rank the interfaces.

o Group the report data based on a specific parameter. Click '{F_hl Add Group to add a subgroup.

This reportlet supports one metric.
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To select a new metric for your reportlet, click E:'Show Toolbar and 'ﬁ’ﬂOptions.

Top N Stacked Chart

Ranks the individual contribution of each interface based on the selected metrics.

The performance of each interface is aggregated for the default display grain of one hour.
Enables you to:

o Spot the interfaces for which the performance metrics present extreme values.

o Investigate the aggregated data for the interfaces that are exhibiting unusual utilization levels.
o Detect the network path having a com m on network performance problem.

This reportlet supports up to six metrics.

To select a new metric for your reportlet, click E:'Show Toolbar and ﬁﬂOptions.

Top N Table

Ranks the interfaces based on the selected metric.

Enables you to:

o Spot the interfaces for which the performance metrics present extreme values.
« Investigate the aggregated data for the interfaces that are exhibiting unusual utilization levels.

o Select the metric based on which you want to generate the report. The metric that you select is
used to rank the interfaces.

o Group the report data based on a specific parameter. Click '{F_bl Add Group to add a subgroup.

This reportlet supports up to six metrics.

To select a new metric for your reportlet, click E:'Show Toolbar and ﬁﬂOptions.

Top N Table with Bars

Ranks the interfaces based on the selected metric and displays a horizontal bar to depict the
aggregated metric value.

Enables you to:

o Spot the interfaces for which the performance metrics present extreme values.
« Investigate the aggregated data for the interfaces that are exhibiting unusual utilization levels.

o Select the metric based on which you want to generate the report. The metric you select is used
torank the interfaces.

o Group the report data based on a specific parameter. To add a subgroup, click the ﬁAdd New
Grouping button.

This reportlet supports up to six metrics.

To select a new metric for your reportlet, click E:'Show Toolbar and ﬁﬂOptions.
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Calculating Availability

AvailabilityPct (Avg%, Min%, Max%) represents the average availability of all samples. NNMi
calucates this metric using multiple values including but not limited to ifOperStatus and
ifAdminStatus.

Calculating Availability for Interfaces
Scenario 1
An interface is considered available, when:
o The agent is reachable and the following conditions are met:
= HP NNM iSPI Performance for Metrics receives polled data from the agent.
= The polled data confirms that the ifOperStatus and ifAdminStatus are up.

o The agent is not reachable; that is, the agent did not respond to the performance query but the
following conditions are met:
= HP NNMiSPI Performance for Metrics does not receive polled data from the agent.

= The polled data confirms that 1 fOperStatus and 1 fAdminStatus are up.
= NNMi has determined that the device SNMP agent is responding.

Scenario 2

An interface is considered unavailable when:

o The agent is reachable and the following conditions are met:
= HP NNMiSPI Performance for Metrics receives polled data from the agent.
= The polled data confirms that 1 fOperStatus is down.
= The polled data confirms that 1 fAdminStatus is up.

o The agent is not reachable; that is the agent did not respond to the performance query and the
following conditions are met:

= HP NNMiSPI Performance for Metrics does not receive polled data from the agent.
= NNMi has determined that the device SNMP agent is not responding.

« The agent is not reachable; that is, the agent did not respond to the performance query and the
following conditions are met:

= HP NNMiSPI Performance for Metrics does not receive polled data from the agent.
= The polled data confirms that 1 fOperStatus is down.
= The polled data confirms that 1 fAdminStatus is up.
= NNMi has determined that the device SNMP agent is not responding.
Scenario 3

A sample is not considered for reporting, when:
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e ifAdminStatus is down.
¢ You configure NNMi not to poll the interface for 1 fAdminStatus and i fOperStatus.

¢ You manually configure a device or an interface as Out of Service or Unmanaged.
Calculating AvailabilityPct

HP NNM iSPI Performance for Metrics calculates the number of seconds for the metric
AvailabilityPct as equal to the polling interval if 1 fOperStatus for the interface is Up.

Availability percent for a given interface over a specific time range is calculated using the following
formula:

100 * (Total Available Seconds / Total Polling Interval in Seconds)

If i foperStatus for the interface is down, the number of seconds for the AvailabilityPct metric is
considered as 0 (zero) for the sample.

Example

o Ifaninterface is unavailable for 15 minutes and available for 45 minutes in an hour, the
AvailabilityPct (avg) for that hour will be 75%.

o A node has two interfaces. Interface1 is available for the whole hour, and Interface2 is
unavailable for the whole hour. The AvailabilityPct (avg) for the node would be 50% for that hour.

Availability Exceptions

Depicts the number of availability exceptions.

NNMi raises an availability exception for a sample when interface availability decreases below a
preset threshold.

Availability Exception Aggregation Rule

o Availability Exceptions (sum): The total number of samples that are marked as exceptions. In
other words, it depicts the number of samples where an interface was unavailable.

o Availability Exceptions (%Avg, %Max, %Min): The percentage of samples that are marked as
exceptions. For example, if five samples out of 100 samples are marked as exceptions,
Availability - Exception Rate (avg) will be 5%.
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Glossary of Basic Metrics

Metric Description

countDistinct Metrics The countDistinct metrics are provided only by the
Interface Health Extension Pack. They track the number
of interfaces over a period of time. You can use a
countDistinct metric on a report with a topology filter
selection to track the number of interfaces that belong to
the selected topology group.

For example, if you select the Qualified Interface Name
metric with the topology filter selection of a particular
Interface Group, you can track the number of interfaces
that belong to the selected group from the generated
report.

Some of the available countDistinct metrics are:
¢ Qualified Interface Name
¢ Interface Name

¢ Interface Alias

¢ Interface Descr

¢ Interface Index

o Interface Type

o Interface Physical address
o Interface Speed (In:Out)

o Interface ID

o Interface UUID

¢ Node Name

¢ Node Contact

¢ Node Location

o Node Family

¢ Node Vendor

e NodelD

e Node UUID

Discard Exceptions Number of packet discard exceptions; percentage of

. . samples above the discard exception threshold.
o Discard Exceptions (sum)

o Discard Exceptions (Y%esamples)

Discards - Packets Total number of discarded packets, in and out combined,
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o Discards Packets (sum) followed by the number of discarded incoming packets

« Discards Packets In (sum) and the number of discarded outbound packets.

o Discards Packets Out (sum)

Discard Rate Total number of packets with discards as a percentage of
total packets (minimum, maximum, and average);
followed by the number of discarded packets incoming,

e Discard Rate - Lower Threshold as a percentage of total incoming packets (minimum,
maximum, and average), and the number of discarded
packets outbound, as a percentage of total outbound
packets (minimum, maximum, and average).

o Discard Rate (avg, min, and max)

e Discard Rate - Threshold
Exception Count

e Discard Rate - Threshold
Exception Rate

o Discard Rate - Upper Threshold

o Discard Rate In (avg, min, and
max)

e Discard Rate In - Lower
Threshold

o Discard Rate In- Threshold
Exception Count

e Discard Rate In - Discount
Exception Rate

o Discard Rate In - Upper
Threshold

o Discard Rate Out (avg, min, and
max)

Error Exceptions Number of packet error exceptions; percentage of

) samples above the error exception threshold.
o Error Exceptions (#samples)

o Error Exceptions (%samples)

Error Rate Total number of packets with errors as a percentage of
total packets; followed by number of packets with errors
received as a percentage of total packets received, and
o Error Rate (min) number of packets with errors transmitted, as a
percentage of total packets transmitted.

o Error Rate (avg)

o Error Rate (max)
o Error Rate - Lower Threshold

o Error Rate - Threshold Exception
Count
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Metric Description

o Error Rate - Threshold Exception
Rate

o Error Rate - Upper Threshold

o ErrorRate In (avg)

¢ Error Rate In (min)

o Error Rate In (max)

o Error Rate In - Lower Threshold

e Error Rate In - Threshold
Exception Count

e Error Rate In - Threshold
Exception Rate

o Error Rate In - Upper Threshold

o Error Rate Out (avg)

o Error Rate Out (min)

o Error Rate Out (max)

o Error Rate Out - Lower Threshold

o Error Rate Out - Threshold
Exception Count

e Error Rate Out - Threshold
Exception Rate

o Error Rate Out - Upper Threshold

Errors
o Errors - Packets (sum)
o Errors - Packets In (sum)

o Errors - Packets Out (sum)

Total number of packets with errors, in and out combined;
number of incoming packets with errors; number of
outbound packets with errors.

Period - Length (secs) (sum)

The duration (in seconds) between consecutive polling
cycles of NNMi.

Sample Count

Number of polled samples

e Throughput In (bps)
e Throughput Out (bps)

SNMP Response Time SNMP Response Time (msec) (avg, min, max): time for
interface/device to respond to polling request
Throughput (bps) o Total throughput on the interface (in bits-per-second):

= Throughput (bps) (avg)
= Throughput (bps) (min)
= Throughput (bps) (max)
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Metric Description

o Incoming throughput on the interface (in bits-per-
second):
= Throughput In (bps) (avg)

= Throughput In (bps) (min)
= Throughput In (bps) (max)

¢ Outgoing throughput on the interface (in bits-per-
second):
= Throughput Out (bps) (avg)

= Throughput Out (bps) (min)
= Throughput Out (bps) (max)

Utilization - avg% Average utilization from any sample
o Utilization (avg)
o Utilization In (avg)

o Utilization Out (avg)

Utilization - max% Maximum utilization in (the largest value from any
Utilizati sample); maximum utilization out (the largest value from

. ilization (max) any sample)

o Utilization In (max)

o Utilization Out (max)

Utilization - min% Minimum utilization in (the smallest value from any
Utilizati ) sample); minimum utilization out (the smallest value from

. ilization (min) any sample)

¢ Utilization In (min)

o Utilization Out (min)

Utilization Exceptions Number of exceptions; percentage of samples above or

e . below the threshold range set in NNMi.
o Utilization Exceptions (sum)

o Utilization Exceptions

(Y%osamples)
Volume Total number of data packets or bytes passing through
o Volume - Packets (sum) the network

o Volume - Packets In (sum)

¢ Volume - Packets Out (sum)
e Volume -Bytes (sum)

¢ Volume - Bytes In (sum)

o Volume - Bytes Out (sum)

Page 197 of 230 HP Network Node Manager iSPI Performance for Metrics Software (9.20)



Online Help
Contents

Metric Types

The Interface Health extension pack provides the following types of metrics.

Metric Description

Gauge Metrics with single non-cumulative values.

For example: SNMP Response Time, Throughput (bps). The iSPI Performance for
Metrics calculates the average, minimum, and maximum values while aggregating
the values of gauge metrics.

Percent Metrics with single non-cumulative percentage values.

For example: Discards Rate, Error Rate. The iSPI Performance for Metrics
calculates the average, minimum, and maximum values while aggregating the
values of percent metrics.

Counter Metrics that have incremental values.

For example: Volume - Bytes, Volume - Packets. HP NNM iSPI Performance for
Metrics calculates the sum while aggregating the values of counter metrics.

Exceptions | The count or percentage of samples that are out of the threshold boundary defined
in NNMi.

To use exception metrics, you must set the thresholds in NNMi by following the
instructions in the "Configure Threshold Monitoring for Interfaces" section of the
HP Network Node Manager i Software Online Help for Administrators.

The Exception (sum) metrics indicate the count of samples that are outside of the
threshold boundary (depends on the polling interval).

The Exception (Avg%, Max%, Min%) metrics indicate the percentage of samples
outside of the threshold boundary (independent of the polling interval).

Glossary of LAN Metrics

Available for the following:
o ETHERLIKE -MIB
e OLD-CISCO-INTERFACES-MIB

Metric Description

LAN FCS Error Count Number of frames received on the selected interface that
s consist of the necessary number of octets in length but

s Sum do not pass the FCS check.

* Average This count does not include the frames received with any

e Minimum of the following errors:

¢ Maximum o frame-too-long

o frame-too-short
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o Baseline Average (avg) The count of LAN FCS error increases when the

MAC service returns a frameCheckError to the LLC or

« Baseline Deviation (avg) another MAC user

o Sl
Slope (avg) NNMi enables you to define an upper and a lower
o Upper Normal (max) thresholds for the count of FCS WLAN Errors.

e Lower Normal (min) See the NNMi Online Help for Administrators for
information about how to define thresholds using the

* Days ToThreshold (min) Threshold Configuration form.

o Baseline Exception Count (sum)
o Baseline Exception Rate (avg)

o Baseline Intercept Component
(avg)

« Baseline Trend Component (avg)

o Baseline Seasonal Component
(avg)

o Anomaly Sample Flags Window
(sum)

o Baseline Linear Samples Used
(avg)

o Baseline Seasonal Samples
Used (avg)

o Upper Threshold (max)
o Lower Threshold (min)
e Threshold Exception Count (sum)

e Threshold Exception Rate (avg)

LAN Collision Count (sum) Number of output collisions detected on the selected
interface

LAN Collision Rate Percentage of output collisions detected on the selected
interface for the selected time range

o Average

- Calculated using any of the following methods based on

e Minimum )
the interface type:

¢ Maximum

e ((100.0 * collisonsOut Number of
output collisions detected on the
selected interface for the selected
time range) / (1fHCOutUcastPkts Number
of packets that higher-level protocols
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Metric Description

requested be transmitted, and which

were not addressed to a multicast or
broadcast address at the sub-layer for
the selected interface. These include
those packets that were discarded or
not sent. + ifHCOutMulticastPkts
Number of packets transmitted to a
multicast address per second during
the selected time range +
ifHCOutBroadcastPkts Number of packets
transmitted to a broadcast address per
second during the selected time range)

e ((100.0 * collisonsOut) /
(1fOutUcastPkts Number of packets that
higher-level protocols requested be
transmitted, and which were not
addressed to a multicast or broadcast
address at the sub-layer for the
selected interface. These include
those packets that were discarded or
not sent. + 1fOutNUcastPkts Number of
packets that higher-level protocols
requested be transmitted to a non-
unicast (i.e., a subnet roadcast or
subnet multicast) address. These
include the packets that were
discarded or not sent.)

e ((100.0 * collisonsOut) /
(1fOutUcastPkts + ifOutMulticastPkts +
ifOutBroadcastPkts)

LAN Deferred Frames (sum) Total number of frames for which the first transmission
attempt on the selected interface is delayed because the
medium is busy

The count does not include the following:
e Frames involved in collisions
o Interfaces that are operating in full-duplex mode

o Frames delayed because of discontinuities in the
management system

LAN Alignment Errors (sum) Total number of input packets that had cyclic redundancy
checksum errors

Input Queue Drops Number of packets the selected interface dropped
because the input queue was full
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e Sum NNMi enables you to define an upper and a lower

« Baseline Average (avg) thresholds for the count of input queue drops.

See the NNMi Online Help for Administrators for
information about how to define thresholds using the
o Baseline Slope (avg) Threshold Configuration form.

o Baseline Deviation (avg)

e Upper Normal (max)

o Lower Normal (min)

o Days To Threshold (min)

o Baseline Exception Count (sum)
o Baseline Exception Rate (avg)

o Baseline Intercept Component
(avg)

o Baseline Trend Component (avg)

o Baseline Seasonal Component
(avg)

¢ Anomaly Sample Flags Window
(sum)

o Baseline Linear Samples Used
(avg)

o Baseline Seasonal Samples
Used (avg)

o Upper Threshold (max)
o Lower Threshold (min)
e Threshold Exception Count (sum)

e Threshold Exception Rate (avg)

Output Queue Drops Number of packets the selected interface dropped

because the output queue was full
e Sum

Baseline A NNMi enables you to define an upper and a lower
« Baseline Average (avg) thresholds for the count of output queue drops.
« Baseline Deviation (avg) See the NNMi Online Help for Administrators for

o Baseline Slope (avg) information about how to define thresholds using the
Threshold Configuration form.

o Upper Normal (max)

o Lower Normal (min)

o Days To Threshold (min)

o Baseline Exception Count (sum)
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Metric Description

(avg)

(avg)

(sum)

(avg)

Used (avg)
o Upper Threshold (max)

o Lower Threshold (min)

o Baseline Exception Rate (avg)

o Baseline Intercept Component

o Baseline Trend Component (avg)

o Baseline Seasonal Component

¢ Anomaly Sample Flags Window

o Baseline Linear Samples Used

o Baseline Seasonal Samples

e Threshold Exception Count (sum)

e Threshold Exception Rate (avg)

Note:The ETHERLIKE-MIB polling policies override the OLD-CISCO-INTERFACES-MIB polling
policies, if the selected interface supports both ETHERLIKE-MIB and OLD-CISCO-
INTERFACES-MIB, and thus both State Poller policies.

Glossary of Polling Metrics

Metric Description

Target Error (avg)

Generated if the target interface returns any of the following SNMP
error responses:

o Authentication error
o Nosuchname

o No such object.

Reboot (avg)

Generated if the target interface was restarted during the poll and
no data could be retrieved from the interface.

NNMi checks the sysUptime metric to determine whether the
interface was restarted during the last poll.

Invalid Data (avg)

Generated when NNMi has successfully polled data from the
target, but has determined that the data is invalid. For example, this
metric is calculated when the number of packets is greater than the
number of octets.

Unresponsive Target (avg)

Generated when the SNMP agent did not respond when collecting
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metrics for a particular polling policy.

Glossary of SDH DS1 Metrics

Available only for DS1 Interfaces

Metric Description

DSx1SESs Rate | Rate of Severely Errored Seconds encountered by the selected DS1
interface in one second.

e Average
. The object returns the total number of Severely Errored Seconds encountered
e Minimum ; . .
by the interface in past 15 minutes.
o Maxi
aximum NPS calculates the rate of Severely Errored Seconds per second.
NPS calculates the metric to display average, minimum, and maximum rate
of Severely Errored Seconds encountered by the selected interface.
DSx1SEFSs Rate of Severely Errored Framing Seconds encountered by the selected DS1
Rate interface in one second.
e Average The object returns the total number of Severely Errored Framing Seconds
. encountered by the interface in past 15 minutes.
e Minimum
. NPS calculates the rate of Severely Errored Framing Seconds per second.
e Maximum

NPS calculates the metric to display average, minimum, and maximum rate
of Severely Errored Framing Seconds encountered by the selected interface.

DSx1ESs Rate [ Rate of Errored Seconds encountered by the selected DS1 interface in one

second.
e Average
- The object returns the total number of Errored Seconds encountered by the
e Minimum . . .
interface in past 15 minutes.
¢ Maximum

NPS calculates the rate of Errored Seconds per second.

NPS calculates the metric to display average, minimum, and maximum rate
of Errored Seconds encountered by the selected interface.

DSx1UASs Rate | Rate of Unavailable Seconds encountered by the selected DS1 interface in

one second.
e Average
. The object returns the total number of Errored Seconds encountered by the
e Minimum . . .
interface in past 15 minutes.
¢ Maximum

NPS calculates the rate of Errored Seconds per second.

NPS calculates the metric to display average, minimum, and maximum rate
of Errored Seconds encountered by the selected interface.

DSx1PCVs/sec | Rate of Path Coding Violations encountered by the selected DS1 interface in

one second.
o Average

The object returns the total number of Path Coding Violations encountered by
the interface in past 15 minutes.
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e Minimum

o Maximum

NPS calculates the rate of Path Coding Violations per second.

NPS calculates the metric to display average, minimum, and maximum rate
of Path Coding Violations encountered by the selected interface.

DSx1DMs Rate
e Average
e Minimum

¢ Maximum

Rate of Degraded Minutes encountered by the selected DS1 interface in one
second.

The object returns the total number of Degraded Minutes encountered by the
interface in past 15 minutes.

NPS calculates the rate of Degraded Minutes per second.

NPS calculates the metric to display average, minimum, and maximum rate
of Degraded Minutes encountered by the selected interface.

DSx1BESs Rate
o Average
e Minimum

¢ Maximum

Rate of Bursty Errored Seconds encountered by the selected DS1 interface
in one second.

The object returns the total number of Bursty Errored Seconds encountered
by the interface in past 15 minutes.

NPS calculates the rate of Bursty Errored Seconds per second.

NPS calculates the metric to display average, minimum, and maximum rate
of Bursty Errored Seconds encountered by the selected interface.

DSx1LESs Rate

Rate of Line Errored Seconds encountered by the selected DS1 interface in
one second.

o Average
. The object returns the total number of Line Errored Seconds encountered by
e Minimum . . )
the interface in past 15 minutes.
* Maximum NPS calculates the rate of Line Errored Seconds per second.
NPS calculates the metric to display average, minimum, and maximum rate
of Line Errored Seconds encountered by the selected interface.
DSx1LCVs/sec | Rate of Line Coding Violations encountered by the selected DS1 interface in
one second.
e Average
. The object returns the total number of Line Coding Violations encountered by
e Minimum . . .
the interface in past 15 minutes.
* Maximum NPS calculates the rate of Line Coding Violations per second.
NPS calculates the metric to display average, minimum, and maximum rate
of Line Coding Violations encountered by the selected interface.
DSx1CSSs Rate | Rate of Controlled Slip Seconds encountered by the selected DS1 interface
in one second.
e Average
. The object returns the total number of Controlled Slip Seconds encountered
e Minimum ; . .
by the interface in past 15 minutes.
e Maximum

NPS calculates the rate of Controlled Slip Seconds per second.
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Metric

Description

NPS calculates the metric to display average, minimum, and maximum rate
of Controlled Slip Seconds encountered by the selected interface.

Glossary of SDH DS3 Metrics

Available only for DS3 Interfaces

Metric Description

DSx3PCVs/sec | Count of Path Coding Violations encountered by the selected DS3 interface
in one second.
e Average
. The object returns the total number of Path Coding Violations encountered by
e Minimum . . .
the interface in past 15 minutes.
* Maximum NPS calculates the total number of Path Coding Violations per second.
NPS calculates the metric to display average, minimum, and maximum
number of Path Coding Violations encountered by the selected interface.
DSx3LESs Rate | Rate of Line Errored Seconds encountered by the selected DS3 interface in
one second.
e Average
. The object returns the total number of Line Errored Seconds encountered by
e Minimum . . .
the interface in past 15 minutes.
o Maxi
aximum NPS calculates the percentage of Line Errored Seconds per second.
NPS calculates the metric to display average, minimum, and maximum rate
of Line Errored Seconds encountered by the selected interface.
DSx3LCVs/sec | Count of Line Coding Violations encountered by the selected DS3 interface in
one second.
e Average
. The object returns the total number of Line Coding Violations encountered by
e Minimum . . .
the interface in past 15 minutes.
o Maxi
aximum NPS calculates the total number of Line Coding Violations per second.
NPS calculates the metric to display average, minimum, and maximum
number of Line Coding Violations encountered by the selected interface.
DSx3CCVs/sec | Count of C-bit Coding Violations encountered by the selected DS3 interface
in one second.
e Average
. The object returns the total number of C-bit Coding Violations encountered by
e Minimum . . .
the interface in past 15 minutes.
o Maxi
aximum NPS calculates the number of C-bit Coding Violations per second.
NPS calculates the metric to display average, minimum, and maximum
number of C-bit Coding Violations encountered by the selected interface.
DSx3SEFSs Rate of Severely Errored Framing Seconds encountered by the selected DS3
Rate interface in one second.
Page 205 of 230 HP Network Node Manager iSPI Performance for Metrics Software (9.20)



Online Help
Contents

Metric Description

e Average The object returns the total number of Severely Errored Framing Seconds
. encountered by the interface in past 15 minutes.
e Minimum
. NPS calculates the percentage of Severely Errored Framing Seconds per
e Maximum
second.
NPS calculates the metric to display average, minimum, and maximum rate
of Severely Errored Framing Seconds encountered by the selected interface.
DSx3CSESs Rate of C-bit Severely Errored Seconds encountered by the selected DS3
Rate interface in one second.
e Average The object returns the total number of C-bit Severely Errored Seconds
. encountered by the interface in past 15 minutes.
e Minimum
Maxi NPS calculates the percentage of C-bit Severely Errored Seconds per
e Maximum
second.
NPS calculates the metric to display average, minimum, and maximum rate
of C-bit Severely Errored Seconds encountered by the selected interface.
DSx3PESs Rate | Rate of P-bit Errored Seconds encountered by the selected DS3 interface in
one second.
e Average
- The object returns the total number of P-bit Errored Seconds encountered by
e Minimum . . .
the interface in past 15 minutes.
Maxi
¢ Maximum NPS calculates the percentage of P-bit Errored Seconds per second.
NPS calculates the metric to display average, minimum, and maximum rate
of P-bit Errored Seconds encountered by the selected interface.
DSx3PSESs Rate of P-bit Severely Errored Seconds encountered by the selected DS3
Rate interface in one second.
e Average The object returns the total number of P-bit Severely Errored Seconds
- encountered by the interface in past 15 minutes.
e Minimum
. NPS calculates the percentage of P-bit Severely Errored Seconds per
¢ Maximum
second.
NPS calculates the metric to display average, minimum, and maximum rate
of P-bit Severely Errored Seconds encountered by the selected interface.
DSx3UASs Rate | Rate of Unavailable Seconds encountered by the selected DS3 interface in
one second.
o Average
- The object returns the total number of Errored Seconds encountered by the
e Minimum . . .
interface in past 15 minutes.
* Maximum NPS calculates the percentage of Errored Seconds per second.
NPS calculates the metric to display average, minimum, and maximum rate
of Errored Seconds encountered by the selected interface.
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DSx3CESs Rate
e Average
e Minimum

e Maximum

Rate of C-bit Errored Seconds encountered by the selected DS3 interface in
one second.

The object returns the total number of C-bit Errored Seconds encountered by
the interface in past 15 minutes.

NPS calculates the percentage of C-bit Errored Seconds per second.

NPS calculates the metric to display average, minimum, and maximum rate
of C-bit Errored Seconds encountered by the selected interface.

Glossary of SONET/SDH Metrics

Available only for SONET/SDH Interfaces

Metric Description

e Average
e Minimum

e Maximum

SonetSectionESs Rate Rate of Errored Seconds encountered by the selected

SONET/SDH Section interface in one second.

The object returns the total number of Errored Seconds
encountered by the SONET/SDH Section interface in past 15
minutes.

NPS calculates the rate of Errored Seconds per second.

NPS calculates the metric to display average, minimum, and
maximum rate of Errored Seconds encountered by the selected
SONET/SDH Section interface.

o Average
e Minimum

¢ Maximum

SonetSectionSESs Rate Rate of Severely Errored Seconds encountered by the selected

SONET/SDH Section interface in one second.

The object returns the total number of Severely Errored Seconds
encountered by the SONET/SDH Section interface in past 15
minutes.

NPS calculates the rate of Severely Errored Seconds per second.

NPS calculates the metric to display average, minimum, and
maximum rate of Severely Errored Seconds encountered by the
selected SONET/SDH Section interface.

SonetSectionSEFSs Rate | Rate of Severely Errored Framing Seconds encountered by the

selected SONET/SDH Section interface in one second.

e Average
Mini The object returns the total number of Severely Errored Framing

* Minimum Seconds encountered by the SONET/SDH Section interface in

o Maximum past 15 minutes.
NPS calculates the rate of Severely Errored Framing Seconds per
second.
NPS calculates the metric to display average, minimum, and
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maximum rate of Severely Errored Framing Seconds encountered
by the selected SONET/SDH Section interface.
SonetSectionCVs/sec Rate of Coding Violations encountered by the selected
SONET/SDH Section interface in one second.
e Average
Mini The object returns the total number of Coding Violations
o Vinimum encountered by the SONET/SDH Section interface in past 15
e Maximum minutes.
NPS calculates the rate of Coding Violations per second.
NPS calculates the metric to display average, minimum, and
maximum rate of Coding Violations encountered by the selected
SONET/SDH Section interface.
SonetLineESs Rate Rate of Errored Seconds encountered by the selected
SONET/SDH Line interface in one second.
e Average
Minimum The object returns the total number of Errored Seconds
° u encountered by the SONET/SDH Line interface in past 15 minutes.
* Maximum NPS calculates the rate of Errored Seconds per second.
NPS calculates the metric to display average, minimum, and
maximum rate of Errored Seconds encountered by the selected
SONET/SDH Line interface.
SonetLineSESs Rate Rate of Severely Errored Seconds encountered by the selected
SONET/SDH Line interface in one second.
o Average
Minimum The object returns the total number of Severely Errored Seconds
¢ Vinimu encountered by the SONET/SDH Line interface in past 15 minutes.
* Maximum NPS calculates the rate of Severely Errored Seconds per second.
NPS calculates the metric to display average, minimum, and
maximum rate of Severely Errored Seconds encountered by the
selected SONET/SDH Line interface.
SonetLineUASs Rate Rate of Unavailable Seconds encountered by the selected
SONET/SDH Line interface in one second.
e Average
Mini The object returns the total number of Unavailable Seconds
o Vinimum encountered by the SONET/SDH Line interface in past 15 minutes.
o Maxi
aximum NPS calculates the rate of Unavailable Seconds per second.
NPS calculates the metric to display average, minimum, and
maximum rate of Unavailable Seconds encountered by the
selected SONET/SDH Line interface.
SonetFarEndLineESs Rate | Rate of Far End Errored Seconds encountered by the selected
SONET/SDH Medium/Section/Line interface in one second.
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e Average The object returns the total number of Far End Errored Seconds
. encountered by the SONET/SDH Medium/Section/Line interface in

e Minimum .
past 15 minutes.

* Maximum NPS calculates the rate of Far End Errored Seconds per second.
NPS calculates the metric to display average, minimum, and
maximum rate of Far End Errored Seconds encountered by the
selected SONET/SDH Medium/Section/Line interface.

SonetFarEndLineSESs Rate of Far End Severely Errored Seconds encountered by the

Rate selected SONET/SDH Medium/Section/Line interface in one
second.

e Average

« Minimum The object returns the total number of Far End Severely Errored
Seconds encountered by the SONET/SDH Medium/Section/Line

e Maximum interface in past 15 minutes.

NPS calculates the rate of Far End Severely Errored Seconds per
second.

NPS calculates the metric to display average, minimum, and
maximum rate of Far End Severely Errored Seconds encountered
by the selected SONET/SDH Medium/Section/Line interface.

SonetFarEndLineCVs/sec

Rate of Far End Coding Violations encountered by the selected
SONET/SDH Medium/Section/Line interface in one second.

e Average
Minimum The object returns the total number of Far End Coding Violations
¢ Vinimu encountered by the SONET/SDH Medium/Section/Line interface in
o Maximum past 15 minutes.
NPS calculates the rate of Far End Coding Violations per second.
NPS calculates the metric to display average, minimum, and
maximum rate of Far End Coding Violations encountered by the
selected SONET/SDH Medium/Section/Line interface.
SonetFarEndLineUASs Rate of Far End Unavailable Seconds encountered by the selected
Rate SONET/SDH Medium/Section/Line interface in one second.
e Average The object returns the total number of Far End Unavailable
. Seconds encountered by the SONET/SDH Medium/Section/Line
e Minimum . . .
interface in past 15 minutes.
e Maximum

NPS calculates the rate of Far End Unavailable Seconds per
second.

NPS calculates the metric to display average, minimum, and
maximum rate of Far End Unavailable Seconds encountered by the
selected SONET/SDH Medium/Section/Line interface.

SonetPathESs Rate

Rate of Errored Seconds encountered by the selected
SONET/SDH Path interface in one second.
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e Average The object returns the total number of Errored Seconds
. encountered by the SONET/SDH Path interface in past 15
e Minimum .
minutes.
e Maximum

NPS calculates the rate of Errored Seconds per second.

NPS calculates the metric to display average, minimum, and
maximum rate of Errored Seconds encountered by the selected
SONET/SDH Path interface.

SonetPathSESs Rate

Rate of Severely Errored Seconds encountered by the selected
SONET/SDH Path interface in one second.

e Average

o Minimum The object returns the total number of Severely Errored Seconds
encountered by the SONET/SDH Path interface in past 15

¢ Maximum minutes.
NPS calculates the rate of Severely Errored Seconds per second.
NPS calculates the metric to display average, minimum, and
maximum rate of Severely Errored Seconds encountered by the
selected SONET/SDH Path interface.

SonetPathCVs/sec Rate of Coding Violations encountered by the selected
SONET/SDH Path interface in one second.

o Average

« Minimum The object returns the total number of Coding Violations
encountered by the SONET/SDH Path interface in past 15

¢ Maximum minutes.

NPS calculates the rate of Coding Violations per second.

NPS calculates the metric to display average, minimum, and
maximum rate of Coding Violations encountered by the selected
SONET/SDH Path interface.

SonetPathUASs Rate

Rate of Unavailable Seconds encountered by the selected
SONET/SDH Path interface in one second.

e Average
Mini The object returns the total number of Unavailable Seconds

o Vinimum encountered by the SONET/SDH Path interface in past 15

e Maximum minutes.
NPS calculates the rate of Unavailable Seconds per second.
NPS calculates the metric to display average, minimum, and
maximum rate of Unavailable Seconds encountered by the
selected SONET/SDH Path interface.

SonetFarEndPathESs Rate of Far End Errored Seconds encountered by the selected

Rate SONET/SDH Path interface in one second.

e Average The object returns the total number of Far End Errored Seconds

encountered by the SONET/SDH Path interface in past 15
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e Minimum minutes.

e Maximum NPS calculates the rate of Far End Errored Seconds per second.
NPS calculates the metric to display average, minimum, and
maximum rate of Far End Errored Seconds encountered by the
selected SONET/SDH Path interface.

SonetFarEndPathSESs Rate of Far End Severely Errored Seconds encountered by the

Rate selected SONET/SDH Path interface in one second.

e Average The object returns the total number of Far End Severely Errored

o Seconds encountered by the SONET/SDH Path interface in past

e Minimum .

15 minutes.
e Maximum

NPS calculates the rate of Far End Severely Errored Seconds per
second.

NPS calculates the metric to display average, minimum, and
maximum rate of Far End Severely Errored Seconds encountered
by the selected SONET/SDH Path interface.

SonetFarEndPathCVs/sec

Rate of Far End Coding Violations encountered by the selected
SONET/SDH Path interface in one second.

e Average
Minimum The object returns the total number of Far End Coding Violations
* vinimu encountered by the SONET/SDH Path interface in past 15
e Maximum minutes.
NPS calculates the rate of Far End Coding Violations per second.
NPS calculates the metric to display average, minimum, and
maximum rate of Far End Coding Violations encountered by the
selected SONET/SDH Path interface.
SonetFarEndPathUASs Rate of Unavailable Seconds encountered by the selected
Rate SONET/SDH Path interface in one second.
e Average The object returns the total number of Unavailable Seconds
. encountered by the SONET/SDH Path interface in past 15
e Minimum .
minutes.
e Maximum

NPS calculates the rate of Unavailable Seconds per second.

NPS calculates the metric to display average, minimum, and
maximum rate of Unavailable Seconds encountered by the
selected SONET/SDH Path interface.
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Glossary of Packet Type Count Metrics

Metric Description

NonUnicast - Packets (sum)

Total number of packets received and sent by the
interfaces using the non-unicast protocol

NonUnicast - Packets In (sum)

Total number of packets received by the interfaces using
the non-unicast protocol

NonUnicast - Packets Out (sum)

Total number of packets sent by the interfaces using the
non-unicast protocol

Multicast - Packets (sum)

Total number of packets received and sent by the
interfaces using the multicast protocol

Multicast - Packets In (sum)

Total number of packets received by the interfaces using
the multicast protocol

Multicast - Packets Out (sum)

Total number of packets sent by the interfaces available
using the multicast protocol

Unicast - Packets (sum)

Total number of packets received and sent by the
interfaces using the unicast protocol

Unicast - Packets In (sum)

Total number of packets received by the interfaces using
the unicast protocol

Unicast - Packets Out (sum)

Total number of packets sent by the interfaces using the
unicast protocol

Broadcast - Packets (sum)

Total number of packets received and sent by the
interfaces using the broadcast protocol

Broadcast - Packets In (sum)

Total number of packets received by the interfaces using
the broadcast protocol

Broadcast - Packets Out (sum)

Total number of packets sent by the interfaces using the
broadcast protocol

Unknown Protocol - Packets (sum)

Total number of packets received and sent by the
interfaces using any protocol other than the following
ones:

e Unicast
e Non-unicast
o Multicast

o Broadcast

Average Packet Size - Bytes (avg)

Average number of bytes received and transmitted by the
selected interface for the selected time range.

Calculated using the following method:
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Volume - Bytes (sum) / Volume - Packets
(sum)

Average Packet Size - Bytes In (avg) | Average number of bytes received by the selected

interface for the selected time range.
Calculated using the following method:

Volume - Bytes In (sum) / Volume -
Packets In (sum)

(avg)

Average Packet Size - Bytes Out

Average number of bytes transmitted by the selected
interface for the selected time range.

Calculated using the following method:

Volume - Bytes Out (sum) / Volume -
Packets Out (sum)

Glossary of Wireless LAN Metrics for CISCO-DOT11-ASSOCIATION-MIB

Available only on WLAN interfaces that support CISCO-DOT11-ASSOCIATION-MIB.

Metric Description

NumActiveWirelessClients Number of wireless clients currently associating with the
selected device on the selected interface

o Average

« Minimum You can select the device and interface using the
NPS Topology Selector.

* Maximum NPS calculates the metric to display average, minimum, and
maximum number of wireless clients associated to the
selected interface.

NumActiveBridges Number of bridges currently associating with this device on
the selected interface.

e Average

o Minimum You can select the device and interface using the
NPS Topology Selector.

* Maximum NPS calculates the metric to display average, minimum, and
maximum number of bridges associated to the selected
interface.

NumActiveRepeaters Number of repeaters currently associating with this device
on the selected interface.

e Average

o Minimum You can select the device and interface using the
NPS Topology Selector.

* Maximum NPS calculates the metric to display average, minimum, and
maximum number of repeaters associated to the selected
interface.
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StationsAssociated (sum) Total number of stations associated with this device on the

selected interface.

Displays the number of stations associated to the interface
since the device re-started.

StationsAuthenticated (sum) Total number of stations authenticated with this device on

the selected interface.

Displays the number of stations authenticated on the
interface since the device re-started.

StationsRoamedIn (sum) Total number of stations roamed (transferred) from another

device to this device on the selected interface

Displays the number of stations transferred to the selected
interface since the device re-started.

StationsRoamedAway (sum) Total number of stations roamed (transferred) away from this

device on the selected interface

Displays the number of stations transferred from the
selected interface since the device re-started.

StationsDeauthenticated (sum) | Total number of stations de-authenticated with this device on

the selected interface

Displays the number of stations for which the authentication
were removed from the selected interface since the device
re-started.

StationsDisassociated (sum) Total number of stations disassociated with this device on

the selected interface

Displays the number of stations that were disassociated
from the selected interface since the device re-started.

Glossary of Wireless LAN Metrics

Available only on WLAN interfaces — Following IEEE802dot11 performance policy

Metric Description

SuccessfulRetryCount
(sum)

Total number of times the MSDU is successfully transmitted after
one or more re-transmissions.

RTSSuccessCount (sum) Total number of CTS Clear to Send received in response to an

RTS Request to Send.

(sum)

TransmittedFragmentCount | Total number of acknowledged MPDU with an individual address

in the address 1 field or an MPDU with a multicast address in the
address 1 field of type Data or Management."

(sum)

MaxedOutTransmitAttempts | Total number of times the MSDU is not transmitted successfully

due to the number of transmit attempts exceeding either the
dot11ShortRetryLimit or dot11LongRetryLimit.
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ReceivedFragmentCount Total number of successfully received MPDU of type Data or
(sum) Management.

UndecryptableFrames (sum) | Total number of frames received with the WEP subfield of the
Frame Control field set to one and the WEPOn value for the key
mapped to the TA's MAC address indicates that the frame should
not have been encrypted or that frame is discarded due to the
receiving STA not implementing the privacy option.

RTSFailureCount (sum) Total number of CTS signals failed to be sent in response to an
RTS.
ACKFailureCount (sum) Total number of times the ACK was not received when expected.

FrameDuplicateCount (sum) | Total number of frames received that the Sequence Control field
indicates is a duplicate.

FCSErrorCount (sum) Total number of FCS errors detected in received MPDU.

About Path Health Reports

The Path Health report displays icons that represent the nodes and interfaces in a path. A vertical
chain of nodes and interfaces represents the path from one managed element to another. Each
node and interface shows a series of small pie charts and trend lines depicting activity and
performance for that element over the previous six hours.

With Path Health, you can analyze:
o The ratio of exceptions per metric over the last hour (one pie chart per metric)
o Metric values over the last six hours (one graph per metric)

They enable you to determine whether the values are static, rising steadily, falling steadily, or
fluctuating.

1. From one of the NNMi inventory views, select two elements.

2. Path Health can only be launched from a Path View in NNMi. To view the Path View page,
from the NNMi console, select Action > Path View.

3. From the Path View, select Actions > Reporting-Path Health.
The Path View page shows the following menus:
= Source Node: The first element of the selected path
= Destination Node: The last element of the selected path
4. Select Actions and Reporting-Path Health to create the Path Health report.

If the Path View shows multiple paths between hops, NNMi will ask you to select a specific path.
To select, click the appropriate connecting line within NNMi. The colors on the screen will change
when you make the selection. The Path Health option under Actions does not function until your
selection is complete.

Launching Path Health Reports for Nodes with Multiple Paths
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The NNMi console can display more than one path between your source and destination nodes.
When you request a Path Health report using the Actions > Reporting-Path Health menu, the left-
most icon on the path changes color if multiple paths exist between the source and destination
nodes. To launch a Path Health report, select a particular path by clicking every visible node on the
path and selecting Actions and Reporting-Path Health.

Features and Defaults

Path Health pulls data from the following extension packs:
e Component Health

o Interface Health

From the Component Health collections, Path Health generates the following statistics for a node in
a path:

o CPU exceptions last hour/ CPU utilization last six hours
« Memory exceptions last hour/ Memory utilization last six hours
o Buffer exceptions last hour / Buffer utilization last six hours

From the Interface Health collections, Path Health generates the following statistics for an interface
in a path:

o Utilization exceptions last hour / Utilization over the last six hours

o Discard exceptions last hour / Number of discards per poll over the last six hours

o Error exceptions last hour/ Number of errors per poll last six hours

The Path Health report pulls data from the Component Health Live and Interface Health Live tables.
How to Use Path Health

You can monitor the fault conditions that show up in a Path View. The performance data in Path
Health can help you determine the cause.

If a node, interface, or component in the Path Health report shows exceptions, you can easily find
more information by clicking the links for node, interface, or component. For example, if a node
shows CPU exceptions, open the Report Menu, select an appropriate report, and drill down on the
node until you identify the specific component that is reporting problems.

Path Health Report

The Path Health report displays icons that represent the nodes and interfaces in a path. A vertical
chain of nodes and interfaces represents the path from one managed element to another. Each
node and interface shows a series of small pie charts and trend lines depicting activity and
performance for that element over the previous six hours.

With Path Health, you can analyze:
o The ratio of exceptions per metric over the last hour (one pie chart per metric)
o Metric values over the last six hours (one graph per metric)

The selected Path View is displayed as follows.
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The pie chart enables you to view the comparison between the number of polls that are below or
above the set threshold. The data in the pie chart represents the samples collected within the last
hour.

The line graphs track sampled data over the previous six hours.

Unknown ltems

Unknown icons (represented by ?) appear in the Path Health report for a device or interface that is
not being polled for the required data. The Path Health report presents Component Health data for
each node and Interface Health data for each interface. It is possible that a node can support the
Interface Health collections (MIB-I1), but not the Component Health collections. The report could,
therefore, display data for the inbound and outbound interfaces on a node but not for the node itself.

About Self Diagnostics Reports

The Self Diagnostics Extension Pack monitors the health of the processes that function within
NPS.

Reports enable you to:

o Investigate how the processes are performing.

o Analyze if the metrics measuring NPS performance are within an acceptable (normal) range.
o Compare the performance of NPS processes for a selected time range.

o Analyze the performance of NPS processes during the busiest time of the day.

Calendar Report

The Calendar report displays hourly statistics for two metrics in a single, extended graph spanning
multiple days.

Features and Defaults

The default settings are:

o Task Categories, Task Types, and Task Names= All
o Dates/Times = Last 31 days
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o Metric(s) Shown on Y1 Axis = Process Time (secs)(avg)
o Metric(s) Shown on Y2 Axis = Process Time (secs)(min)

The default view shows data for the current month. When the NPS collects enough data, you can
use the Until Now option to look at data for the previous 70 days.

How to Use This Report
Use this report to:

Observe gradual trends over time

Observe isolated spikes

Verify that an abnormal condition has returned to normal

Make comparisons

This report also reveals:
o Day-of-week patterns

o Hour-of-day patterns

Chart Detail Report

The Chart Detail report enables you to perform a trend analysis for the health and performance of
NPS processes based on historical performance data.

The report displays a comparative analysis of the selected metrics for each time unit. For example,
to compare how the average Threshold Exception Rate was affected by variance in average
process time per millisecond for the past week, you would generate a Weekly Performance
Diagnostics report for the selected node group.

You can select two or more task types, task names, extension packs, and so on.
With this report you can:

o Analyze the trend of network health and performance for multiple task types, task names,
extension packs, and so on based on one unit of time. Each unit of time is called a Display
Grain. Each Display Grain is measured as follows:

= 5 minutes for hourly report
= 1 hour for daily report
= One day for weekly report
= One day for monthly report
o Identify any ups and downs in the health and performance of NPS processes

o Compare the health and performance of more than two task types, task names, extension
packs, and so on based on historical health and performance data

The following filters are available in the Time Controls pane:
o Start Date/Time
o Time Range

o Display Grain
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e Hour of day

o Day of Week

Features and Defaults

The graph tracks metrics over the selected time period. The default settings are:
o Task Categories, Task Types, and Task Names = Al

o Primary metric = Process Time (secs)(avg)

e Secondary metric = Process Time (secs)(min)

To add another primary or secondary metric, click Options and '{F_hl the Add group button.
To remove a primary or secondary metric you already added, click Options and P the Remove
group button.

You can view the data in tabular format by clicking Options and selecting Table. To view both the
chart and the table, click Options and select Chart and Table.

Heat Chart Report

The Heat Chart report tracks the hourly performance of a single metric. The default metric is
Process Time (secs)(avg). The default time period is the last 24 hours. Performance is color-coded,
which makes it easy to spot a condition that is gradually worsening and to distinguish satisfactory
performance from unsatisfactory performance.

The following filters are available in the Time Controls pane:
o Start Date/Time

o Time Range

¢ Display Grain

¢ Auto Refresh

e Hours of Day

o Day of Week

Features and Defaults

The legend at the top of the report ties a range of normalized performance values to a particular
color. Any value within that range gets that color. Beneath the legend, each day of the month is
listed left to right, day 1 through 31. Down the side of the report is each hour of the day. Each cell
inside the table is color-coded and indicates a specific value. You can move the mouse pointer on a
cell to view raw data.

The default settings are:

o Time Period = Last 24 hours
Hour of Day = All

Day of Week = All

Metric = Process Time (secs)(avg)
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Managed Inventory Report

The Managed Inventory report displays a list of available topology attributes. You can use the
available attributes to filter specific data and create a report. The report presents the list of attributes
in the form of a table. The Count column indicates the number of entries for each attribute.

For the topology item Extension Pack, the Count column indicates the number of available
extension packs on the NPS system.

For the topology item Task Category, the Count column indicates the number of task categories
created by NPS.

Monitor the Health of NPS and Extension Packs

The reports generated by the Self Diagnostics Extension Pack help you monitor the health and
performance of the processes that constitute the core functionality of NPS and the Extension
Packs on the NPS system.

The Self Diagnostics Extension Pack identifies every process on the NPS system as a task. Every
task is grouped under relevant task type, task category, and Extension Pack.

Task Categories

o ETL

¢ Report Generation

Task Types

ETL:

o build_groupcache_from_db

o build _topcache from_db

o checkAggregates

e process_group_dump_file

e process_metricsfiles

o process_metricsfiles->bulkload archive table
e process_metricsfiles->bulkload live table

o process_metricsfiles->preprocessing

e process_retention->aggregate table

e process_retention->live table

e process_retention->archive table

e process_retention->timeDimension table
e process_summary->Summary Child Proc
e process_summary->Summary Parent Proc
e process_topodump _file

Report Generation:
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o Calendar

e Chart Detail

¢ Dashboard

¢ Headline

¢ Heat Chart

¢ Most Changed

¢ Managed Inventory
e TopN

Tasks

NPS monitors and administers essential processes as tasks running on the NPS system. All
processes are introduced by different Extension Packs on the system. The processes are named
according to the following format:

extension_pack_name>.<task_category>.<task_type>

Metrics

You can generate reports for the following metrics:

e Process Time (time in seconds for the task to complete)

o Number of Rows (applies to select tasks, such as ETL bulk loads)

o Available System Memory: Shows free memory (free and cached memory on Linux), which
enables you to see if your system’s memory usage is increasing, thus decreasing available
memory. Low available memory can degrade system performance.

¢ Auvailable Disk Space: Enables you to monitor disk usage in the Data Directory file system. By
plotting the Available Disk trend over time, you can see if your disk usage has reached a steady
state, orif you are on a trajectory to run out of disk space.

Most Changed Report

The Most Changed report compares performance over two different (consecutive) time periods and
ranks processes by the amount of change. The sort order is most-changed to least-changed.

Features and Defaults

The report contains a table with the following columns:
o Performance for the previous time period

o Performance for the selected time period

o Growth, expressed as a percentage increase

Change

The default settings are:

o Dates/Times = Last Day (and the day before)
o Hourof Day = All
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e Day of Week = Al
o Rank Metric = Process Time (secs)(avg))
e Top N Option =Top 10

When you select a month, the report compares two months (the month you selected and the
previous month). When you select a week, the report compares two weeks (the week you selected
and the previous week).

The report provides data for one metric.

Peak Period Report

The Peak Period report ranks the performance of an NPS process during the busiest time of the
selected time range.

With this report, you can:
o Identify the performance and utilization of the selected metrics during the peak period.

« Identify the NPS processes that have the highest or lowest performances during the peak
period.

o Compare the performance for multiple NPS processes during the peak period using this report.
Peak Period Report Options

e Top/BottomN

e Metric

o Grouping by Time Period

This report tracks up to six metrics over the selected time period.

To add another metric, click Options and '{F_hl (the Add group button).

To remove a metric you already added, click Options and X (the Remove group button).

To select a range of value for the metric, click W and select a range of metric value the report
should consider. For example, to see the top five interfaces with average memory utilization
between 10% and 90%, select 10 as the Lowest value and 90 as the Highest value.

By default, the report groups data by Time Period. You can select multiple grouping attributes with
ﬁ. To remove a grouping attribute, use X_
Use this report to identify the period when NPS process performance is the lowest.
Check this report once a day to see which NPS processes need special attention.
Top 10 Task Duration Report

The report monitors the Top 10 ETL and report generation processes and tracks the time taken by
each process during the selected time range.
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Top N Report

The Top N report ranks NPS processes by the metric you select. You can use this report to spot the
processes that performed at the extremes. You can also analyze historical data for the processes
that exhibit unusual performance levels.

The following topology filters are available:

o Extension Pack

Task Category

Task Type
e Task Name
With this report you can:

o Rank the performance of the extension packs and tasks running on your Performance iSPI
server.

o Detect the underlying reason of a persistent problem with a process. You can compare the
performance for multiple tasks.

Example

Say that some of the processes in your network are performing poorly. You can group the
processes that report the highest processing time so that the process with the highest processing
time is ranked first.

Top N Report Options
The following options are available:

o Top/Bottom 'N'
Select a rank between top or bottom 5, 10, 25, 50, 100, all descending, and all ascending for
selected NPS processes.

o Metric
Select the metric on which you want to generate the report. This metric is used to rank the
report.

o Display Time Series Chart
Select Yes to view the detail chart with the table. Select No to hide the chart and display only the
table. The created Top N Report displays the graphical representation of the metric values for
the NPS processes over the selected time range.

o Grouping By
Enables you to group the report data based on a specific parameter. Click to add a subgroup.

This report tracks up to six metrics for each metric type over the selected time period.

To add another metric, click Options and '{F_hl (the Add group button).

To remove a metric you already added, click Options and Pt (the Remove group button).

To select a range of value for the metric, click W and select a range of metric value the report
should consider. For example, to see the average process time for the Self Diagnostics extension
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pack within a range of 100 and 500 seconds, select 100 as the minimum value and 500 as the
maximum value.

By default, the report groups data by extension pack. You can select multiple grouping attributes

with ﬁ To remove a grouping attribute, use x.

By default, the Top N Report is displayed without the Time Series Chart. To view the detail table,
click Display Time Series Chart.

Check this report once a day to see which extension pack or process needs special attention.

Check this report periodically throughout the day to see which extension packs or processes are
performing at the extremes and need special attention.

Top N Chart Report
The Top N Chart report ranks NPS processes by the metric you select.
With this report, you can:
o Spot NPS processes that perform at the extremes.
o Detect NPS processes that have a performance problem.
Top N Chart Options
The following options are available:
e Top/BottomN
o Metric
o Grouping By

This report tracks up to six metrics over the selected time period.

To add another metric, click Options and '{F_hl (the Add group button).

To remove a metric you already added, click Options and X (the Remove group button).

To select a range of value for the metric, click W and select a range of metric value the report
should consider. For example, to see the top five interfaces with average availability between 10%
and 90%, select 10 as the Lowest value and 90 as the Highest value.

By default, the report groups data by extension pack. You can select multiple grouping attributes

with ﬁ To remove a grouping attribute, use x.

Check this report once a day to see which NPS processes need special attention.

About Reportlets

In a large enterprise network, the NNM iSPI Performance products (HP NNM iSPI Performance for
Metrics, HP NNM iSPI Performance for Quality Assurance, and HP NNM iSPI Performance for
Traffic) can produce a large amount of data and large cardinality. Enterprise networks often have a
very large number of unique IP addresses, source nodes, destination nodes, virtual circuits,
interfaces, and components that each produce a large amount of data. Generating reports can
therefore be time-consuming.
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Reportlets enable you to generate quick impressions of the larger reports using the NNM iSPI
Performance dashboard.

To view reportlets:
1. Logintothe NPS home page.

2. Onthe left navigation panel, select Dashboard Reportlets.

3. Select an extension pack and a reportlet.

You can also create custom dashboards using the reportlets (see "Creating Custom Dashboards
Using the Bl Server Portal").

Simple Bar Chart
Compares the performance of two metrics for the selected time range.
Enables you to:
o Compare the performance trends of multiple metrics.

¢ Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports two metrics.
Simple Bar and Line Chart

Displays the trend of NPS process performance for the selected time range using the following
values:

o Primary Metric on the bar chart

e Secondary Metric on the line chart

Enables you to:

o Compare the performance trends of multiple metrics.

¢ Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports two metrics.

Calendar

Displays a comparative study of the selected Primary Metric and Secondary Metric

The default display grain is set to 1 hour. You cannot change the display grain of this reportlet.
Enables you to monitor:

o Daily system resource utilization by the NPS processes

o Volume of data processed by the NPS processes for the selected time range

o Performance of the NPS processes for the selected time range

This reportlet supports two metrics.
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Gauge

Evaluates the metric for the selected point of time.
Enables you to:
o Measure the daily performance of the selected metric.

o Detect any abnormal or unexpected performance level.

This reportlet supports one metric.
Heat Chart

Grades the performance of the selected metric for the selected time range.
Metric performance is aggregated based on an hourly display grain.
Enables you to:

« View how NPS process performance is affected by a varying metric.

o Compare the hourly performance of the selected metric.

o Detect the time range when NPS process performance was affected adversely because of the
fluctuating metric value.

This reportlet supports one metric.
Metric Snapshot

Displays metric performance for the selected time range.

Enables you to:

o Build a performance history for the selected metric and analyze how metric performance
changes over time. Doing this can help you to determine the baseline value for the metric

o Compare the performance of multiple metrics over a specified time range. You can generate a
snapshot report for a single metric, save the snapshot report for various metrics, and compare
the performance of each metric over a time range.

This reportlet supports one metric.

Most Changed

Compares metric performance between yesterday and today.

Aggregates daily metric utilization and ranks performance in descending order.

Enables you to:

o Measure performance fluctuations for NPS processes.

o Detect the Top N NPS processes that have a common performance or utilization problem.
You can enhance the report usability using the following features:

e Top N

¢ Grouping By

Page 226 of 230 HP Network Node Manager iSPI Performance for Metrics Software (9.20)



Online Help
Contents

This reportlet supports one metric.
Multimetric Chart

Analyzes the utilization trend for selected metrics over a selected time range.

Enables you to:

o Perform a comparative analysis of selected metrics for each display grain. The default display
grainis 1 hour.

¢ Analyze the reason for ups and downs in NPS process performance.
o Detect any persistent problem in NPS process performance.

This reportlet supports up to six metrics.

Simple Chart

Analyzes the utilization trend for selected metrics over a selected time range.

Enables you to:

o Perform a comparative analysis of the selected metrics for each display grain. The default
display grainis 1 hour.

o Analyze the reason for ups and downs in NPS process performance.
o Detect any persistent problem in NPS process performance.
This reportlet supports two metrics.

Simple Table

Analyzes the utilization trend for selected metrics over a selected time range.
The default display grainis 1 hour.

Enables you to:

¢ Analyze the hourly performance of the metrics.

o Detect any abnormal or unexpected NPS process performance.

« Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports two metrics.

Sparkline
Evaluates the trend of metric value change over a selected time range.
Enables you to:

o Analyze variations in performance for the selected metric.

o Decide whether the expected behavior for the selected metric should be reassessed.

This reportlet supports one metric.
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Top N Chart

Ranks the individual contribution of each metric for NPS process performance over a selected time
range.

The performance of the NPS process is aggregated on hourly basis.

Enables you to:

o Spot the NPS processes for which the performance metrics present extreme values.

¢ Investigate the aggregated data for NPS processes that exhibit unusual utilization levels.

o Select the metric on which you want to generate the report. The metric you select is used to rank
the NPS processes.

o Group the report data on the basis of on a specific parameter. To add a subgroup, click '{F_hl the
Add Group button.

This reportlet supports one metric.
Top N Line Chart

Ranks the utilization trend for the selected metrics over a selected time range.

The performance of the NPS process is aggregated on an hourly basis.

Enables you to:

o Spot the NPS processes for which the performance metrics present extreme values.
o Investigate aggregated data for NPS processes that exhibi unusual utilization levels.

o Select the metric on which you want to generate the report. The metric you select is used to rank
the NPS processes.

o Group the report data on the basis of a specific parameter. To add a subgroup, click ‘{F_hl the Add
Group button.

This reportlet supports one metric.
Top N Stacked Chart

Ranks the individual contribution of each NPS process based on selected metrics.

The performance of each NPS process is aggregated for the default display grain of 1 hour.
Enables you to:

o Spot the NPS processes for which the performance metrics present extreme values.

¢ Investigate the aggregated data for NPS processes that exhibit unusual utilization levels.
This reportlet supports one metric.

Top N Table

Ranks the NPS processes based on the selected metric.

Enables you to:
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Spot the NPS processes for which the performance metrics present extreme values.
Investigate the aggregated data for NPS processes that exhibit unusual utilization levels.

Select the metric on which you want to generate the report. The metric you select is used to rank
the NPS processes.

Group the report data on the basis of a specific parameter. To add a subgroup, click “{F_hl the Add
Group button.

This reportlet supports one metric.

Top N Table with Bars

Ranks the NPS processes based on the selected metric and displays a horizontal bar to depict the
aggregated metric value.

Enables you to:

Spot the NPS processes for which the performance metrics present extreme values.
Investigate the aggregated data for NPS processes that exhibit unusual utilization levels.

Select the metric on which you want to generate the report. The metric you select is used to rank
the NPS processes.

Group the report data on the basis of a specific parameter. To add a subgroup, click ‘{F_hl the Add
Group button.

This reportlet supports one metric.
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